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Welcome to MASCHINE!

1 Welcome to MASCHINE!

Thank you for buying MASCHINE!

MASCHINE is a groove production studio that implements the familiar working style of classi-
cal groove boxes along with the advantages of a computer based system. MASCHINE is ideal
for making music live, as well as in the studio. It’s the hands-on aspect of a dedicated instru-
ment, the MASCHINE hardware controller, united with the advanced editing features of the
MASCHINE software.

Creating beats is often not very intuitive with a computer, but using the MASCHINE hardware
controller to do it makes it easy and fun. You can tap in freely with the pads or use Note Re-
peat to jam along. Alternatively, build your beats using the step sequencer just as in classic
drum machines.

Patterns can be intuitively combined and rearranged on the fly to form larger ideas. You can try
out several different versions of a song without ever having to stop the music.

Since you can integrate it into any sequencer that supports VST, AU, or AAX plug-ins, you can
reap the benefits in almost any software setup, or use it as a stand-alone application. You can
sample your own material, slice loops and rearrange them easily.

However, MASCHINE is a lot more than an ordinary groovebox or sampler: it comes with an
inspiring 7-gigabyte library, and a sophisticated, yet easy to use tag-based Browser to give you
instant access to the sounds you are looking for.

What's more, MASCHINE provides lots of options for manipulating your sounds via internal ef-
fects and other sound-shaping possibilities. You can also control external MIDI hardware and
3rd-party software with the MASCHINE hardware controller, while customizing the functions of
the pads, knobs and buttons according to your needs utilizing the included Controller Editor
application. We hope you enjoy this fantastic instrument as much as we do. Now let’'s get go-
ing!

—The MASCHINE team at Native Instruments.
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1.1 Where to Start?

MASCHINE provides you with many information sources. The main documents are meant to be
read in the following sequence:

1.  MASCHINE Setup Guide

2. MASCHINE Getting Started and online video tutorials

3. MASCHINE Manual (this document)

The whole documentation set is available in PDF format and located within the MASCHINE
installation folder on your hard disk. You can also access these documents from the Help
menu in the Application Menu Bar or from the Help submenu in the MASCHINE menu.

Please check the Service Center or the Native Instruments website regularly for up-to-date
and localized versions of these documents. You can start the Service Center by selecting
Launch Service Center from the Help menu in the Application Menu Bar or from the Help
submenu in the MASCHINE menu.

Please check the Service Center or the Native Instruments website regularly for up-to-date
and localized versions of these documents. You can start the Service Center by selecting
Launch Service Center from the Help menu in the Application Menu Bar or from the Help
submenu in the MASCHINE menu.

Additional documentation sources provide you with details on more specific topics:
= MASCHINE Hardware Control Reference
= Controller Editor Manual

Hereafter is a quick description of each of these documentation sources.

Your First Stop: the Setup Guide

The Setup Guide will guide you through the software and hardware installation of MASCHINE,
from the very beginning to the first sound coming through your speakers.

First read the Setup Guide. Then proceed with this MASCHINE Getting Started to get more fa-
miliar with MASCHINE.
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MASCHINE Getting Started

After reading the Setup Guide and following its instructions, your MASCHINE should be up
and running. The next step is to read the MASCHINE Getting Started. This gives you a practi-
cal approach to MASCHINE via a set of tutorials covering easy and more advanced tasks in or-
der to help you familiarize yourself with MASCHINE.

Video Tutorials

The Native Instruments website provides you with a lot of video tutorials that give you a hands-
on approach to many sides of the MASCHINE workflow. To see them, point your favorite brows-
er to following URL: http://native-instruments.com/maschinemedia.

MASCHINE Manual

This MASCHINE Manual provides you with a comprehensive description of all MASCHINE soft-
ware and hardware features.

MASCHINE Hardware Control Reference

The MASCHINE Hardware Control Reference provides an overview of a MASCHINE Project, the
quick access options performed using the MASCHINE hardware controller, and lots of key-
board shortcuts.

Controller Editor Manual

Besides using your MASCHINE hardware controller together with its dedicated MASCHINE
software, you can also use it as a powerful and highly versatile MIDI controller to pilot any oth-
er MIDI-capable application or device. This is made possible by the Controller Editor software,
a little application that allows you to precisely define all MIDI assignments for your MASCHINE
controller. The Controller Editor should have been installed during the MASCHINE installation
procedure. For more information on this, please refer to the Controller Editor Manual available
as a PDF file in the Documentation subfolder of the Controller Editor installation folder on your
hard disk.

Other Online Resources

If you are experiencing problems related to your Native Instruments product that the supplied
documentation does not cover, there are several ways of getting help:
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= Knowledge Base

= User Forum

= Technical Support

= Registration Support

You will find more information on these in chapter 115, Troubleshooting — Getting Help.

1.2 What’s New in MASCHINE 2.0?

Here is a short overview of the new or improved software and hardware features in MA-
SCHINE 2.0.

New Features

= MASCHINE STUDIO controller support: MASCHINE 2.0 supports the new groundbreaking
MASCHINE STUDIO controller.

= New audio engine with multi-core support: MASCHINE’s audio engine has been completely
re-written. Now providing full multi-core support, it reaches a new milestone in audio
quality while using less CPU power than its predecessor.

= Completely re-designed GUI: The user interface of the MASCHINE software has been re-de-
signed to improve workflow efficiency while retaining the MASCHINE feel.

= Mix view: The MASCHINE window now provides two switchable, complementary views:
Whereas the Arrange view contains the Arranger, the Control area, and the Pattern Editor
already present in previous versions of MASCHINE, the new Mix view offers two important
new tools: the Mixer and the Plug-in Strip (see below).

= Mixer: Located in the top part of the new Mix view, the Mixer is now at your disposal to
control each of your channels (Sounds, Group, and Master). Whereas the Arranger and the
Pattern Editor put emphasis on the arrangement of your song, the Mixer focuses on the
routing — in particular it makes controlling your various audio levels or setting up com-
plex audio routing a breeze! See chapter 19.2, The Mixer.

= Dedicated Cue hus: You can now send any Sound or Group channel to the new dedicated
Cue bus for pre-listening. Cued channels are temporarily removed from their normal target
and routed to the Cue bus instead. You can send the Cue bus to a separate output of your
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audio interface (e.g., the headphone output) and pre-listen to the cued channels without
affecting the main output of MASCHINE — great during a live performance! The Prehear
feature of the Browser, the metronome signal, as well as your recordings and the Slice
previews in the Sample Editor are also sent to the Cue bus. Of course, the Cue channel
can be controlled via the new Mixer like any other channel of MASCHINE. See section
19.2.6, Using the Cue Bus.

Plug-in Strip: Located in the bottom part of the new Mix view, the Plug-in Strip allows you
to visually control each of the Plug-ins (effects or instruments) you have loaded in the fo-
cused channel (Sound, Group or Master). Each Plug-in included in MASCHINE has its
own visual representation for an intuitive control of all its parameters. Furthermore, any
Native Instruments product installed on your computer provides one or two custom views
in the Plug-in Strip with various sets of parameters. VST/AU plug-ins from third-party
manufacturers are represented by a generic panel. In addition, you can undock any Plug-
in and open it in its own floating window in order to access its original user interface. See
section 19.4, The Plug-in Strip.

Unlimited Groups: Your Projects can now have as many Groups as required. This greatly ex-
pands the organization facilities in bigger Projects. See section 14.3, Managing Groups.

Unlimited effects: Each channel (Sounds, Groups, and Master) can now host any number
of Effect Plug-ins. See chapter 16, Working with Plug-ins.

Drumsynths: In addition to the Sampler Plug-in, MASCHINE now includes additional
sound generators: the Drumsynths — an impressive set of highly flexible and finely tail-
ored drum synthesizers allowing you to create your own custom drum sounds without us-
ing any sampled material! See chapter 110, Using the Drumsynths.

Side-chain input: Various MASCHINE Plug-ins now include a side-chain input that you can
feed with other signals of your Project. Similarly, you can now use side-chaining in VST/
AU plug-ins as well (AU plug-ins with side-chain input, VST plug-ins with multiple in-
puts). See section 111.1.3, Using the Side-Chain Input.

Multiple Sound and Group selection: You can now select multiple Sounds or Groups and ed-
it them at once. See section 14.1.3, Selecting Multiple Sounds or Groups.

New visual Browser: The Browser has been entirely re-designed. It is now organized in a
more efficient and logical way. It also provides custom pictures for all installed NI prod-
ucts, making your searches even more intuitive. See chapter 13, Browser.
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Extended MIDI/host automation and parameter mapping: You can now assign MIDI controls
and host automation directly to MASCHINE parameters independently of the Macro Con-
trols. This is done via the new Assignment area under the Control area. See section 18.2,
Using MIDI Control and Host Automation.

MIDI tracks in Patterns: You can now create and edit MIDI tracks at the Sound level for the
desired MIDI messages within your Patterns. These tracks will be sent in real time to the
MIDI output of the respective Sounds. They will also be exported together with the Pattern
via MIDI drag-and-drop export. See section 17.6, Creating MIDI Tracks from Scratch in
MASCHINE.

MIDI file import: You can now import your MIDI files to Patterns in MASCHINE. See sec-
tion 17.8.3, Importing MIDI to Patterns.

MIDI Program Change for VST/AU plug-in presets: You can now use MIDI Program Change
messages to change the presets in the VST/AU plug-ins loaded in MASCHINE. See sec-
tion 18.2.3, Selecting VST/AU Plug-in Presets via MIDI Program Change.

Macro Controls available at all levels: Macro Controls are now available in every Sound, ev-
ery Group, and in the Master, allowing you to build your own sets of parameters as you see
fit — this comes in very handy when playing live! See section 18.3, Creating Custom Sets
of Parameters with the Macro Controls.

Improved sampling facilities: The Sample Editor includes various improvements, among
other things: Slices can now overlap or have gaps in between; sample mapping has been
re-organized for more efficiency; etc. See chapter 112, Effect Reference.

Pad view: MASCHINE now provides a dedicated Pad view that allows you to focus on the
way pads trigger the various Sounds of the Group. In particular, the Pad view hosts the re-
designed Link groups and Choke groups. See section 14.2, Managing Sounds.

New effects: MASCHINE 2.0 includes a new Plate Reverb effect, and the Compressor pro-
vides a new Feedback mode. See section 112.4.5, Plate Reverb and 112.1.1, Compres-
sor, respectively.

Improved looping: You can now loop any part of your song, not only Scenes. See section
113.3.1, Selecting a Loop Range.
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= Follow mode for Patterns and Scenes: The Arranger and the Pattern Editor now provide a
Follow option that automatically synchronizes the display to the current playback position.
See section 17.1.3, Following the Playback Position in the Pattern and 113.1.3, Follow-
ing the Playback Position in Your Project.

= Advanced Undo: You now have two different Undo commands at your disposal: Step Undo
cancels the last action you did (classic undo), while Take Undo cancels the last group of
actions at once. In particular, this comes in handy when recording notes or modulation!
See section 12.3.4, Undo/Redo.

= Customizable metronome: You can now choose any audio sample for the downbeat and up-
beat sounds of the metronome. See section 12.5.1, Preferences — General Page.

Hardware New Features and Workflow Improvements

Most of the workflows on the hardware controller have been refined for more efficiency and
flexibility. Many of the new features in the MASCHINE software are also available from the
controller. We cannot list here all the hardware improvements but only mention the most visi-
ble changes:

= MASCHINE STUDIO controller: The new MASCHINE STUDIO controller includes numerous
unique features: big color displays, Mix mode, Scene Arrange mode, Pattern Arrange
mode, |I/0 and Level section for quick level adjustment, dedicated section for event
editing — to mention a few...

= Re-designed controller modes: All modes on all controllers have been improved to support
the new features of the MASCHINE software: unlimited number of Plug-ins, unlimited
number of Groups, multiple selection of Sounds and Groups, etc.

= New Record Settings mode: Press + to access the metronome, Count-in, and
Input Quantize settings from your controller. See section 17.2.3, Using the Metronome,
17.2.4, Recording with Count-in, and 17.2.5, Quantizing while Recording.

= New Record Prepare mode: Instead of pressing to start recording in real time, you can
hold a bit longer to show the Record Prepare mode. This mode allows you to adjust a
few essential parameters for your next recording (Pattern Length, Pattern Grid, metro-
nome). You can then release and directly start your recording! See section 17.2.2,
The Record Prepare Mode.

= Gate function for Note Repeat: You can now cut the repeated notes before the next ones or
let them overlap. See section 15.2.1, Note Repeat.
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= Adjustable Count-in: You can now adjust various settings of the Count-in. See section
17.2.4, Recording with Count-in.

= Re-designed Choke groups and Link groups: Choke groups and Link groups are now both
available in Pad Mode. All Link groups, Choke groups also feature Master and Slave
mode. See section 15.1.4, Using Choke Groups and 15.1.5, Using Link Groups.

1.3 Manual Conventions

This section introduces you to the signage and text highlighting used in this manual. This man-
ual uses particular formatting to point out special facts and to warn you of potential issues.
The icons introducing these notes let you see what kind of information is to be expected:

Whenever this exclamation mark icon appears, you should read the corresponding note
carefully and follow the instructions and hints given there if applicable.

This light bulb icon indicates that a note contains useful extra information. This informa-
tion may often help you to solve a task more efficiently, but does not necessarily apply to
the setup or operating system you are using; however, it's always worth a look.

Furthermore, the following formatting is used:

= Text appearing in (drop-down) menus (such as Open..., Save as... etc.) and paths to loca-
tions on your hard disk or other storage devices is printed in italics.

= Text appearing elsewhere (labels of buttons, controls, text next to checkboxes etc.) is
printed in blue. Whenever you see this formatting applied, you will find the same text ap-
pearing somewhere on the screen.

= Text appearing on displays of the MASCHINE controller is printed in light grey. Whenever
you see this formatting applied, you will find the same text on a controller display.

= Text appearing on labels of the hardware controller is printed in . Whenever you see
this formatting applied, you will find the same text on the controller.

= Important names and concepts are printed in bold.

= References to keys on your computer’s keyboard you'll find put in square brackets (e.g.,
“Press [Shift] + [Enter]”).
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» Single instructions are introduced by this play button type arrow.

— Results of actions are introduced by this smaller arrow.

Naming Convention

Throughout the documentation we will refer to MASCHINE controller (or just controller) as the
hardware controller and MASCHINE software as the software installed on your computer.

The term “effect” will sometimes be abbreviated as “FX” when referring to elements in the MA-
SCHINE software and hardware. These terms have the same meaning.
Button Combinations and Shortcuts on Your Controller

Most instructions will use the “+” sign to indicate buttons (or buttons and pads) that must be
pressed simultaneously, starting with the button indicated first. E.g., an instruction such as:
“Press + "
means:

1. Press and hold
2. While holding , press and release it.
3. Release

1.3.1  Unlabeled Buttons and Knohs on the MASCHINE MK1 Controller

The buttons and knobs above and below the displays on your MASCHINE controller do not
have labels (all other elements on the controller do).
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AL, GROUP AL 120.00

ARRANGER PATTERM
ZOOM SCROLL ZOOM

4.0 % 0.0 % 37.0%

The unlabeled buttons and knobs on the MASCHINE controller.

For better reference, we applied a special formatting here: throughout the document, the ele-
ments are capitalized and numbered, so the buttons above the displays are written Button 1 to
Button 8, while the knobs under the displays are written Knob 1 to Knob 8. E.g., whenever you
see an instruction such as “Press Button 2 to open the EDIT page,” you'll know it's the second

button from the left above the displays.
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2 Basic Concepts

This chapter will reintroduce you to MASCHINE's main elements and terminology and explain
how they relate to one another. You will also learn how to set up your audio interface and how
to connect MIDI devices.

Before reading this chapter it is strongly recommended that you read the MASCHINE Get-
ting Started first.

2.1 Names and Concepts You Should Know

We will start with a list defining the most important concepts and names.

Browser

The Browser is the front end for accessing all the elements of your MASCHINE Projects:
Projects, Groups, Sounds, instruments and effect presets, and Samples. Each of these can be
stored and tagged in a way that allows you easy access to all of them. MASCHINE’s factory
library is already completely tagged, as well as factory libraries of any Native Instruments prod-
ucts installed on your computer. You can also import your own files to the Library and tag them
as well. To learn more about the Browser, please read chapter 13, Browser.

Project

A Project contains all data needed for a song: Groups with their Patterns, all Scenes and all
settings, modulation, effects, routings, Sounds and Samples. It's like a snapshot of the entire
state of MASCHINE. Please read the MASCHINE Getting Started for a complete overview of
the MASCHINE Project structure.

Sound

Sounds are the building blocks of all sound content in MASCHINE. A Sound is made up of any
number of Plug-ins. Each Sound of the selected Group is mapped to one of the 16 pads on the
hardware controller, so you can play the Sounds by pressing the pads. Refer to chapter 14,
Managing Sounds, Groups, and Your Project for more information on Sounds.
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Group

A Group contains 16 Sound slots. In addition to the Effect Plug-ins applied to each individual
Sound, a Group can have its own insert effect. These affect all the Sounds in the Group. A
Group can also contain any number of Patterns (grouped into banks of 16 Patterns each). Re-
fer to chapter 14, Managing Sounds, Groups, and Your Project for more information on Groups.

Master

This is where all audio signals from each of the Groups and Sounds come together and get
mixed. The Master channel can also host any number of insert effects of its own, these effects
are applied to all Groups and the Sounds within them. More information on the Master can be
found in chapter 14, Managing Sounds, Groups, and Your Project.

Pattern

A Pattern is a sequence that plays Sounds from a Group. It belongs to that Group and will be
saved together with the Group. In every Scene you can choose for each Group which of its Pat-
terns has to be played. More information on Patterns can be found in chapter 17, Working with
Patterns.

Scene

A Scene is a combination of Clips for your different Groups. Each Clip references a specific
Pattern of a Group. In a Scene you can create one Clip for each Group. Scenes are located in
the Arranger. They can be used to build up a finished arrangement or to trigger different parts
of a song during a live performance. Refer to chapter 112.6.3, Saturator for more information
on Scenes.

Event

Events are the individual drum hits or notes that make up a Pattern. In the Pattern Editor,
events are visually represented by rectangles in the Event area. Depending on the current view
in the Pattern Editor, you can see events for all Sounds slots (Group view) or for the selected
Sound slot only (Keyboard view). Events are described in more detail in chapter 17, Working
with Patterns.
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Plug-in

Each Sound, each Group, and the Master can hold any number of Plug-ins. Plug-ins can be
instruments or effects, and they can be internal (included with MASCHINE), from other Native
Instruments products (instruments or effects), or external (third-party VST/AU plug-ins). Instru-
ment and Effect Plug-ins can be loaded in the first Plug-in slot of Sounds. The other Plug-in
slots of Sounds, as well as the Plug-in slots of Groups and of the Master can hold Effect Plug-
ins only. At each level (Sound, Group, and Master), Plug-ins process the audio in series, ac-
cording to the order in which they are stacked up. Refer to chapter 16, Working with Plug-ins.

Effect

MASCHINE comes with many different effects in the form of Internal Plug-ins. You may also
use Native Instruments or third-party VST/AU effect plug-ins. Each Sound, each Group, and
the Master can hold any number of effects that will be applied as insert effects. The flexible
routing system also allows you to create send effects, multi-effects, and side-chains. For more
details on using effects in MASCHINE, refer to chapter 110.6.3, Percussion — Shaker. You will
find an exhaustive description of all internal effects included in MASCHINE in chapter 112,
Effect Reference.

Please refer to chapter 117, Glossary at the end of this Manual for more definitions!

2.2 Adjusting the MASCHINE User Interface

The MASCHINE software user interface is very flexible. You can choose what to display and
what not, allowing you to focus on your workflow. This section shows you how to adjust the MA-
SCHINE GUI to suit your needs.

2.2.1  Adjusting the Size of the Interface

From the View menu in the Application Menu Bar and from the View submenu in the MA-
SCHINE menu you can select one of four different sizes to display MASCHINE’s software GUI:
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File Edit [View] Controller Help

Browser

Arranger

Mixer

Small
Medium
Large

Fullzcreen

The View menu in the Application Menu Bar (Windows depicted).

© MASCHINE

New Project

Group A1

The View submenu in the MASCHINE menu.

Full screen view is also available from your computer keyboard via [Ctrl]+[F] (Mac OS X:
[CmdI+[F]).

2.2.2  Showing/Hiding the Browser

» Click the Browser button (with the magnifier symbol) in the Header to show and hide the
Browser. You can also select Browser from the View menu in the Application Menu Bar or
from the View submenu in the MASCHINE menu.
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© MASCHINE

New Project

EK-TL A Kit

The Browser button in the Header.

You can also show/hide the Browser from your computer keyboard via the [F4] function key.

2.2.3  Switching between Arrange View and Mix View

» Click the Mix View button at the top left of the Arranger to switch between the Arrange
view and the Mix view. You can also select Arranger or Mixer from the View menu in the
Application Menu Bar or from the View submenu in the MASCHINE menu.

< > @ A 13000

My First Project -

Al I EK-TL A Kit

B1 Bas

Cc1 I Group C1

m Group D1

The Mix View button.

You can also switch between Arrange view and Mix view from your computer keyboard via
the [Tab] key.

2.2.3.1 Switching between Arrange View and Mix View on Your Controller

» Press + to switch between the Arrange view and the Mix view.
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2.2.4  Minimizing the Mixer

When MASCHINE is in Mix view, you can minimize/maximize the Mixer in the top part of the
MASCHINE window:

» Click the arrow button at the bottom left of the Mixer to show and hide the channel de-
tails in the Mixer.

Sound 2

GROUP GROUP

+

Minimizing/maximizing the Mixer.

2.2.5  Showing/Hiding the Control Lane

When MASCHINE is in Arrange view, you can show/hide the Control Lane under the Pattern
Editor:

» Click the arrow button on the bottom left of the Pattern Editor to show and hide the Con-
trol Lane.
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Kick Ektl A 1
Snare Ektl A1
ClosedHH Ektl A

B Clap Ektl A1

@ Valocity
+

& 1t 118

Click the arrow button at the bottom left of the Pattern Editor to show/hide the Control Lane.

2.3  Common Operations

This sections introduces a few very common operations in MASCHINE you will encounter in
numerous situations.

2.3.1  Setting the Focus on a Group or a Sound

To display the content and parameters of a particular Sound or Group, you first need to put it
in focus.

Setting the focus on a Sound or Group is slightly different than selecting it: The focus defines
what will be displayed, whereas the selection defines what will be affected by your edits. Note
that a focused Sound/Group is always selected. The distinction is of importance because you
can select multiple Sounds or Groups to apply your edits to all of them at once! See section
14.1.3, Selecting Multiple Sounds or Groups for more on this.

We show here how to put Sounds and Groups in focus when the MASCHINE software is in

Arrange view (default view). For instructions on putting Sounds and Groups in focus in Mix
view, please refer to chapter 19.2.3, Selecting Channel Strips.
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Setting the Focus on a Group

» To put a Group in focus, click this Group in the Group List of the Arranger:

Raminagrobis

Al ||_i.=--.- & Layers

B1

— The focused Group is highlighted. The Pattern Editor displays the Sounds and Patterns of
that Group.
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Raminagrobis

Side-Chain Input

*

Amount Curve

1 Kick Aski 1
Bl ciap Aeki 1

The focused Group is highlighted and the Pattern Editor show its content.

If the desired Group does not appear in the Group List, use the scroll bar at the right end of
the Arranger or turn your mouse wheel while hovering the Arranger to display any hidden
Groups. You can also extend the Arranger by dragging its lower right corner vertically with

the mouse.

You can also select multiple Groups at once to apply changes to all of them. See section
14.1.3, Selecting Multiple Sounds or Groups for more information.

Setting the Focus on a Sound

To put a Sound in focus:
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1. Set the focus to the Group containing the desired Sound by clicking it in the Group List
on the left of the Arranger (see above).

Raminagrobis

a1 | Basse:
B1
Cc1
D1
E1
F1

The focused Group is highlighted. The Pattern Editor displays the Sounds and Patterns of
that Group.
2. Click the desired Sound slot in the Sound List of the Pattern Editor:

— The focused Sound slot is highlighted.
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The focused Sound slot is highlighted.

If the desired Sound does not appear in the Sound List, use the scroll bar at the right end
of the Pattern Editor or turn your mouse wheel while hovering the Pattern Editor to display
any hidden Sounds.

You can also select multiple Sounds at once to apply changes to all of them. See section
14.1.3, Selecting Multiple Sounds or Groups for more information.

2.3.1.1  Setting the Focus on a Group or a Sound on the MASCHINE Controller

Setting the Focus on a Group

1. If necessary, press + the desired Group button A-H to switch to the Group bank
containing the desired Group.

2. Press the desired Group button A-

—  The corresponding Group is now in focus.
Once the Group is focused you can use Button 1-3 above the left display to quickly switch
between the Master, the focused Group and the last focused Sound in that Group! See sec-
tion 12.3.2, Switching Between the Master, Group, and Sound Level for more information.

Setting the Focus on a Sound

1. If you want to set the focus on a Sound located in another Group, first set the focus on its
Group as described above.

2. Hold
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3.  While holding , check that Button 2 (EVENTS) is disabled — if it is enabled, press
it to disable it.
4. While holding , press the pad of the desired Sound.

—  The corresponding Sound is now in focus.

If the pads on your controller are in Group mode, simply press the pad of the desired
Sound to set the focus on that Sound!

Once the Sound is focused you can use Button 1-3 above the left display to quickly switch
between the Master, the containing Group and the focused Sound! See section 12.3.2, Switch-
ing Between the Master, Group, and Sound Level for more information.

You can also select multiple Sounds at once to apply changes to all of them. See section
14.1.3, Selecting Multiple Sounds or Groups for more information.

2.3.2  Switching Between the Master, Group, and Sound Level

At any time you can quickly switch the Control area between the parameters of the Master, the
focused Group, and the focused Sound.

SOUND

[ o
The Finger

Click the desired tab to switch the display of the Control area.

» Click the MASTER, GROUP or SOUND tab in the top left corner of the Control area to
display the Plug-in parameters or Channel properties of the Master, the focused Group or
the focused Sound, respectively.

— The selected tab lights up. The name of your Project, the focused Group or the focused
Sound appears under the MASTER, GROUP, and SOUND tabs (the Muddy Matt Sound in
the picture above), and the rest of the Control area displays the Plug-in parameters and
Channel properties of the Master, the focused Group or the focused Sound, respectively.
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2.3.2.1 Switching Between the Master, Group, and Sound Level on the MASCHINE Controller
On your controller:

1.
2.

Press the button to enter Control mode.

Press Button 1 (MASTER), Button 2 (GROUP) or Button 3 (SOUND) above the left display to
show the Plug-in parameters and Channel properties of the Master, the focused Group or
the focused Sound, respectively.

The selected tab lights up. The name of your Project, the focused Group or the focused
Sound appears on the left display (under the MASTER, GROUP, and SOUND tabs), and the dis-
plays show the Plug-in parameters and Channel properties of the Master, the focused
Group or the focused Sound, respectively.

2.3.3  Navigating Channel Properties, Plug-ins, and Parameter Pages in the Control Area

We describe here how to display/edit any Plug-in parameters or Channel properties located in
any Sound, Group or the Master.

To select a particular Plug-in or a particular set of Channel properties, you first need to display
the parameters of the Master, the desired Group or the desired Sound:

1.

To display the parameters of a particular Group or Sound, put it in focus by clicking it in
the Group List or Sound List, respectively (see section 12.3.1, Setting the Focus on a
Group or a Sound above).

In the top left corner of the Control area, click the MASTER, GROUP or SOUND tab to
display the parameters of the Master, the focused Group or the focused Sound, respec-
tively.

The Control area now displays the Plug-in parameters and Channel properties of the de-
sired Sound, desired Group or the Master.
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Selecting Channel Properties

1. At the far left of the Control area, click the Channel icon (showing a little knob) to display
the Channel properties:

SWING

The button lights up. The Channel Property selector appears in the left part of the Control
area, showing a square of four buttons representing the various sets of Channel properties
available for the selected Sound, Group or the Master:

SWING

,

Groove Amount

2. Click the desired button (Input, Output, Groove, or Macro) in the Channel Property selec-
tor to select that set of Channel properties.

— The selected button is highlighted and the parameters of the selected Channel properties
appear in the Parameter area (the right and biggest part of the Control area).
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Selecting a Plug-in

1. At the far left of the Control area, click the little Plug-in icon to display the Plug-ins:

< -
LI‘ Sampler

The icon lights up. The Plug-in List appears in the left part of the Control area, showing a
stack of all Plug-ins loaded in the selected Sound, Group or the Master:
Fraq / Gain

( 2
Lid Samplar

EQ
m Matavearb
+

n

Click the desired Plug-in slot in the Plug-in List to select that Plug-in.

— The parameters of the selected Plug-in appear in the Parameter area (the right and big-
gest part of the Control area).

If the Plug-in List only shows a “+” sign, it means that there are no Plug-ins loaded in this
Sound, Group or the Master. Clicking the “+” sign allows you to load a new Plug-in: see
section 16.1.3, Loading, Removing, and Replacing a Plug-in for more on this.

Navigating Parameter Pages

In some situations, the selected Plug-in or Channel properties provide more parameters than
the display(s) of your controller and the Parameter area in the software can show at once. Ex-
amples of this are the parameters for the Groups’ or Sounds’ Output properties and those for
the Sampler Plug-in. In these cases, the parameters are divided into several Parameter pages
that you can easily navigate with the hardware and software.

In the software the names of the available pages are displayed at the top of the Parameter
area. The name of the page currently displayed is highlighted.

» Click the desired page name at the top of the Parameter area to show the corresponding
Parameter page.
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SOUND [ENGIEE  Aux MIDI
AUDIO

Audio Mute

The Parameter pages of the Sound’s Output properties: Audio (currently displayed), Aux, and MIDI.

If all page names cannot be displayed at once at the top of the Parameter area, two small ar-
rows are displayed on the left to click through the pages:

SOUND 7 4k Mas Ise Mas Filtar Ma: Vas Env Mas Env2

Scratchy £ MAS FILTER
-
-

<«
l" Massive
+ (OO ¢ ™)

F1 Cutoff F1 Mod F1 Raso F1 Gain F2 Cutoff F2 Mod 2 Reso F2 Gain

» Click the left or right arrow to access additional pages.

Adjusting the Parameters

In the Parameter area, each parameter includes a control element and a label. Following types
of control elements are available:
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Element Action

Knob: Click the knob and drag your mouse vertically to change the parameter
value. Hold [Shift] on your computer keyboard and drag your mouse to ad-
just the value in finer increments.

Button: Click the button to switch its state. When the button is enabled, it
shows a small colored LED.

Selector: Click the displayed value to open the drop-down list, and click an-
other value in the list to select it.

2.3.3.1 Navigating Channel Properties, Plug-ins, and Parameter Pages on the MASCHINE

Controller

On the MASCHINE controller in Control mode, do the following:

1.

Set the focus on the desired Sound, Group or the Master (see section 12.3.1, Setting the
Focus on a Group or a Sound).

Press Button 1 (MASTER), Button 2 (GROUP) or Button 3 (SOUND) to display the Plug-ins and
Channel properties of the Master, the focused Group or the focused Sound, respectively.
Press Button 5 (CHANNEL) to display the Channel properties or Button 6 (PLUG-IN) to display
the Plug-in slots of the selected Sound, Group or the Master.

CHANHEL G
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4. Press Button 7/8 to navigate the Channel properties or Plug-ins (the name of the selected
Channel properties or Plug-in appears between the left and right arrows under Button 7
and 8).
Upon your selection the parameters of the selected Channel properties or Plug-in are
shown on the displays of your controller.

5. Use the Page huttons to navigate through the Parameter pages of the selected Channel
properties or Plug-in.

s

Whenever there is more than one page, it will be shown on the right side of the right dis-
play like this:

1. SAMFPLER Trl

Moreover, if there is another page available to the left or to the right of the current page,
the corresponding Page button will be half lit on your controller.

6. Use Knobs 1-8 under the displays to adjust the value of the parameters available on the
selected page. For continuous parameters, hold while turning the Knobs to adjust
the values in finer increments.

HASTER GROUP SOUHD | CHAHHEL NIRRT Qe OUTPUT Iv]
Gi, ATMO LOOPS 15000 161

AUDID 1,2

DEST. CUE LEVEL PAN
AZ:51-1 OFF -6.9 DB 0.0%

The displays showing the AUDIO page from the Group’s Output properties (OUT tab).
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Using the Navigate Mode

Alternatively, you can also navigate Channel properties and Plug-ins along with their Parameter
pages via the Navigate mode of your controller:

1. Hold to enter Navigate mode (or pin it by pressing + Button 1).

2. Press Button 5 (CHANNEL) to display the Channel properties or Button 6 (PLUG-IN) to display
the Plug-in slots of the selected Sound, Group or the Master.

CHANNEL JIUTTC T ) -

3. Press Button 3/4 to navigate the Channel properties or Plug-ins (the name of the selected
Channel properties or Plug-in appears between the left and right arrows under Button 3
and 4).

4. Press the dimmed pads to select the desired Parameter pages. The abbreviated names of
the available Parameter pages are shown on the right display along with the corresponding
pads:

1. FRISH T+ [CHAHHEL | IGNEGE | PREY [ HEXT |
4 IRZEY DRAS 15000 555N LFO..DEST]| [MAC.DEST
ARRANGER JEp— TUHING | [MOD..LOPE] [MOD..DEST]
ZOOM o ZOOM SCROLL EXCL.LTER HOD.ILTER| [MOD..L A/E|

0.0 % .| 29 % 0.0 % LGRS (MAC..0 LFO| [EXCL.EHY | [ EXCITER |

Upon your selection the corresponding pad turns fully lit and the page name is highligh-
ted on the right display.

5. Press Button 7/8 to access the previous/next 16 Parameter pages, if available.

6. Release to get back to Control mode (or press a second time if you
pinned the Navigate mode).

— The selected Parameter page now appears on the displays.
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2.3.4 Undo/Redo

Undoing and re-doing your last actions can be useful to cancel operations you have performed
or to compare two versions before and after a change. You can undo nearly everything you did
after loading or creating your Project.

Note: If you save your Project, you will no longer be able to undo or redo any actions per-
formed before saving!

MASCHINE 2.0 provides two different undo/redo features, each of them being suited for spe-
cific situations:

= Step Undo allows you to cancel your last single action.

= Take Undo allows you to cancel your last group of actions.

Step Undo

Step Undo/Redo is the classic undo/redo found in most applications. It cancels or re-executes
each single action you have performed.

In the software use the following keyboard shortcuts for the Step Undo and Step Redo func-
tions:

» To cancel your last action (Step Undo), press [CtrI]+[Shift]+[Z] ([Cmd]+ [Shift]l+ [Z] on
Mac OS X). To re-execute your last action (Step Redo), press [Ctrll+ [Shift]l+ [Y] ([Cmd]+
[Shift]l+ [Y] on Mac OS X). You can also select Undo Step and Redo Step from the Edit
menu in the Application Menu Bar or from the Edit submenu in the MASCHINE menu.

The commands in the Edit menu additionally shows which action will be undone/redone!

Take Undo

Suppose you have just recorded a 16th-note hi-hat beat over four bars, but then decide to can-
cel it. Normally you would have to cancel the 64 notes one at a time, repeatedly calling the
undo function 64 times in a row. This is what Take Undo has been made for!

Take Undo/Redo is an extended undo/redo available while recording that allows you to cancel
or re-execute a whole group of actions at once.
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Take Undo/Redo is the default undo/redo in MASCHINE. In the software use the common key-
board shortcuts for the Undo and Redo functions:

» To cancel your last group of actions, press [Ctrl]+[Z] ((Cmd]+[Z] on Mac OS X). To re-exe-
cute your last group of actions, press [Ctrl]+[Y] ([Cmd]+[Y] on Mac OS X). You can also
select Undo and Redo from the Edit menu in the Application Menu Bar or from the Edit
submenu in the MASCHINE menu.

The commands in the Edit menu additionally shows which action will be undone/redone!

Take Undo is available in following situations:
= Recording in Control mode
= Recording in Step mode

= Recording modulation

Outside of these three situations, Take Undo has the same effect as Step Undo (see
above).

2.3.4.1 Undo/Redo on the MASCHINE MK1 Controller
Both Step Undo and Take Undo are also available on your controller:
» On the MASCHINE hardware controller, perform the Take Undo operation by pressing

+ pad 1 ( ). To perform the Take Redo operation, press + pad 2 (
).

» On the MASCHINE hardware controller, perform the Step Undo operation by pressing

+ pad 3 ( ). To perform the Step Redo operation, press + pad
( ).

2.3.5  Pinning a Mode on Your Controller

Besides the default Control mode, your controller has various other modes of operation, which
you can enter by pressing their dedicated buttons. Depending on their purpose and workflow,
these controller modes are of two types:
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= Temporary modes only stay active as long as you hold down their button on the controller.
When you release the button, your controller returns to Control mode. This is for example
the case with the button.

= Permanent modes stay active even if you release their button. To deactivate them, you
must press their button a second time. This is for example the case with the
button.

But in some situations you might want to release the mode button of a temporary mode with-
out leaving that mode, e.g., to free your hand and tweak other controls more easily. For this
purpose, MASCHINE lets you pin (or “lock”) temporary modes so that they behave like perma-
nent modes.

2.3.5.1 Pinning a Mode on the MASCHINE MK1 Controller

» To pin a mode on your controller, press the relevant mode button ( , ,
etc.) + Button 1 above the left display.

— Now the mode is always pinned when you select it.

» To unpin a mode (i.e. make it a temporary mode again), press its mode button + Button
1 again.

—  Now the mode will only be active as long as you hold the mode button.

Here is a list of all buttons on your controller that you can pin by pressing Button 1 simultane-
ously:

= All buttons in the column at the left of the pads ( , . , )

. button

. button

. button (F2 on older controllers): Instead of using Button 1, press +
to pin the mode. Moreover, when you leave this mode it is

automatically unpinned — it will be temporary again next time you press
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2.3.6  Using Two or More Hardware Controllers

If two or more MASCHINE controllers of different types (MASCHINE STUDIO, MASCHINE
MK2, MASCHINE MIKRO MK2, MASCHINE, and MASCHINE MIKRO) are connected to your
computer, only one controller can be used to control the MASCHINE software at a time.

If you have more than one instance of the MASCHINE software running on your computer,
you can control each instance with a different controller. See 12.4.3, Controlling Various
Instances with Different Controllers for more information.

A controller not connected to any MASCHINE software instance can be used in MIDI mode
(i.e. as a MIDI controller) at the same time as the other controller(s). See the Controller Ed-
itor Manual for more information on MIDI mode.

You can choose which controller you want to use with the MASCHINE software. This can be
done both from your controller and in the software.

You can select the desired controller from the Controller menu in the Application Menu Bar or
from the Controller submenu in the MASCHINE menu:

Eile Edit View | Controller | Help
@ MAS( MASCHINE MIKRO

LIBRARY

File Raminagrobis

MASCHINE MIKRO MK2 &
MASCHINE Bt =

MASCHINE MK2 LT
v MASCHINE STUDIO Controller MASCHINE MIKRO

MASCHINE MIKRO MK2 h
MASCHINE
MASCHINE MK2

Drums

= e v MASCHINE STUDIO

Click the Controller menu (left) or the Controller submenu in the MASCHINE menu (right) and select the controller you want
to use (Windows depicted).

Hardware
On the controller you want to use with the MASCHINE software, do the following:

= MASCHINE STUDIO controller: Press + , turn the jog wheel to select the
desired instance, and press the jog wheel or Button 8 to load it.
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= MASCHINE (MK2) controller: Press + , turn Knob 5 (or press Button 5/6) to
select the desired instance, and press Button 8 to load it.
= MASCHINE MIKRO (MK2) controller: Press + F2, turn the Control encoder to se-

lect the desired instance, and press the Control encoder to load it.

2.4  Stand-Alone and Plug-in Mode

You can run the MASCHINE software as a stand-alone application or integrate it into your fa-
vorite Digital Audio Workstation (or DAW, in short) by loading it as a plug-in. The MASCHINE
software is available in the VST, Audio Unit, and AAX plug-in formats. For further information
on plug-in compatibility and for a detailed description of how to use plug-ins in your host,
please refer to the documentation included with your host software. If you did not install the
plug-ins when installing the MASCHINE software, please refer to the Setup Guide available
from the documentation folder in the MASCHINE software installation folder.

24.1 Differences between Stand-Alone and Plug-in Mode

Transport Functions

The most noticeable difference between the stand-alone and plug-in mode of MASCHINE re-
lates to the interaction with MASCHINE’s sequencer. Indeed, when MASCHINE is used as a
plug-in within a host sequencer software (e.g., Cubase or Pro Tools), MASCHINE's sequencer
is exclusively controlled by the host application: you cannot, e.g., manually start, stop or re-
start the playback in MASCHINE, nor modify the tempo or the time signature of your Project
within the MASCHINE plug-in itself — these are synchonized to your host’s own transport
functions and tempo settings. As a direct consequence, when MASCHINE is used as a plug-in
the Restart and Play buttons as well as the Tempo and Time Signature fields are grayed out
and inactive in the MASCHINE Header. Obviously you cannot control MASCHINE's playback
and tempo settings from your MASCHINE controller either.

However from your controller you can directly control the transport functions of your host

application instead. See section 12.4.4, Controlling your Host's Transport Functions in
Plug-in Mode for more information.
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Audio and MIDI Handling

When MASCHINE is used in stand-alone mode, it directly communicates with your audio and
MIDI interface. You can select which physical audio/MIDI ports have to be used on your inter-
face, and configure crucial audio settings like the sample rate. All this is done via the Audio
and MIDI Settings panel (for more information on this, please refer to 12.6, Audio and MIDI
Settings).

On the contrary, When MASCHINE is used as a plug-in within a host application, the commu-
nication with your audio and MIDI interfaces is managed by the host — the MASCHINE plug-
in only communicates with the host. Native Instruments’ Online Knowledge Base provides
how-tos that will help you route the MASCHINE plug-in to multiple tracks/outputs in the major
hosts:

= How to route MASCHINE to multiple outputs in Ableton Live:
http://www.native-instruments.com/knowledge/questions/1705

= How to route MASCHINE to multiple outputs in Cubase:
http://www.native-instruments.com/knowledge/questions/1707

= How to route MASCHINE to multiple outputs in Pro Tools:
http://www.native-instruments.com/knowledge/questions/1709

= How to route MASCHINE to multiple outputs in Logic Pro:
http://www.native-instruments.com/knowledge/questions/1711

For all details on the audio and MIDI configuration of your host application, please refer to
its documentation.

Multiple Plug-in Instances

When you are using MASCHINE as a plug-in within a host application, you can open multiple
MASCHINE instances. Actually, you can load as many instances of MASCHINE as your com-
puter and your host application can handle CPU-wise. In contrast to the stand-alone applica-
tion, they are always synced to the host. In plug-in mode you can also send MIDI Program
Change messages from your host to switch between MASCHINE'’s Scenes or between patches
of other plug-ins loaded into MASCHINE, or record automation for MASCHINE parameters. To
learn more about these, have a look at chapter 113.4, Triggering Scenes via MIDI (MASCHINE
Plug-in Only) and 18.2, Using MIDI Control and Host Automation.
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2.4.2  Switching Instances

When two or more instances of the MASCHINE software are running (e.g., as plug-ins on dif-
ferent tracks of your DAW), you must choose which instance you want to control from your
hardware controller. You can do this both from your controller and in the software.

Click the Connect button to connect the controller to that instance.

» To select your controller from a particular MASCHINE instance, click the Connect button
in the MASCHINE Header of that instance.

2.4.2.1 Switching Instances from the MASCHINE MK1 Controller
To switch from one MASCHINE instance to another:

= Press +
= Turn Knob 5 (or press Button 5/6) to select the desired instance.

= Press Button 8 to load that instance.

2.4.3  Controlling Various Instances with Different Controllers

You can use two or more MASCHINE controllers of different types (MASCHINE STUDIO, MA-
SCHINE MK2, MASCHINE MIKRO MK2, MASCHINE, and MASCHINE MIKRO) simultaneously
with different instances of the MASCHINE software (possibly with one instance in stand-alone
mode). In doing so, the following applies:

= Only one MASCHINE controller of any type can be connected to an instance at a time.
You can choose which instance you want to control from each controller as described in
12.4.2, Switching Instances.

= When you start a new instance of the MASCHINE software, it connects to one of the MA-
SCHINE controllers according to following precedence rules:

o Rule 1: The MASCHINE STUDIO controller focus has priority over the MK2 controllers
(MASCHINE MK2 and MASCHINE MIKRO MK2), which themselves take priority over
legacy controllers (MASCHINE and MASCHINE MIKRO).
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o Rule 2: The MASCHINE controllers (legacy and MK2) have priority focus over MA-
SCHINE MIKRO controllers (legacy and MK2).

o Rule 1 has priority over rule 2.

244  Controlling your Host’s Transport Functions in Plug-in Mode

When you are using MASCHINE as a plug-in within a host application, the Host Transport Con-
trol feature allows you to split the control elements of your controller into two groups:

= All buttons in the section except , , and control your host
application via MIDI.

= All other elements control the MASCHINE plug-in instance.

This allows you to simultaneously control the transport functions of your host and the various
elements of your MASCHINE Project!

The Host Transport Control can be activated in the MIDI Template loaded in the Controller Edi-
tor. When MASCHINE is loaded as a plug-in in your host application, do the following:

1. Start the Controller Editor.

2. In the Device menu in the top left corner of the Controller Editor window, select the entry
corresponding to your controller in order to edit its MIDI assignments of your MASCHINE
STUDIO Controller.

3. Inthe Templates page on the right, click the desired MIDI Template to load it.
4. Click the Host Transport Control option under the Template List to enable/disable it.
—  From now on the buttons in the section (except , , and ) will

send MIDI data as specified in the Template loaded in the Controller Editor, while all oth-
er elements will control the MASCHINE plug-in instance.

For more information on the MIDI mode, please refer to the Controller Editor Manual.

2.5 Preferences

The Preferences panel lets you specify various settings for MASCHINE.
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» To open the Preferences panel, click Preferences... in the Maschine menu (Mac OS X) or
File menu (Windows) of the Application Menu Bar, or in the File submenu of the MA-
SCHINE menu:

Edit View Controller Help

Mew Ctrl+M
Open... Ctrl+ O
Save Ctrl+5
Save As.. Ctrl+Shift+5

Save As...

Save Project with Samples... Save Project with § os...

Import Maschine 1.x Format...

Import Maschine1.x Format...

Export Audio... Export Audio...

Recent Files 3
Recent Files k

Preferances... [\.-
Preferences... %

Audio and MIDI Settings...

Sync to External MIDI Clock
Send MIDI Cleck

Exit

Preferences... in the File menu of the Application Menu Bar (Windows depicted), and in the File submenu of the MA-
SCHINE menu.

The following pages are available in the Preferences panel:
= General: see 12.5.1, Preferences — General Page.
= Default: see 12.5.2, Preferences — Default Page.
= Library: see 12.5.3, Preferences — Library Page.
= Plug-ins: see 12.5.4, Preferences — Plug-ins Page.
= Hardware: see 2.5.5 Preferences — Hardware Page.

= Colors: see 12.5.6, Preferences — Colors Page.
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2.5.1 Preferences — General Page

The General page holds a few global settings.

» To display the General page click the General tab on the left of the Preferences panel.

Preferences

Startup

Reload Last Projec
Recording Audio
Prafer Project Folder
MIDI

Sync Offs Slav
Metronome
Enabled

Close

The Preferences — General page.

Setting Description

Startup

Reload Last Project If this option is checked, the last Project you worked on will automatically
load the next time you start MASCHINE.

Recording Audio
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Setting Description

Prefer Project Folder

If this checkbox is marked, the Samples you record will be put in a subdir-
ectory of the folder where your Project is saved. If not, your recordings will
be saved in the generic Recordings folder in your standard user directory
(see section 12.5.2, Preferences — Default Page).

Sync Offset Slave

Depending on variables such as the speed of your CPU, your audio inter-
face, your MIDI interface and the Latency value you selected in the Audio
and MIDI Settings panel (see 12.6, Audio and MIDI Settings), you may ex-
perience a lack of synchronization between MASCHINE and the external
MIDI Master. To compensate, you can adjust this Sync Offset Slave value
in milliseconds. An easy way to do that is to play a 4/4 kick drum pattern
or a metronome sound on both MASCHINE and the external MIDI Master
and mix them together moving the slider until they are played at exactly
the same time. As soon as you can hear a flanger-like effect, you know you
are close to the correct Sync Offset Slave value. Keep on adjusting the
Sync Offset Slave control until you can neither hear the flanging effect nor
two separate signals.

Metronome

Enabled Check this box to activate the metronome. You can also enable the metro-
nome by clicking the Metronome button in the MASCHINE Header — see
section 17.2.3, Using the Metronome.

Volume Adjusts the volume of the metronome.

Signature Selects the time interval between each tick of the metronome. By default

the metronome indicates the beats (the quarter notes, 1/4). Here you can
select another note value for the ticks.

Count-in Length

Adjusts the duration of the Count-in, i.e. how long the metronome will
sound before the recording actually starts.

2.5.2  Preferences — Default Page

The Default page allows you to define a few default settings that will be used for every new

Project.

» To display the Default page click the Default tab on the left of the Preferences panel.
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Preferences

Metronome Settings
Down B Sampl

Up B Sampl
Pattern Length

Bars

Template Project
Standalor

Plug-ir

The Preferences — Default page.

Setting Description

Metronome Settings

Down Beat Sample and Up Beat | Here you can select audio files to be used as up and down beat of the met-
Sample ronome, respectively. The fields display the locations of the audio files se-
lected for use. Click the fields to select other files. Click the little crosses
on the right of the fields to remove the custom audio files and use the de-
fault metronome sounds instead.

Pattern Length
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Setting Description

Bars

Here you can define the default length of new Patterns. The length is
measured in bars:beats:16ths. To adjust the value, click the desired num-
ber (bars, beats or 16ths) and drag your mouse vertically. See 17.1.6, Ad-
justing the Pattern Grid and the Pattern Length for more information on
the Pattern Length.

Template Project

Standalone

Here you can select a Project to load automatically when you start a new
Project in MASCHINE used as a stand-alone application. The field displays
the location of the Template Project selected for use. Click the folder icon
to select another Template Project. Any Project file can be used as a tem-
plate, this can be from the MASCHINE Library or you could create a file,
for example with your preferred instruments and effects already loaded into
the Plug-in slots. If you have already set a Template Project, click the
cross icon to unset it and start new Projects from scratch instead.

Plug-in

Here you can select a Project to load automatically when MASCHINE is
used as a plug-in within a Digital Audio Workstation. The field displays the
location of the Template Project selected for use. Click the folder icon to
select another Template Project. Any Project file can be used as a tem-
plate, this can be from the MASCHINE Library or you can create a file, for
example with your preferred instruments and effects loaded into the Plug-
in slots. If you have already set a Template Project, click the cross icon to
unset it and start new Projects from scratch instead.

2.5.3  Preferences — Library Page

The Library page allows you to edit the locations of all MASCHINE library files (both factory

and user) that appear in the LIBRARY pane of the Browser.

é The LIBRARY pane of the Browser is described in section 13.2, Searching and Loading

Files from the Library.

» To display the Library page click the Library tab on the left of the Preferences panel.

At the top of the page, the Factory and User buttons allow you to switch between the Factory
pane and the User pane.
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Factory Pane

» To display the Factory pane, click the Factory button at the top of the Library page.

Preferences

EQ Factory P

Program Files (xB6)\...\Native Instruments\FMB8 FMB Factory Content

rogr Fi MAGuitar Rig 5\R suitar Rig Pro

Filadusa s

Rescan

Close

The Preferences panel — the Library page’s Factory pane.

The Factory pane shows all factory libraries available. These includes the MASCHINE Factory
Library, libraries imported from other NI products, as well as installed MASCHINE EXPAN-
SIONS.

These libraries will appear in the Factory view of the Browser’s Library pane.
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Element Description

LLocation column Shows the path of each library. If you have moved any library to another location
on your computer, click the folder icon on the left of that library and select its
new path.

Product column Shows the name of each product. These names cannot be edited.

Rescan button If you have made any change to a library (e.g., changed its location), select it in
the list and click the Rescan button to rescan that library.

User Pane

» To display the User pane, click the User button at the top of the Library page.

Preferences
Factory
Location

e to sat an

r Library

Remove

The Preferences panel — the Library page’s User pane.
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The User pane shows all user libraries currently used. These include MASCHINE's standard
user directory as well as any other user directory you might have defined. These libraries will
appear in the User view of the Browser’s Library pane.

Element Description

Location column Shows the path of each library. If you have moved any library to another location
on your computer, click the folder icon on the left of that library and select its
new path.

Alias column Shows the alias stored for each library. Click an alias to edit it. Defining aliases

for your user folders is not mandatory, but it can be of great help when working
on different computers (see description below). After adding a location (see Add
below), click the field in the new row and in the Alias column to set the alias for
that new location. The alias of the default user folder, Standard User Directory,
cannot be edited — this is the location where all your user files will be stored by

default.

Add button Click Add to manually add directories to the user library. See below for more de-
tails.

Remove button Click Remove to remove the selected user library. Files will only be removed

from the MASCHINE Browser, not from your hard disk.

Rescan button If you have made any change to a library (e.g., added/removed files), select it in
the list and click the Rescan button to rescan that library.

@ You can resize the Preferences panel at your convenience using the usual method on your
operating system. You can also resize each column by clicking and dragging the limit be-
tween both column headers.

Using Aliases

The aliases available in the Alias column act as references to the paths shown in the Location
column. When you save a Project, the saved data includes both the path and the alias for each
file used in the Project. This will allow you to use a Project on different computers even if the
files used in the Project (e.g., Samples) are stored in different locations on each computer:
Simply define the same alias for these locations on each computer, and MASCHINE will re-
place the path saved on the first computer with the path set to the same alias on the second
computer in order to retrieve the files on this second computer, therefore avoiding the possibil-
ity of missing Samples.
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In the User pane of the Library page, you can add other folders to the user content of your MA-
SCHINE Library. To do this:

1. Click Add at the bottom of the pane.
A folder selection dialog opens up.

2. In the dialog, navigate to the desired folder on your computer and click OK (Choose on
Mac OS X).

—  All MASCHINE-compatible files found in the selected folder are added to your user con-
tent in MASCHINE.

Furthermore, the imported files will have their attributes (product/bank/sub-bank, Type/Sub-
Type/Mode tags, as well as properties) set as follows:

= For all file types, any attributes already in the files will be retained.

= For Samples, if the product/bank/sub-bank attributes are empty, they will be set to the
folders in which the Samples are located:

o The product will be set to the name of the folder you have selected.

o |f Samples reside in a subfolder of this folder, the subfolder name will be used as
bank.

o |f Samples reside in a subfolder of this subfolder, the name of the lower subfolder will
be used as sub-bank.

By adding a folder to the user content of your MASCHINE Library, you make their files availa-
ble in the Browser’s LIBRARY pane for quick searching and loading! For more information on
how to use the LIBRARY pane of the Browser, please refer to section 13.2, Searching and
Loading Files from the Library.

Paths to folders added via the IMPORT button in the Browser’s FILES pane will also show
up here. The only difference between adding folders via the Add button in Preferences pan-
el, described here, and via the [MPORT button in the FILES pane of the Browser is that the
latter allows you to directly tag the files as they are imported. See section 13.5.5, Using
the Result List for more information on how to import folders via the FILES pane.

Preferences
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Please note that the selected folder cannot contain, or be contained within, a folder already
listed in the User or Factory pane. If MASCHINE detects such a folder as you press OK
(Choose on Mac OS X) in the folder selection dialog, a Duplicate Location message appears:
Click OK to return to the folder selection dialog and select another folder on your computer.
Removing Folders from the User Library

You can also remove any user folder from your Library — except the default user

2.5.4  Preferences — Plug-ins Page

The Plug-ins page allows you to manage the Native Instruments and External Plug-ins you want
to use in MASCHINE.

» To display the Plug-ins page click the Plug-ins tab on the left of the Preferences panel.
At the top of the page, the Manager and Locations buttons allow you to switch between the
Manager pane and the Locations pane.

Manager Pane

» To display the Manager pane, click the Manager button at the top of the Plug-ins page.

In the Manager pane of the Plug-ins page, you can enable/disable VST/AU plug-ins, rescan
their directories, and set default presets for your Native Instruments and External Plug-ins.

When a Native Instruments or External Plug-in is disabled, it will not be available for loading
(from the various Plug-in menus in the software and from the Plug-in Browser on your control-
ler). If, for example, you do not use certain VST plug-ins in MASCHINE, it could be useful to
disable them so that they do not overload the list of available Plug-ins.

For more information on Native Instruments Plug-ins, External Plug-ins, and other Plug-ins
in MASCHINE, please refer to chapter 16, Working with Plug-ins.
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Preferences

Manager Locations

Plug-in Default Config
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v |
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v |
v m
-, [ ]

The Preferences panel — the Plug-ins page’s Manager pane.
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Element Description

Plug-in column

Lists all available VST/AU plug-ins from the directories specified in the Locations
pane (see below). This includes all enabled or disabled 32-bit VST/AU plug-ins,
when MASCHINE is running in 32-bit mode or otherwise all enabled or disabled
VST/AU 64-bit plug-ins, when MASCHINE is running in 64-bit mode.

On the left of each plug-in in the list, a checkbox allows you to enable/disable
this plug-in in MASCHINE. When a plug-in is disabled, it will not be available for
loading in MASCHINE.

Default Config column

For each plug-in you can set a default preset that will be loaded with this plug-in
when you load it. Click the folder icon on the left to choose a default plug-in pre-
set. You can also save a preset as default for the Plug-in via the Save As De-
fault... entry in the Plug-in menu. If no default is set here, the parameters of this
plug-in will be auto-mapped when loading it into a plug-in slot.

To remove a default plug-in preset, click the little cross on the right.

Rescan button

If you have changed the content of any directory specified in the Locations pane
(see below), you should rescan your plug-in directories in order to keep the list of
available external plug-ins up to date. Clicking Rescan will check the integrity of
your plug-ins and allow you to automatically detect plug-ins that were added or
removed, or deselect any plug-ins that are not working correctly for any reason.
Note that the scan will ignore the plug-ins that are disabled in the list above.

Manager Pane: Use NI Audio Units Checkbox (Mac 0S X Only)

On Mac OS X, the Manager pane contains an additional Use NI Audio Units checkbox. Check
this box to include the Audio Units (AU) versions of your Native Instruments plug-ins in the

software’s Plug-in menus and in the controller’s Plug-in Browser:

= |f this checkbox is disabled (default setting), the AU versions of your Native Instruments
plug-ins are still listed in the list above but they are disabled (checkbox unchecked):
These Plug-ins won’t appear in the Native Instruments submenu of the Plug-in menus
(software) or in the Plug-in Browser (controller). Additionally, the remaining entries for
Native Instruments Plug-ins (all of them VST) won't display the (VST) mention next to

their name.
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= |f you enable the Use NI Audio Units checkbox, all Native Instruments’ AU plug-ins are
enabled in the list above and are available for loading in MASCHINE. In order to distin-
guish them from the VST versions, Plug-in entries in the Native Instruments submenu of
the Plug-in menus and in the Plug-in Browser will display either (VST) or (AU) after their
name.

You can also enable or disable Native Instruments’ AU plug-ins individually in the list via the
checkboxes described above — as soon as you enable one of them, the Use NI Audio Units
checkbox is automatically activated.

The Use NI Audio Units checkbox relates only to AU plug-ins from Native Instruments. AU
plug-ins from third-party manufacturers are not affected by this setting.

When the Use NI Audio Units checkbox is disabled or the AU version of a Native Instru-
ments plug-in is disabled, you can still load Projects that uses this AU plug-in.

Location Pane

» To display the Location pane, click the Location button at the top of the Plug-ins page.

In the Locations section of the Plug-ins page, you can manage the various plug-in directories
you want to use in MASCHINE.
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Manager

Plug-in

\WSTPlugins 32 bith,

fstPlugins

Rescan

The Preferences panel — the Plug-ins page’s Locations pane.

The Locations pane also contains the following controls:

Element Description

Plug-in column Lists all plug-in directories used in MASCHINE. Click the folder icon on the left
of an entry to change the path of that plug-in directory.
Add button Click Add to add plug-in directories.
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Element Description
Remove button Click Remove to remove the selected directory.
Rescan button If you have changed the content of a directory (such as installed or removed plug-

ins), you should rescan your plug-in directories in order to keep the list of availa-
ble plug-ins up to date. Clicking Rescan will check the integrity of your plug-ins
and allow you to automatically detect plug-ins that are added or removed, or disa-
ble any plug-ins that are not working correctly for any reason.

2.5.5 Preferences — Hardware Page

The Hardware page enables you to customize how the pads react to your playing, and the
brightness/contrast of the MASCHINE controller displays.

» To display the Hardware page click the Hardware tab on the left of the Preferences panel.
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Display

Brightness

The Preferences panel — Hardware page.

Setting Description

Pads

Sensitivity Use the Sensitivity slider to adjust how sensitive the pads respond to your
touch. This sets the minimum threshold at which the MASCHINE control-
ler will register a “hit.”

Velocity Scaling Velocity Scaling determines how your playing is translated into velocity val-
ues: starting from Soft 3 (a soft touch is enough to get a big velocity value)
through Linear to Hard 3 (you really have to hit the pad hard to get a big
velocity value).

Display
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Setting Description

Brightness The Brightness slider allows you to adjust the brightness of both left and
right displays of the MASCHINE controller.

Contrast Left and Right With these sliders you can adjust the contrast of the left and right displays
separately.

Adjusting the Settings from the Hardware

You also have access to the Sensitivity, Brightness, and Contrast Left, and Contrast Right set-
tings from your controller. To do this, you first have to enter MIDI mode:

1.

ok wn

o

2.5.6

Press SHIFT + CONTROL (MIDI) to switch your controller to MIDI mode.
Press SHIFT + Button 4 (SETTINGS) to show the Settings Display mode.
Turn Knob 1 (BRIGHT.) to adjust the Brightness parameter described above.
Turn Knob 2 (PADSENS) to adjust the Sensitivity parameter described above.

Turn Knob 4 (CNTR.L) and 5 (CNTR.R) to adjust the Contrast Left and Contrast Right param-
eters described above, respectively.

When you're done, press SHIFT + CONTROL (MIDI) again to quit the MIDI mode and get
back to MASCHINE mode.

For more information on the MIDI mode, please refer to the Controller Editor Manual.

Preferences — Colors Page

The Colors page enables you to choose default colors for your Scenes, Groups, and Sounds.

» To display the Colors page click the Colors tab on the left of the Preferences panel.
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W White

oup Color

Close

The Preferences panel — Colors page.

Setting Description

Scene Default Selects a default color for your Scenes. In the menu you can choose the
desired color from the 16-color palette or White (default setting). The color
selected as default is highlighted in the menu. If you select Auto each
Scene will have a different default color.

Group Default Selects a default color for your Groups. In the menu you can choose the
desired color from the 16-color palette. The color selected as default is
highlighted in the menu. If you select Auto (default setting) each Group
will have a different default color.

MASCHINE - Manual - 72



Basic Concepts
Audio and MIDI Settings

Setting Description

Sound Default Selects a default color for your Sounds. In the menu you can choose the
desired color from the 16-color palette. The color selected as default is
highlighted in the menu. If you select Auto each Sound will have a differ-
ent default color. If you select Use Group Color (default setting) Sounds
will by default mirror the color of the Group they belong to.

Load with Colors Color settings are saved with your MASCHINE files (Projects, Groups,
Sounds, etc.). If you uncheck Load with Colors (checked by default), the
saved colors won't be used next time you load the files — the loaded files
will use the default colors set in this Colors page instead.

A Please note that the settings in this Colors page define default colors: These colors will only

be used when creating a new Project, resetting a Group/Sound, or when Load with Colors is
unchecked (see above). To change the color of particular objects (Sounds, Groups, Pat-
terns, Scenes) in your Project, use the Color submenu in the object’s context menu in the
software. See 14.2.4, Changing the Sound’s Color, 14.3.4, Changing the Group’s Color,
17.7.7, Changing the Pattern’s Color, and 113.2.7, Changing the Scene’s Color for more
information, respectively.

As long as an object (Scene, Sound, Group or Pattern) has the default color, this color is
not attached to the object but instead to its “position” in the respective list: In particular,
if you move the object to another position the default color will not follow the object — the
object will instead take the default color of its new position.

2.6  Audio and MIDI Settings

When MASCHINE is running as a stand-alone application, the Audio and MIDI Settings panel
allows you to configure the audio and MIDI hardware device(s) to use with MASCHINE along
with the audio routing between your audio device and MASCHINE.

» Toopen the Audio and MIDI Settings panel, select the Audio and MIDI Settings... entry
from the File menu in the Application Menu Bar (or from the File submenu in the MA-
SCHINE menu).
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A When MASCHINE is running as a plug-in in a host application, its audio and MIDI configu-

ration is managed by the host, and the Audio and MIDI Settings panel is not available. See
section 12.4, Stand-Alone and Plug-in Mode for more information on using MASCHINE in a
host environment.

The Audio and MIDI Settings panel contains three pages: Audio, Routing, and MIDI. Each
page can be displayed by clicking the corresponding tab at the top.

2.6.1  Audio and MIDI Settings — Audio Page

The Audio page holds settings related to your audio interface.

Irﬁu.u:ii-:l and MIDI Settings §1

Audio Routing MIDI ([0
Driver [ AsiO -
Device [ ASI0 Config | [ Komplete Audio 6 -]
Status | Running |
Sample Rate (44100 -]
Latency 64 Samples
Input» 3.9 ms | Processing » 1.5ms | Output » 4.4 ms | Overall » 9.8 ms

|: © Cancel :| [ @ OK :|

The Audio page of the Audio and MIDI Settings panel.

Setting Description

Driver Select your audio driver here.

Device This allows you to choose from the available devices if you have connected
more than one audio interface.

MASCHINE - Manual - 74



Basic Concepts
Audio and MIDI Settings

Setting Description

Status This shows you whether your audio interface is currently running.

Sample Rate This displays the selected sample rate of your audio interface. Please re-
start MASCHINE after changing the sample rate.

Latency Mac 0S X: This slider allows you to adjust the latency of your audio inter-
face in samples. Lower values result in a more immediate playing response
but are heavier on both the CPU and the audio driver, and may result in
audible clicks and pops. Larger values are easier on the CPU, but intro-
duce a larger latency (i.e., there may be a very small delay between when
you hit a pad and when you actually hear it). You should therefore experi-
ment with this setting so that it is as low as possible without overloading
your CPU or introducing any audio artifacts.

Windows: When using an ASIO driver, the Audio and MIDI Settings panel
shows an ASIO Config button instead of the Latency slider. Click this but-
ton to open the settings window of the selected ASIO driver.

2.6.2  Audio and MIDI Settings — Routing Page

The Routing page allows you to configure the connections between the virtual inputs/outputs of
MASCHINE and the physical inputs/outputs of your audio interface.
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-

Audic and MIDI Settings

Maschine In 3 L
Maschine In 3 R
Maschine In 4 L
Maschine In 4 R

Audio Routing MIDI (o
[ Inputs | Outputs |
Maschine In 1 L T:input 1L
Maschine In 1 R 2:Input 2 R
MaschineIn 2 L 3:input3 L
Maschine In 2 R 4: Input 4 R

5:5/PDIF Input L
6: 5/PDIF Input R
- not connected -
- not connected -

[ © Cancel :| |: @ 0K :|

The Routing page of the Audio and MIDI Settings panel (entries may vary on your computer).

Element Description

Inputs

By clicking Inputs, you can define which inputs on your audio interface
should be used for the four stereo inputs of MASCHINE. Select the inputs
of your audio interface on the right column by clicking the fields: you will
be presented with a drop-down menu with all the available Inputs. The
choices made here will determine which inputs can be used when sam-
pling external sources, for example.

Outputs

By clicking Outputs, you will be presented with a list of the 16 stereo out-
puts from MASCHINE: In the right column, you can assign them to the
outputs of your audio interface. Click the fields in the right column to se-
lect the desired outputs via a drop-down menu.

2.6.3  Audio and MIDI Settings — MIDI Page
The MIDI page allows you to set up the MIDI input and output ports that you want to use with

MASCHINE.
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F B
Audio and MIDI Settings (|

Audio Routing MIDI (o

[ Inputs | Outputs |

Device name Status
Maschine Studio In On

[QCanceIJ L @ 0K J

The MIDI page of the Audio and MIDI Settings panel (entries may vary on your computer).

Element Description

Inputs Clicking Inputs displays a list of all the available MIDI inputs of your sys-
tem. You can activate/deactivate each input by clicking the fields in the
Status column, which displays the current status of the corresponding
port.

Outputs Clicking Outputs displays a list of all the available MIDI outputs of your
system. You can activate/deactivate each output by clicking the fields in
the Status column, which displays the current status of the corresponding
port.

Clock Offset (only if Outputs is | Use the Clock Offset control to compensate delay that may occur during
selected) MIDI data transmission. Delayed MIDI Clock data will cause external devi-
ces to respond too late, thus making your track sound out of sync.

By adjusting the Clock Offset value you can set an amount of latency to be
compensated (in milliseconds). MASCHINE will then send MIDI Clock
events ahead of time as defined.
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2.1  Integrating MASCHINE into Your MIDI Setup

You can quickly integrate MASCHINE into your MIDI setup.
You can use MIDI in MASCHINE in various ways. Notably:

= You can synchronize a MIDI Clock signal between MASCHINE and other MIDI devices:
12.7.2, Sync to External MIDI Clock and 12.7.3, Send MIDI Clock.

= |f you connect a MIDI keyboard to the , you can directly play the focused Sound
with it without having to set anything up.

= You can let particular Sounds and Groups react to incoming MIDI data and send MIDI da-
ta to the desired port. More on these in section 18.2, Using MIDI Control and Host Auto-
mation.

= You can also switch Scenes remotely by sending MIDI Note or MIDI Program Change mes-
sages to MASCHINE. More on this in section 113.4, Triggering Scenes via MIDI (MA-
SCHINE Plug-in Only).

2.1.1  Connecting External MIDI Equipment

The MIDI sockets on the rear panel of the MASCHINE controller.

To connect your external MIDI equipment:
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1. Hook it up to the MASCHINE hardware controller’s or socket on the
rear panel.

2. If MASCHINE is running as a stand-alone application, activate the corresponding MIDI in-
put and/or output(s) of your MASCHINE STUDIO controller in the MIDI page of the Audio
and MIDI Settings panel (see 12.6.2, Audio and MIDI Settings — Routing Page).

3. If MASCHINE is running as a plug-in in a host application, the MIDI configuration is man-
aged by the host (see section 12.4, Stand-Alone and Plug-in Mode). Please refer to your
host documentation to know how to configure MIDI in your host.

2.1.2  Sync to External MIDI Clock

If MASCHINE is running as a stand-alone application, it can be controlled externally via MIDI
Clock by any device that is capable of sending MIDI Clock. This could be hardware such as a
drum machine, another groovebox or sequencer, or even another software sequencer.

If you use MASCHINE as a plug-in, it is automatically synced to the host application so you
don’t have to activate external MIDI sync! See section 12.4, Stand-Alone and Plug-in Mode
for more information on using MASCHINE as a plug-in.

To enable this, select the Sync to External MIDI Clock entry from the File menu:

MASCHINE - Manual - 79



Basic Concepts
Integrating MASCHINE into Your MIDI Setup

Edit View Controller Help

MNew Ctrl+M
Open... Ctrl+0
Save Ctrl+5
Save As... Ctrl+5Shift+5

Save Project with Samples...

Impert Maschine 1.x Format...

Export Audio...

Recent Files r

Preferences...

Audic and MIDI Settings...

v Syncto External MIDI Cleck %
Send MIDI Clock

Exit

Sync to External MIDI Clock activated.

You have to define at least one input in the Audio and MIDI Settings panel’” MIDI page to
enable Sync to External MIDI Clock.

When Sync to External MIDI Clock is checked, the Play button in the MASCHINE Header and
the button on your controller are deactivated.

If you want to configure MASCHINE to react to other MIDI messages than MIDI Clock, in
particular if you want to control MASCHINE notes and parameters via MIDI, please refer to
section 18.2, Using MIDI Control and Host Automation, where this is described in detail.

2.1.3  Send MIDI Clock

If MASCHINE is running as a stand-alone application, it can also send a MIDI Clock signal to
any device that is capable of receiving MIDI Clock. This could be hardware such as a drum
machine, another groovebox, or even another software sequencer.

If you use MASCHINE as a plug-in, it cannot send any MIDI Clock signal. See section 12.4,
Stand-Alone and Plug-in Mode for more information on using MASCHINE as a plug-in.
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To enable it, select Send MIDI Clock from the File menu:

Edit View Controller Help

New Ctrl+M
Open... Ctrl+0
Save Ctrl+5
Save As... Ctrl+Shift+S

Save Project with Samples...

Import Maschine 1.x Format...

Export Audio...

Recent Files »

Preferences...

Audio and MIDI Settings...

Sync to External MIDI Clock
v Send MIDI Clock %

Exit

Send MIDI Clock activated.

You can adjust the MIDI Clock offset in the MIDI page of the Audio and MIDI Settings pan-
el. See 12.6.2, Audio and MIDI Settings — Routing Page for more information.

If you want MASCHINE to send other MIDI messages than MIDI Clock, in particular if you
want to control other MIDI-capable devices via the notes played in MASCHINE, please refer
to section 18.2.4, Sending MIDI from Sounds.
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3 Browser

The Browser is the place where you can organize and categorize all of your Projects, Groups,
Sounds, Plug-in presets, and Samples. This is done by tagging them, which means categoriz-
ing them by using keywords. Given that the MASCHINE software has some advantages over the
hardware in this case, such as a very big screen and a QWERTY-keyboard, we will start with the
software first.

3.1 Browser Basics

This section describes some general concepts about the Browser.

3.1.1  The MASCHINE Library

To organize, find, keep track of, and provide you thousands of files at any time ready for load-
ing, MASCHINE makes use of a Library. The MASCHINE Library not only contains the factory
content included with MASCHINE, but also any other factory content (e.g., from MASCHINE
EXPANSIONS or other Native Instruments products) as well as your own user content.

To help you find the right file quickly and efficiently, the Library implements various techni-
ques that go far beyond the classic folder structure of your operating system. For example,
each file included in the Library can be described according to following aspects:

= The file type: Project, Group, Sound, etc.

= The content type of the file, i.e. whether it originates from a product’s factory library or if it
was created by a user.

= The product which the files comes from — this can include, e.g., a hierarchical structure
with a product category, a particular product, and possibly a bank and sub-bank of this
product.

= A variable amount of tags used to describe various characteristics of the file, for example,
the type of effect, the sonic character, the context in which it is used — in a word, any-
thing that might help you find the file.
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Note that the Library is the only other way to display and access your files: You could also
navigate to the same files in your file system. The (substantial) difference lies in the fact
that the Library organizes your files in a musically relevant way.

Which Files are Included in the MASCHINE Library?

The files included in the MASCHINE Library are all MASCHINE-relevant files found in the fold-
ers whose paths are listed in the Library page of the Preferences panel. For more information
on how to manage these library folders, please refer to 12.5.2, Preferences — Default Page.

3.1.2  Browsing the Library vs. Browsing Your Hard Disks

The Browser is your interface to the MASCHINE Library. It provides all necessary tools to
search for the files you require — and suggest other files you might not have thought of. Be-
side this, the Browser also allows you to navigate your file system in a classic way. Both are
described in the next section.

The Browser provides two operation modes, each of them providing its own tools:

= The LIBRARY pane allows you to browse the MASCHINE Library. This is the preferred way
to search for files meeting particular musical requirements. This pane also allows you to
tag your own files to your liking.

= The FILES pane allows you to browse your hard disks by using the hierarchical folder
structure of your operating system. For example you can use it to navigate files that have
not been imported into the MASCHINE Library — and you can import them from there!

In contrast to the software, the Browser on your controller can only load files that have al-
ready been added to the Library. You cannot directly access specific directories on your
hard disks with the Browser using the controller. This is why you should always import all
your files to the Library and tag them using the software beforehand.

Switching Between LIBRARY and FILES Pane

» To show the LIBRARY pane or the FILES pane of the Browser, click the corresponding
tab at the top of the Browser.
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LIBRARY

All Projects

Click the desired tab to show the corresponding pane of the Browser.

The LIBRARY pane is described in section 13.2, Searching and Loading Files from the Library,
and the FILES tab is described in section 13.5, Loading and Importing Files from Your File
System.

3.2  Searching and Loading Files from the Library

The Browser’s LIBRARY pane allows you to search for any file in the MASCHINE Library.

» To display the LIBRARY pane, click the LIBRARY tab in the top left corner of the Brows-
er.

3.2.1  Overview of the LIBRARY Pane

The LIBRARY pane contains following elements:
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LIBRARY

The elements of the LIBRARY pane.

(1) LIBRARY tah: Click the LIBRARY tab to open the LIBRARY pane described here.

(2) File Type selector: This contains six icons, each representing the different files types of MA-
SCHINE. From the left to right the file types are Project, Group, Sound, Instrument preset, Ef-
fect preset, and Sample. By clicking one of them it causes only the files of the selected type to
be displayed in the Result list (8). See section 13.2.2, Selecting a File Type.
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(3) Content selector: Click the NI icon (on the left) to select factory content or the User icon (on
the right) to select user content instead. Only the files of the content selected here will be dis-
played in the Result list (8). See section 13.2.3, Choosing Between Factory and User Content.

(4) Product selector: Click to open a drop-down menu where you can select a particular prod-
uct, product category, and sometimes the bank and sub-bank of the selected product. Again,
only the files matching your selection will be displayed in the Result list (8). See section
13.2.4, Selecting a Product Category, a Product, a Bank, and a Sub-Bank.

(5) TYPES filter: allows you to search for files based on Type and Sub-Type tags that have been
applied to them. See section 13.2.5, Selecting Type and Mode Tags.

(6) MODES filter (Instrument/Effect presets only): allows you to search for files based on Mode
tags that have been applied to them. See section 13.2.5, Selecting Type and Mode Tags.

(7) Search field: Enter any character string into the Search field to limit the search results to
the files containing this string. See section 13.2.6, Performing a Text Search.

(8) Result list: The Result list displays all files that match your query, as specified via the vari-
ous tools above. See section 13.2.7, Using the Result List.

(9) Control bar: At the bottom of the Browser, the Control bar provides a few useful tools when
browsing the MASCHINE Library, some of them depending on your selection in the File Type
selector (2):

= For all file types except Project, click the Autoload button at the far left of the Control bar
to automatically load the selected file in order to hear it in context with the rest of your
Project while it is playing. See section 13.3.1, Loading the Selected Files Automatically.

= For Samples, enable the Prehear button and adjust the volume fader next to it in order to
pre-listen to the selected Samples directly from the Browser in order to make a quick se-
lection. See section 13.3.2, Pre-Listening to Your Samples.

= For Groups, enable the Load Patterns checkbox to load the Group's Patterns together with
the Group. See section 13.3.3, Loading Groups with their Patterns.

= For all files, click the Information button (showing a little “i”) near the EDIT button to dis-
play more information on the selected file(s). See section 13.3.4, Displaying File Informa-
tion.
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= For all files, click the EDIT button at the far right of the bar to open the Attribute Editor
and modify the tags and properties assigned to the selected file(s). See section 13.4, Ed-
iting the Files’ Tags and Properties.

Overview of the Search Workflow in the LIBRARY Pane

When searching for files via the LIBRARY pane, you can progressively refine your search by fol-
lowing this typical top-to-bottom workflow.

The first two steps are mandatory:

1. Choose a file type in the File Type selector (2).
2. Select between factory content and user content in the Content selector (3).

The next steps are optional. They can be useful to further refine your search and limit the
number of search results to a reasonable amount:

1. Choose a product category or a product in the Product selector (4). If you have selected a
product you can further choose a particular bank and sub-bank of this product, if any.

2. Select tags in the TYPES filter (5) — and the MODES filter (6) for Instrument and Effect
presets — describing what you are looking for.

At any time in the procedure described above, you can use the Search field (7) to quickly per-
form a text search among the entries in the Result list (8).

The above steps are described in detail in the following sections.

3.2.1.1  Browsing the Library on the MASCHINE Controller

» Press to enter or leave the Browser.

[ GROUPS [v] CLOCATE | [__USER | [ PREY | [_HEXT | [(MRAIETTH

S-BALL KIT
El. ABEBE..IRECT KIT 1. TRAHS.T MASTER AD S50S AUTUMH KIT

REEEY ROAD wiNTAGE B8Oy KIT
! —I¥PES [ ACCENT KIT
: : REEI KIT

The Browser on your controller.

On the displays of your controller, the Browser is organized as follows:
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= The left display and the Buttons and Knobs on either side allow you to narrow your search
by selecting the file type, the content type (factory or user files), the product/bank/sub-
bank, and the desired Type (and possibly Mode) tags.

= The right display shows you the corresponding result list. It allows you to select and load
the desired file. Turn the Control encoder or Knob 8 to select any entry from the list, and
press the Control encoder or Button 8 (LOAD) to load it.

The above steps are described in detail in the following sections. In addition, you will find on
your controller most of the browsing aids available in the software, as described in section
13.3, Additional Browsing Tools.

If you want to use your hardware a lot make sure you tag all the files you want to use exten-
sively! This makes it a much easier to access them using the hardware.

3.2.2  Selecting a File Type
The File Type selector shows six icons representing the different file types of MASCHINE:

The File Type selector.

(1) Project: (.mxprj)

(2) Groups: (.mxgrp)

(3) Sounds: (.mxsnd)

(4) Instrument Plug-in presets: (.mxinst)
(5) Effect Plug-in presets: (.mxfx)

(6) Samples: (.wav, .aiff)

» Click the desired icon in the File Type selector to display only the files of that type in the
Result list.
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— The selected icon is highlighted and the files are filtered accordingly.

3.2.2.1 Selecting a File Type on the MASCHINE Controller
On your controller in Browse mode:

» At the top left of the left display, press Button 1 or 2 to select the desired file type:
PROJECTS, GROUPS, SOUNDS, INSTRUMENTS, EFFECTS, or SAMPLES.

3.2.3  Choosing Between Factory and User Content

The Content selector shows 2 icons representing the factory content on the left, and the user
content on the right:

The Content selector.

» Click the NI icon to search the factory content, or click the User icon to search the user
content.

3.2.3.1 Choosing the Factory or User Content on the MASCHINE Controller
On your controller in Browse mode:

» At the top right of the left display, press Button 4 (USER) to browse the user content (but-
ton lit and USER label highlighted) or the factory content (button off and USER label not
highlighted).

3.24  Selecting a Product Category, a Product, a Bank, and a Sub-Bank

The Product selector allows you to limit your search to a certain product category, a particular
product, a specific bank of the product, or even a sub-bank in this bank.

By default there is no particular selection in the Product selector: It reads All Projects, All
Groups, All Sounds, All Instruments, All Effects or All Samples according to the type of file
selected in the File Type selector above (see section 13.2.2, Selecting a File Type):

MASCHINE - Manual - 89
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Selecting a Product or a Product Category
» Click the Product selector to open it.

—  The Product selector opens up and shows you the following:

All Instruments

Absynth Battery
Kontakt Maschine Massive

Prism

b

Scarbee Mark | Skanner XT

Vintage Organs

The opened Product selector (for Instrument presets).

Browser
Searching and Loading Files from the Library
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(1) Product selector header: The header shows the product or the selected product category —
if there is no selection it shows a generic label (All Instruments in the picture above) corre-
sponding to the type of file selected in the File Type selector above. Click the header to close
the Product selector.

(2) Product Category filter: Shows the categories of the products that have files available in the
MASCHINE Library. Click a category of a product to select/deselect it. Selecting a category
limits the number of products shown in the Product list below (3). Only one category can be
selected at a time. You can also select a category and close the Product selector by clicking its
header (1) again: The header (1) will display the category that you have just selected, and the
TYPES filter (and MODES filter, if present) along with the Result list will be filtered by that
category.

(3) Product list: Shows the products for which files are available in the MASCHINE Library.
Click the desired product in the list. Upon your selection the Product selector automatically
closes, the product name and icon appear in the header, and the tag filter and Result list be-
low will be filtered accordingly.

MONARK

The closed Product selector with an Instrument selected.

Product categories and products are shown in the Product selector only if the MASCHINE
Library contains files for them. For example, if a Native Instruments effect from the KOM-
PLETE family is installed on your computer but you haven’t saved any user presets for it in
MASCHINE yet, its product icon will not be available in the Product selector when the user
content is selected in the Content selector. Similarly, if you haven’t updated a particular
Native Instruments effect/instrument, the icon for that product might not be available in
the Product selector when the factory content is selected in the Content selector — to pre-
vent this, make sure that all your Native Instruments products are up to date.
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Resetting the Product Selection

» To reset the selection made in the Product selector, click the little cross at the right of
the product name:

— The product selection is cancelled. The Product selector displays the generic label corre-
sponding to the selected file type (Project, Group, Sound, Instrument preset, Effect pre-
set or Sample). The tag filter and the Result list under the Product selector now include
files for all products.

Selecting a Bank and a Sub-Bank

When you select specific products in the Product list (see description above), an additional
Bank menu appears under the closed Product selector:

REAKTOR

All Banks

The Bank menu showing All Banks for REAKTOR Effects.

This Bank menu allows you to select a particular bank of files for the selected product (MA-
SCHINE in the picture above).
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» To select a particular bank for the selected product, click the Bank menu under the prod-
uct icon and choose a bank from the available entries.

REAKTOR

All Banks

ogic Filter Box

Banaan Elactrigue

Cyan

— Upon your selection the Bank menu closes and displays the selected bank. The tag filter
and Result list underneath further narrow their content accordingly.

Banks can be, e.g., additional libraries (e.g., MASSIVE EXPANSIONS), different versions of
the original Factory Library (e.g., FM7 Legacy and FM8 Factory Library), or any other con-
tent categorization specific to a particular product.

Similarly, some banks are split into several sub-banks. In that case a Sub-Bank menu appears
under the Bank menu and allows you to select a particular sub-bank. For example, in the pic-
ture below the Grain Delay sub-bank of the Maschine 2.0 Library bank is selected for the MA-
SCHINE Effect presets:

© MASCHINE

Maschine 2.0 Library
Grain Delay
The Grain Delay sub-bank in the Maschine 2.0 Library bank.

As with the product above, you can remove the selected bank and sub-bank by clicking the lit-
tle cross at the right of the bank or sub-bank name in the closed menu.

Products and Banks for User Content

When you save your own MASCHINE files, they are automatically assigned to products, banks,
and sub-banks as follows:
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= When you save Projects, Groups or Sounds, they are automatically set to the Maschine
product.

= When you save Instrument or Effect presets:

o Presets for Internal Plug-ins: The product is set to Maschine, while the bank is set to
the particular Internal Plug-in for which the preset has been saved (e.g., Sampler,
Kick, Flanger, etc.).

o Presets for Native Instruments Plug-ins: The product is set to the particular Native In-
struments effect or instrument. The bank and sub-bank will vary with each Native In-
struments product.

o Presets for External Plug-ins: The product is set to the manufacturer of the VST/AU
plug-in, and the bank is set to the particular VST/AU plug-in for which the preset has
been saved. The sub-bank is left empty. In addition, the preset is assigned to the Ex-
ternal Plug-ins product category.

3.2.4.1 Selecting a Product, a Bank, and a Sub-Bank on the MASCHINE Controller
On your controller in Browse mode:

» Press either Page button (left of the displays) so that the header above the three fields of
Knob 1-3 read PRODUCT.

[A[_INSTRUMEHTS [v [ LOCATE | [ USER | TTUPREU. [ HERT LOAD
Bl HBEE.IRECT KIT 1. TRAMS.T MASTER AESOLUTE
1] _ PRODUCT _ [r

MED
I 7 ANGELISTA WOEBELE
MASSIVE  (MASFIVE THRT | HRCHETYFE OHE

Selecting a product, a bank, and a sub-bank on your controller.

You can then use Knob 1-3 as follows:

1. Turn Knob 1 to select a product. Turn the Knob at full left to remove any particular selec-
tion (i.e. to select all products).

2. When a product is selected, turn Knob 2 to select a bank of the selected product, if any.
Turn the Knob at full left to remove any particular selection (i.e. to select all banks of the
selected product).
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3. When a bank is selected, turn Knob 3 to select a sub-bank of the selected bank, if any.
Turn the Knob at full left to remove any particular selection (i.e. to select all sub-banks of
the selected bank).

3.2.5  Selecting Type and Mode Tags

The tag filter that appears under the Product selector allows you to search for files according to
particular characteristics, effect type, sonic character, etc.

Chord Dry Glide/Pitch Mod  Lor

TYPES and MODES filters for the Massive Threat bank of the MASSIVE Plug-in.

» Click the desired tags in the tag filter to select them and limit the search to the files
marked with them. Click the selected tags again to deselect them and broaden the
search.

Tags for Projects, Groups, Sounds, and Samples: 3 Type Levels

For Projects, Groups, Sounds, and Samples, tags are structured into three hierarchical levels
globally called Types. You can select them via the TYPES filter:

= At first the TYPES filter displays the available top-level tags only.

= As soon as you select a tag at the top level, the second level appears underneath with
sub-tags of the selected tag.
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= The hierarchical structure means that the sets of sub-tags are specific to each tag of the
level above.

Example: Imagine that you are looking for a shaker Sample from the MASCHINE factory library:

= You have already selected the Maschine product in the Product selector, and the Ma-
schine 2.0 Library bank of this product (for more information on this, see section 13.2.4,
Selecting a Product Category, a Product, a Bank, and a Sub-Bank). For now the TYPES
filter shows only top-level tags:

Maschine 2.0 Library

Drums Loops One Shots

= In order to find a shaker, you first select the Drums Type from the TYPES filter.
Upon your selection the second level of tags appears underneath:

Clap
Kick

In this second level, you select the Shaker Sub-Type.
Now the third level appears with Sub-Types like Acoustic, Analog, etc.

Kick Layarac & 3

Acoustic  Analog  Digital  Vinyl
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By selecting any of these tags, say, Acoustic, you will narrow your search to this particular
Sub-Type of shakers:

Kick ayerac n

Analog Digital Vinyl

= Now imagine that you have loaded an acoustic shaker Sample and want to find a Sample
for another drum instrument, e.g., a tom: You leave the Drums tag selected at the top lev-
el of the TYPES filter and directly go to the second level, where you select Tom instead of
Shaker. As you select Tom, the whole set of Sub-Types underneath (third level) will be re-
placed with the Sub-Types of the Tom tag. However, insofar as possible your previous se-
lection will be retained: In our example, both the Shaker and Tom tags have an Acoustic
tag below them; since you had selected the Acoustic tag below the Shaker tag, the Acous-
tic tag below the Tom tag will be automatically selected as well.

Analog Digital Human

This allows you to quickly find various Samples (even for different instruments) with simi-
lar characteristics — here, an acoustic sound.
Tags for Instrument and Effect Presets: 2 Type Levels and 1 Mode Level

For Instrument and Effect presets, tags can be of two kinds: Type or Mode. You can select
them via the TYPES and MODES filter, respectively:

= The TYPES filter works as described above for all other file types, except that only two
hierarchical levels are available. See above for a detailed description.

= The MODES filter provides an additional level that is independent from the Type levels:
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o |n general, Mode tags will rather refer to technical terms (e.g., Arpeggiated, Percus-
sive, Synthetic, etc.).

o The MODES filter is always displayed. You can start your search with the MODES filter
before (or even without) using the TYPES filter.

o However, the list of tags available in the MODES filter will vary depending on the tags
selected in the TYPES filter. If no file contains both the Type and Mode tags that you
have selected, the Type tags will prevail and the Mode tags will be deselected.

If you don't select any tag in the TYPES or the MODES filter, the Result list will include all
files satisfying any of their tags.

Selecting Multiple Tags from the Same Level
In both TYPES and MODES filter you can select multiple tags from the same level:

» Hold [Shift] on your computer keyboard and click two tags at a particular level to select
these tags and all tags in-between.

» Hold [Ctrl] ([(Cmd] on Mac OS X) on your computer keyboard and click any number of
tags at a particular level to select these particular tags.

— The Result list will include all files satisfying at least one of the selected tags.

3.2.5.1 Selecting Type and Mode Tags on the MASCHINE Controller
On your controller in Browse mode:

» Press either Page button (left of the displays) so that the header above the three fields of
Knob 1-3 read TYPES or TYPES / MODES.

[T SOUHDS [+ CLOCATE | [ USER | [ PREY | [ HEXT |
El. AEBE..IRECT KIT 1. TRAMS..T MASTER

4] TYPES D
|ns‘rnurn£n'rs§ KEYZ ELECTRIC MIKE'S WUELI

Selecting Type tags on your controller (here for Sounds).
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Selecting Tags for Projects, Groups, Sounds, and Samples

When browsing Projects, Groups, Sounds or Samples, the header above the three fields reads
TYPES. You can then use Knob 1-3 as follows:

1. Turn Knob 1 to select a Type. Turn the Knob at full left to remove any particular selection
(i.e. to select all Types).

2. When a Type is selected, turn Knob 2 to select a Sub-Type of the selected Type, if any.
Turn the Knob at full left to remove any particular selection (i.e. to select all Sub-Types of
the selected Type).

3. When a Sub-Type is selected, turn Knob 3 to select a Sub-Type of the selected Sub-Type,
if any. Turn the Knob at full left to remove any particular selection (i.e. to select all Sub-
Types of the selected Sub-Type).

Selecting Tags for Instrument and Effect Presets

When browsing Instrument or Effect presets, the header above the three fields reads TYPES /
MODES. You can then use Knob 1-3 as follows:

1. Turn Knob 1 to select a Type. Turn the Knob at full left to remove any particular selection
(i.e. to select all Types).

2. When a Type is selected, turn Knob 2 to select a Sub-Type of the selected Type, if any.
Turn the Knob at full left to remove any particular selection (i.e. to select all Sub-Types of
the selected Type).

3. Turn Knob 3 to select a Mode, if any. Turn the Knob at full left to remove any particular
selection (i.e. to select all Modes).

3.26  Performing a Text Search

In the Search field you can enter your search query.

The Search field.

» Click in the Search field and type the desired text to limit the results to files containing
this text.
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The search will be performed on the file paths, the file names, the products/banks/sub-banks,
the tags, and the properties directly as you type. If you want to search for a combination of two
words (e.g. “bass” and “analog”) just enter both words in the Search field with a space in be-
tween. As you start typing, the list of matches will start narrowing in the Result list below.

On the right of the Search field, click the Reset button (showing a little cross) to reset both text
search and tag search. The Product selection is not affected.

3.2.7  Using the Result List

The Result list shows all the files that match your query:

MotStop

{ick NuPop 1

The Result list showing kicks from the MASCHINE Library.

If the list is too long to fit in the display, use your mouse wheel or drag the scroll bar on the
right to show the remaining items.

The Result list allows you to:
= Select the desired file(s).

= Load the selected file(s) into your Project (or load another Project).
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= Delete the selected file(s) from your hard disk and from the Library.
= Navigate to the selected file(s) in your operating system.

= See, and possibly edit, the attributes of the selected file(s) by clicking the EDIT button at
the bottom right of the Browser. For more information on this, please refer to section
13.4, Editing the Files’ Tags and Properties.

Selecting Files in the Result List

» To select a single file in the Result list, click its entry.
You can also select multiple files in the Result list in order to process them all at once.

To select adjacent files in the list, do the following:

» Hold [Shift] on your computer keyboard and click two files in the Result list to select
these files and all files in-between.

To select distant files in the list, do the following:

» Hold [Ctrl] ([(Cmd] on Mac OS X) and click all the files you want to select.

Loading Files via Double-Click

Double-clicking one of the matches will load the respective file. Depending on what file type
you have selected, the file will be loaded to different locations within MASCHINE:

= |If it is a Project it will load all associated files replacing all files currently in memory. If
your current Project contains unsaved changes a dialog will appear asking you if you want
to save them. This is to prevent you from losing changes by accidentally loading a new
Project without saving the old one.

= |f it is a Group, it will be loaded into the Group currently in focus.
= |If it is a Sound, it will be loaded into the Sound slot currently in focus.

= If it is an Instrument preset, it will be loaded into the first Plug-in slot of the Sound slot
currently in focus.

= |If it is an Effect preset, it will be loaded into the selected Plug-in slot.
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= |f it is a Sample, it will be loaded into the Sound slot currently in focus. The Sampler
Plug-in will be automatically loaded in the first Plug-in slot in order to play the Sample.
The Sample will spread over the entire velocity and note range.

The file loaded will replace the object previously at that position or in this slot, if any! If
needed, you can undo/redo your action via the shortcuts [Ctrl] + [Z1/[Y] (Windows) or [Cmd]
+ [Z1/1Y] (Mac OS X).

Loading Files via Drag and Drop

Except for Projects, you can also load files from the Result list into the desired location via
drag and drop. This notably has the following benefits:

= You can load the file into a Group or a Sound slot that is not currently focused, or into a
Plug-in slot that is not selected.

= You can load a Sample into its own Zone in the Zone page of the Sample Editor: A new
Zone will be created for that Sample. See section 114.5.3, Adding Samples to the Sam-
ple Map for more information.

Drag and drop of Groups and Sounds is possible only in Arrange view.

Loading Multiple Files at Once via Drag and Drop

Once you have selected multiple files from the Result list (see description above), you can drag
and drop them to the relevant locations in MASCHINE. By doing this, please keep in mind the
following:

= When dragging several Groups onto the Group List, you have following options:

o |If you drop the Groups between two existing Groups (where the insertion line appears),
the dropped Groups will be inserted between these two Groups.

o |f you drop the Groups onto an existing Group, the dropped Groups will replace that
Group and the following ones.

o |If you drop the Groups onto the “+” at the end of the Group List, the Groups will be
appended to the existing Groups in the Group List.

= When dragging several Sounds, you have following options:
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o |f you drop the Sounds onto an existing Group, the Sounds will be loaded in the empty
Sound slots of that Group — if there are not enough empty Sound slots, the Sounds
will be loaded in the first Sound slots of the Group, replacing the Sounds previously
loaded in these slots.

o |f you drop the Sounds onto the “+" at the end of the Group List, the Sounds will be
loaded in a new Group appended to the existing Groups.

o |If you drop the Sounds onto the Sound List, the Sounds will be loaded in adjacent
Sound slots, starting from the slot onto which you dropped them.

= When dragging several Instrument presets, you have the same options as when dragging
several Sounds (see above). Each Instrument preset will be loaded into in its own Sound,
and the Sound will take the name of the preset.

= When dragging several Effect presets, you have following options:

o |f you drop the Effect presets onto a Group in the Group List or onto a Sound in the
Sound List, they will be appended to the existing Plug-ins in the Plug-in List of that
Group or Sound.

o |If you drop the Effect presets between two existing Plug-ins in the Plug-in List of any
channel, they will be inserted between these two Plug-ins.

o |If you drop the Effect presets onto an existing Plug-in in the Plug-in List of any chan-
nel, they will replace that Plug-in and the following ones.

= When dragging several Samples, you have following options:

o |f you drop the Samples onto an existing Group, onto the “+"” at the end of the Group
List, or onto the Sound List, you have the same options as when dragging several
Sounds (see above). Each Sample will be loaded in its own Sound with a Sampler
Plug-in in the first Plug-in slot in order to play the Sample. The Sample will spread
over the entire velocity and note range.

o You can also drop the Samples onto the Zone page of the Sample Editor. In that case
all Samples will be loaded in the focused Sound and a Zone will be created for each
Sample. For more details, see section 114.5.3, Adding Samples to the Sample Map.

You cannot load multiple Projects at once.
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Drag and drop of Groups and Sounds is possible only in Arrange view.

Deleting Files in the Result List
You can delete user files directly from the Result list:

1. Right-click ([Ctrl]-click on Mac OS X) the desired user file and select Delete from the con-
text menu. If you want to delete several files at once, first select them as described
above, and right-click ([Ctrl]-click on Mac OS X) ([Ctrl]-click on Mac OS X) any of them.

A warning dialog opens to inform you that the file will be not only removed from the MA-
SCHINE Library but also deleted from your hard disk.

Click OK to confirm the deletion (or Cancel to keep the file).
— The file is deleted from the MASCHINE Library and from your hard disk.

N

When browsing factory content, the Delete entry is not available in the context menu.

Navigating to the Files in Your Operating System
If you want to find out the location of a particular file shown in the Result list, do the follow-
ing:

» Right-click ([Ctrl]-click on Mac OS X) any file shown in the Result list and select Find in
Explorer (Find in Finder on Mac OS X) from the context menu to open an Explorer/Finder
window pointing to the folder containing that file on your operating system.

3.2.1.1 Loading a File from the Result List on the MASCHINE MK1 Controller

The right display shows you the corresponding result list. It allows you to select and load the
desired file.

A] SOURDS [+] CLOCATE | [ USER | [ PREV | [_HEET | LOAD
LOFI EF
Ei HEEE. IRELCT KIT . 1. TRAHS. T MASTER LATUS FLOWER

1| — PRODUCT I

MAZCHINE  § MASC.ERARY | ALL

The right display showing a result list with the MARKADELLIC Sound selected.
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Check that the desired Group or Sound slot is focused and/or the desired Plug-in slot is se-
lected before loading the file from the Browser to avoid loading it at the wrong place! To
set the focus to a Group or a Sound slot, you can use the Group buttons A-H and the pads
without leaving Browse mode (see section 12.3.1, Setting the Focus on a Group or a Sound
to know how to do it). To select a particular Plug-in slot, you will need to temporarily leave
Browse mode and select the right slot (see section 12.3.2, Switching Between the Master,
Group, and Sound Level and 12.3.3, Navigating Channel Properties, Plug-ins, and Parame-
ter Pages in the Control Area for more information). In any case, don't hesitate to press
+pad 1/ + pad 2 to undo/redo your actions.

— The file is loaded in the focused Group, the focused Sound, or the selected Plug-in slot
(if it’s an Instrument Plug-in, it will be loaded in the first Plug-in slot of the focused
Sound).

If you are loading a Project, it will replace the Project currently opened. If the current Project
contains unsaved changes, a message appears in the displays asking you if you wish to save
them. Press Button 8 (SAVE) to confirm, Button 7 (DISCARD) to close the current Project without
saving the changes, or Button 5 (CANCEL) to cancel the operation and return to the current
Project.

3.3  Additional Browsing Tools

At the bottom of the Browser, the Control bar provides various useful tools that will help you
quickly find and check the files you need.

The Control bar at the bottom of the Browser.

Some of the tools are available only for specific file types. The next sections describe each of
these tools.

The EDIT button (LIBRARY pane) or IMPORT button (FILES pane) at the far right of the
Control bar allows you to edit the attributes of the files selected in the Result list above (in
the FILES pane, these are the files being imported to the Library, whereas in the LIBRARY
pane these are files already in the Library). Please refer to section 13.4, Editing the Files’
Tags and Properties for more information!
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3.3.1  Loading the Selected Files Automatically

» Click the Autoload button to enable/disable Autoload.

The Autoload button.

When Autoload is enabled, any item that you select in the Result list of the LIBRARY pane or
FILES pane is automatically loaded into the focused Group or Sound slot or into the selected
Plug-in slot, replacing any content currently in that location. This allows you to listen to this
item in context with the rest of your Project while it is playing.

Autoload is not available when browsing Projects.

Autoload is not available when browsing Samples with Prehear enabled — see section
13.3.2, Pre-Listening to Your Samples.

Autoload is not only useful to look for an appropriate Sound, Group, Plug-in preset or Sam-
ple, but can also be very inspiring: With a Pattern playing, browse through your Library with
Autoload activated and listen to Sounds and Samples you normally would not use in that
context.

3.3.1.1  Autoload on the MASCHINE Controller

On your controller in Browse mode:

» Press Buttons 5 (PREV) and 6 (NEXT) above the right display to directly load the next or the
previous file from the result list.

Autoload is not available when browsing Projects.

Autoload is not available when browsing Samples with Prehear enabled — see section
13.3.2, Pre-Listening to Your Samples. When Prehear is enabled, Button 5 and 6 select
the previous/next Sample in the result list without loading it automatically.
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3.3.2  Pre-Listening to Your Samples

When you are browsing Samples, a Prehear button and Prehear Volume slider appear next to
the Autoload button.

The Prehear controls.

» Click the Prehear button (showing a little speaker icon) to enable/disable Prehear.

When Prehear is enabled, you can directly hear Samples as you select them in the Result list
of the LIBRARY pane or FILES pane.

» Drag the Prehear Volume slider next to the Prehear button to adjust the volume of the
Samples you are pre-listening to.

The Prehear signal is sent to the Cue bus of MASCHINE. This allows you to pre-listen to Sam-
ples on a distinct output pair (e.g., in your headphones) without affecting MASCHINE's main
output! For more information on the Cue bus, see section 19.2.6, Using the Cue Bus.

Prehear is particularly useful on your controller! See below for more details.

Prehear and Autoload are mutually exclusive: Only one of them can be active at a time. For
more information on the Autoload feature, see section 13.3.1, Loading the Selected Files
Automatically.

3.3.2.1 Pre-Listening to Your Samples on the MASCHINE Controller
When browsing Samples on your controller:
» Press Button 7 (PREHEAR) to enable/disable the Prehear function.
When Prehear is enabled:

= Turn Knob 4 to adjust the Prehear volume.

= The Sample selected in the result list can be triggered from the pad of the focused Sound
or from any pad without being loaded into that Sound.
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= Pressing any other pad triggers its Sound without changing the focus. To set the focus to
another Sound you have to press + its pad or to disable Prehear.

= Turn the Control encoder or Knob 8 to select the previous or next Sample in the result
list. Upon selection this Sample is played back and the previous Sample stops playing.

= Button 5 (PREV) and 6 (NEXT) do not automatically load the Sample they select as they
usually do (see section 13.3.1, Loading the Selected Files Automatically), but instead
they play it back as well.

= To load the Sample, press the Control encoder or Button 8 (LOAD).
When you disable Prehear, the playback of any Sample still being pre-listened is stopped.

The Prehear signal is sent to the Cue bus of MASCHINE. For more information on the Cue
bus, see section 19.2.6, Using the Cue Bus.

3.3.3  Loading Groups with their Patterns

Every Group from the factory library includes a set of Patterns that illustrate possible uses of
that Group. Similarly, when you save a Group of your own to the Library for later use, all Pat-
terns you have created for that Group will be saved with the Group.

When browsing Groups, you can choose to load each Group with or without its Patterns. This is
done by clicking the Load Patterns button at the bottom of the Browser:

The Load Patterns button.

= Load Patterns button enabled: Groups will be loaded together with their Patterns. This al-
lows you to use the Patterns you have saved with the Groups. Upon loading, all Patterns
of the focused Group will be replaced, and a Clip referencing the first Pattern will be cre-
ated in the selected Scene.

= Load Patterns button disabled: Groups will be loaded without their Patterns. This allows
you to load another set of Sounds while keeping your current Patterns. Notably, this can
be very useful to try another drum kit with your current Patterns!

The Load Patterns checkbox is available only when browsing Groups.
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3.3.3.1 Loading Groups with their Patterns on the MASCHINE Controller
When browsing Groups on your controller:

» Press Button 7 (+ PAT) to include or exclude Patterns when Groups are loaded.
—  When the option is enabled (Button 7 lit and + PAT label highlighted), Groups are loaded
together with their Patterns.

3.3.4  Displaying File Information

The Information button.

» Click the Information button (showing a little “i”) next to the EDIT button in the right
part of the Control bar to display information on the file(s) selected in the Result list.

— A box appears above with various information on the selected file(s): File Format, Date
modified, File Size, Type, as well as the Author and Vendor properties, if any (see section
13.4, Editing the Files’ Tags and Properties).

WAV Fila

11/30/12 12:44:36

121.1 KB
wav
Mative Instruments

Mative Instruments

The Information box provides various information on the selected file(s).

If the selected files have different characteristics, the corresponding fields in the Information
box will read multi.
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3.4  Editing the Files’ Tags and Properties

The Attribute Editor allows you to assign or edit tags and properties to your MASCHINE files to
make it easier to find them later when browsing the MASCHINE Library in the LIBRARY pane
(see section 13.2, Searching and Loading Files from the Library).

3.4.1  Attribute Editor Basics
The Attribute Editor is used in the following situations:

= At any time you can edit the tags and properties of user files already in the Library by se-
lecting them in the Result list of the LIBRARY pane and clicking the EDIT button at the
bottom right of the Browser. After you have finished editing click APPLY to apply your
changes to the selected files, or click the lit EDIT button again to cancel you changes and
close the Attribute Editor. See section 13.2, Searching and Loading Files from the Library
for more information on the LIBRARY pane.

= When importing folders to the MASCHINE Library from the Browser’s FILES pane, click-
ing IMPORT at the bottom right of the Browser automatically opens the Attribute Editor so
you can tag the files being imported. After you have finished tagging click OK to import
the files to the Library and apply the selected tags, or click CANCEL to cancel the import.
See section 13.5, Loading and Importing Files from Your File System for more information
on the FILES pane.
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1itern selected TYPES

Loops Metal Computear

Mall...ents MNolse Creature
Massive Parcussion Famale
Metal Scratch Male
Multi FX SFX Phoneme
Multitrack Sin... Note Vocoder
Mico Strike

MNolse Swea...well

One Shots [] Vocal O

Cirean Fan

The Attribute Editor (here showing the TYPES page).

The Attribute Editor affects the files selected in the Result list of the LIBRARY pane (see sec-
tion 13.2.7, Using the Result List) or the files within the folders selected for import in the
FILES pane (see section 13.5.5, Using the Result List).

The Attribute Editor is organized into various pages:

= In the LIBRARY pane of the Browser, all pages are available: BANK, TYPES, MODES (In-
strument/Effect presets only), and PROPERTIES.

= In the FILES pane of the Browser, only the TYPES and MODES pages are available.

» Click the desired tab at the top right of the Attribute Editor to show the corresponding
page.

You can adjust the overall height of the Attribute Editor by dragging its upper border.

The number of items selected appears in yellow in the upper left corner of the Attribute Editor.

Displaying Attributes of Factory Files

When browsing in the LIBRARY pane, if the files selected in the Result list are factory files
(i.e. files from any factory content) this will be indicated by a yellow read only item label next
to the EDIT button at the bottom of the Browser:
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read only item
Factory files are loaded in the Attribute Editor.

The Attribute Editor will display the various attributes for these files, but you won't be able to
modify them.

3.4.2 The BANK Page
The BANK page is only available when opening the Attribute Editor from the LIBRARY pane.

1item salected

Maschine

e 2.0 Library

The BANK page of the Attribute Editor.

The BANK page shows you (from top to bottom) the product, bank, and sub-bank(s) of the se-
lected file(s). If any of these attributes are not set the corresponding fields read empty....

You cannot modify the attributes shown in the BANK page — they are automatically assigned
by MASCHINE.

3.4.3  The TYPES and MODES Pages

The TYPES and MODES pages display and let you modify the tags assigned to the file(s) selec-
ted in the Result list above.

= The TYPES page is available for all file types when opening the Attribute Editor both from
the LIBRARY pane and the FILES pane. It shows three columns (for Projects, Groups,
Sounds, and Samples) or two columns (for Instrument and Effect presets) according to
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the hierarchical levels of the Type tags (see section 13.2.5, Selecting Type and Mode
Tags):

1item selected TYPES

Loops et Guitar Cowbell

Mall...ents Hiha...sed Darabuka
Massive Influ...ops Djembe
Matal Parcussion kA Guiro

Multl FX Snare Tabla
Multitrack Synth Triangle v

Mico Vocal Various

= The MODES page is available when opening the Attribute Editor from the LIBRARY pane
to edit the tags of Instrument and Effect presets. When opening the Attribute Editor from
the FILES pane to import new files, the MODES page is always available, however it will
be taken into account only if Instrument or Effect presets are imported. The MODES page
shows only one column:

1item selected MODES

Additive
Arp...lated
Chord

Dry

FM

Glid... Mod
Granular

Displaying Tags

= |n both TYPES and MODES pages, tags assigned to the selected files are marked with a
check mark right of their name:
Dalay
Distortion

Downbeat
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= In the TYPES page, click the name of a tag to select it and display its Sub-Types in the
next column to the right. In each column only one tag can be selected. The selected tag is
highlighted:

MNolsea Amblence

One Shots [] Analog FX

Organ Blip & Blop

Assigning Tags

» Click the empty check box right of the desired tag name to assign this tag to the selected
files.

— A check mark appears in the check box.
Additionally, when you check a tag on the TYPES page:

= |If another column is available on the right the tag you check is automatically selected and
its Sub-Types appear in the next column (if any), allowing you to directly refine your de-
scription by checking the desired Sub-Types in this next column.

= |f you check a Sub-Type tag whose parent tag was not checked in the previous column on
the left, this parent tag will be automatically checked as well.

Be as precise as possible when tagging your files in order to be able to find what you are
looking for later.

Unassigning Tags
» Click the check mark right of the desired tag to unassign this tag from the selected files.

—  The check mark disappears.

In the TYPES page, if you uncheck a tag for which some Sub-Type tags were selected in
the columns on the right, these will automatically unassigned as you unassign their parent
tag.

Creating New Tags
You can also create your own tags both in the TYPES and MODES pages:
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» To create a new tag in any column, click the “+” symbol at the bottom of the column,
enter the desired tag name with your computer keyboard and press [Enter] to confirm.

Lo-Fi Snare
Loops O Synth
Mall...aents Vocal

Massive

“h

Adding a new Sub-Type for the Loops Type.

Deleting Tags

Tags in the TYPES and MODES pages cannot be deleted manually. However, if a tag is not as-
signed to any file anymore, it will be automatically removed from its column.

3.44  The PROPERTIES Page

The PROPERTIES page is only available when opening the Attribute Editor from the LIBRARY
pane.

1itern selected PROFPERTIES

The PROPERTIES page of the Attribute Editor.

The PROPERTIES page displays three additional attributes of the selected files:

= Vendor: Use this field to indicate the manufacturer of the selected files. Click the down-
pointing arrow on the right to quickly select any Vendor attribute already in use in other
files of the Library.

= Author: Use this field to indicate the author of the selected files. Click the down-pointing
arrow on the right to quickly select any Author attribute already in use in other files of the
Library.

= Comment: Use this field to add any other information about the selected files.
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As with the other pages of the Attribute Editor, the fields in the PROPERTIES page can be
modified only if you have selected user files in the Result list. The attributes of factory files
cannot be edited.

3.9  Loading and Importing Files from Your File System

The Browser’'s FILES pane allows you to browse your file system and import the desired folders
to your MASCHINE Library.

» To display the FILES pane, click the FILES tab in the top left corner of the Browser.

3.5.1 Overview of the FILES Pane

The FILES pane contains following elements:
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FILES

Desktop nico

zast +» Music »

The elements of the FILES pane.

(1) FILES tab: Click the FILES tab to open the FILES pane described here.

(2) Favorite bar: Displays all your Favorites. Click any Favorite to directly jump to that particular
path and display its content in the Result list (5). See section 13.5.2, Using Favorites.

(3) Location har: Displays the selected path. The Location bar provides various tools to quickly
navigate your file system. See section 13.5.3, Using the Location Bar.
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(4) Recent Locations hutton: Click this button to see a list of the last visited locations and quick-
ly jump any of them. See section 13.5.4, Navigating to Recent Locations.

(5) Result list: The Result list displays the content (files and folders) of the folder loaded in the
Location bar (3). Only MASCHINE-compatible files are displayed. See section 13.5.5, Using
the Result List.

(6) Control bar: At the bottom of the Browser, the Control bar provides a few useful tools when
browsing your file system, some of them depending on the type of the files selected in the Re-
sult list:

= For all file types except Project, click the Autoload button at the far left of the Control bar
to automatically load the selected file in order to hear it in context with the rest of your
Project while it is playing. See section 13.3.1, Loading the Selected Files Automatically.

= For Samples, enable the Prehear button and adjust the volume fader next to it in order to
pre-listen to the selected Samples directly from the Browser in order to make a quick se-
lection. See section 13.3.2, Pre-Listening to Your Samples.

= For Groups, enable the Load Patterns checkbox to load the Group's Patterns together with
the Group. See section 13.3.3, Loading Groups with their Patterns.

= For all files, click the Information button (showing a little “i”) near the EDIT button to dis-
play more information on the selected file(s). See section ».

= When a folder is selected, click the IMPORT button at the far right of the bar to import
the selected folder to the MASCHINE Library. Clicking the IMPORT button will open the
Attribute Editor so you can assign tags to the selected files about to be imported. See sec-
tion 13.4, Editing the Files’ Tags and Properties.

3.5.2  Using Favorites
Located at the top of the FILES pane, the Favorite bar displays all your Favorites.

Desktop  nico

The Favorite bar, at the top of the FILES pane.
Favorites are shortcuts to specific locations in your file system.

» Click any Favorite in the Favorite bar to jump to that location.
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— The selected location is loaded in the Location bar and its content appears in the Result
list.

Favorites can be useful if you often return to the same location while browsing your file system
in the FILES pane: Save this location as a Favorite, and at any time you will be only one click
away from that location!

The default Favorites are the roots of each of your hard disks, your desktop folder, and your
user folder.

Adding and Removing Favorites

You can add your own Favorites to the Favorite bar. This is done in the Result list:

1. Navigate to the parent folder containing the folder you want to use as Favorite, so that
this folder appears in the Result list.

2. In the Result list, right-click ([Ctrl]-click on Mac OS X) the desired folder and select Add
to Favorites from the context menu.

S| Add to Favorites m
Import to Library
Refrash

Find in Fxnlnrar

You can also remove any Favorite from the Favorite bar:

» To remove a Favorite, right-click it ([Ctrl]-click it on Mac OS X) in the Favorite bar and
select Remove from Favorites.

3.5.3  Using the Location Bar

The Location bar shows and lets you modify the selected path. At any time the Result list will
display the content of the path shown here.

Workspace C: » Users » Gast »

The Location bar.

The Location bar provides following tools:
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= Up arrow: Click the Up arrow on the left to go one level up in your file system.
= Selected path: Within the path displayed, you can:
o Click any folder name to jump to that folder:

o Click any right-pointing arrow after a folder name to open a list of its subfolders, and
select any entry in the list to jump to that folder:

Mixes
Maw Loops h
Sessions - 2013-07

Sesslons - 2013-08
Sessions - 2013-09

o If all the levels cannot be displayed in the path, click the double left-pointing arrow
left of the path to display the remaining upper levels (up to the Workspace, represent-
ing the highest level in your file system), and select any entry in the list to jump to
that location:

3.5.4  Navigating to Recent Locations

The Recent Locations button shows a clock icon at the right of the Location bar:

The Recent Location button.

The last 10 locations you have visited are stored by MASCHINE and available here:
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» Click the Recent Location button and select any recently visited location from the list.

— This location is loaded in the Location bar and its content displayed in the Result list.

3.5.59  Using the Result List

The Result list of the FILES pane shows the files and folders found in the path loaded in the
Location bar above (see section 13.5.3, Using the Location Bar).

Only MASCHINE-compatible files are shown in the Result list.

Trouble

The Result list of the FILES pane.

If the list is too long to fit in the display, use your mouse wheel or drag the scroll bar on the
right to show the remaining items.

In front of each file, an icon indicates the type of the file:
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This is an Instr

Icons for various file types.

Navigating Your File System in the Result List

You can further browse your file system in the Result list by opening any of the displayed fold-
er:

» Double-click a folder to display its content.

To return to the previous folder or to select any folder outside the folder currently displayed,
use the various tools located above the Result list:

= Favorites: 13.5.2, Using Favorites.
= Location bar: 13.5.3, Using the Location Bar.

= Recent Locations button: 13.5.4, Navigating to Recent Locations.

Selecting Files and Folders in the Result List

» To select a single file or folder in the Result list, click its entry.

You can also select multiple files and folders in the Result list in order to process them all at
once.

To select adjacent files in the list, do the following:

» Hold [Shift] on your computer keyboard and click two files in the Result list to select
these files and all files in-between.

To select distant files in the list, do the following:

» Hold [Ctrl] ([(Cmd] on Mac OS X) and click all the files you want to select.
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Loading Files from the Result List

You can load files from the Result list using the same methods as in the Result list of the
LIBRARY pane: via double-click or via drag-and-drop. For all details, please refer to section
13.2.7, Using the Result List.

Additional Features in the Result List

» Right-click ([Ctrl]-click on Mac OS X) any entry in the Result list to open a context menu
with additional commands.

Add to Favoritas
Import to Library
Refrash

Find in Explorer

The context menu in the Result list of the FILES pane (Windows depicted).

Following commands are available:

Command Description

Add to Favorites (folders only) Adds the selected folder to your Favorites. See section 13.5.2, Using
Favorites for more information.

Import to Library (folders only) Imports the selected folder(s) into the Library. See section 13.5.5,
Using the Result List for more information.

Refresh Refreshes the display of the list, in case items have been modified in
that folder.

Find in Explorer/ Find in Finder Opens an Explorer/Finder window pointing to the selected folder.

Sort by Name Sorts the Result list according to the item names.

Sort by Date Sorts the Result list according to the item dates.
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3.5.6  Importing Files to the MASCHINE Library

Apart from the huge MASCHINE factory library, you might want to use your own samples or any
MASCHINE files you received from other users. As described previously, you can load them di-
rectly from the FILES pane. If this can come in handy, e.g., to quickly check received files in a
MASCHINE context, it can get tedious when using the files on a regular basis. Furthermore,
you won't be able to find and load them from your controller nor from the LIBRARY pane (see
section 13.2, Searching and Loading Files from the Library).

For this you will have to import the files into the Library first. Importing files does not mean
they will be moved from the directory they currently reside in, they will only be referenced by
the Browser. That's why whenever you move files, make sure to update the paths to their re-
spective directories in the Library page of the Preferences panel, as described in section
12.5.2, Preferences — Default Page.

This section describes how to import files into the MASCHINE Library. When working on a
Project, you can also save individual objects (Project, Groups, Sounds, Plug-in presets, or
Samples) of the Project to the Library for later use. This will be described in each object-
specific section, later in this manual.

MASCHINE supports WAVE (.wav) and AIFF (.aiff) sample formats at a sample rate of
44.1 kHz or greater and a bit depth of 16 bits, 24 bits or 32 bits float.

The FILES pane allows you to import whole folders. All MASCHINE-compatible files found in
the selected folder(s) will be imported.

To import a folder, do the following:

1. Click the FILES tab at the top of the Browser to open the FILES pane.

2. In the FILES pane, navigate to the folder containing the folder you want to import. To do
this, use the various tools described in the previous sections.

3. Select the desired folder as described above.

4. Click the IMPORT button at the bottom right of the Browser.
You will be presented with the Attribute Editor.

5. In the Attribute Editor, tag the files you are about to import to the Library as described in
section 13.4, Editing the Files’ Tags and Properties.

6. When you are done, click OK at the bottom right of the Browser to import the files to the
Library.
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—  All MASCHINE-compatible files found in the selected folder(s) are imported to your Li-
brary. They are added as user content (User icon selected in the Content selector of the
LIBRARY pane, see section 13.2.3, Choosing Between Factory and User Content). Fur-
thermore, the paths of the imported folders are added to the list of user libraries in the
User pane of the Library page in the Preferences panel — see section 12.5.2, Preferen-
ces — Default Page for more information on this.

If the folder(s) you are importing contain different types of files (e.g., Samples, Sounds,
and Groups), the various imported files will be available by selecting the corresponding
types in the File Type selector (see section 13.2.2, Selecting a File Type).

You can also apply/remove tags at any time after they are imported. However, it may be
best to tag files on import, since it will make it easier to find them later.
Other Attributes Set During Import

In addition to the Type (and possibly) Mode tags that you can manually assign to the files be-
ing imported (see above), other attributes are automatically set as follows:

= For all file types, any attributes already assigned to the files will be retained.

= For Samples, if the product/bank/sub-bank attributes are empty, they will be set to the
folders in which the Samples are located:

o The product will be set to the name of the folder you have selected.

o If Samples reside in a subfolder of this folder, the subfolder name will be used as
bank.

o |f Samples reside in a subfolder of this subfolder, the name of the lower subfolder will
be used as sub-bank.

3.6  Locating Missing Samples

If you are loading a MASCHINE Project and one or more referenced Sample(s) cannot be found
for any reason, a dialog in which you can locate the missing Samples will appear.
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Missing Sample

A sample could not be found.

C:/Users/Gast/Music/Apt A12 (0.05 - 5.8s).wav

IGNORE ALL IGNORE LOCATE

The Missing Sample dialog allows you to locate missing Samples.

Sounds referencing missing Samples are marked with an exclamation mark. Additionally, their
Groups are also marked with an exclamation mark when selected.

The Missing Sample dialog shows you which Sample cannot be found. Three buttons at the
bottom of the dialog let you choose between following actions:

= |IGNORE: Click this button to continue loading your Project without locating the missing
Sample. You will be able to locate it at a later time (see below).

= |GNORE ALL: Click this button to ignore the missing Sample as well as all other missing
Samples, if any. You will be able to locate them at a later time (see below).

= LOCATE: Clicking this button opens a Locate selection dialog in which you can manually
locate the missing Sample. Navigate to the desired Sample in your file system and click
Open. Consequently, your Project uses the newly selected Sample in place of the missing
one. If other Samples are missing, MASCHINE tries to trace their path starting from the
path you just indicated.

Locating or Purging Missing Samples at a Later Time

When Sample references cannot be resolved, two additional Purge Missing Samples and Find
Missing Samples appear in the context menu of the affected Sound(s) in the Sound List.
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Group B1 +  Pattern i

Drum Loop

Purge Missing Samples I}
Find Missing Samplas

Import MIDI...
Export MIDI...
Color

Copy

Dacta

The Purge Missing Samples and the Find Missing Samples entries in the context menu of a Sound whose Sample is missing.

» Select Purge Missing Samples from the Sound slot’s context menu to remove the missing
Sample(s) from that Sound.

» Select Find Missing Samples from the Sound slot’s context menu to open the Missing
Sample dialog again and locate missing Samples for that Sound.

The same commands also appear in the context menu of the parent Group in the Group List,
as well as in the in the File submenu of the MASCHINE menu (in the MASCHINE Header):

= In the context menu of the parent Group, these commands will affect all Sounds with
missing Samples in that Group.

= |n the File submenu of the MASCHINE menu, these commands will affect all Sounds with
missing Samples in your Project.

3.1  Using Quick Browse

Quick Browse is a feature that allows you to quickly recall a search query you performed to get
to a given file. Let's say you have loaded a kick Sample after browsing the Library, then loaded
a snare Sample to another Sound slot and now you realize you are not satisfied with that kick
Sample, but you heard a nice kick Sample just before you chose the current one. Normally you
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would now have to try to remember the name or the tags you used to find it, or browse all kick
Samples (given that the MASCHINE Library already has several hundreds of kick Samples, this
may take a considerable amount of time). With Quick Browse you can restore the query with
just one click.

Quick Browse is available for Samples, Plug-ins presets (Instruments and Effects), Sounds,
Groups, and Projects. Depending on the type of file you are looking for, the Quick Browse func-
tion is activated by clicking the magnifying glass in either of the following locations:

= Quick Browse for Projects, Groups and Sounds: Click the magnifying glass right of the col-
ored file name appearing in the upper left part of the Control area to recall the search
query that was used for that file. That file will be:

o The focused Group if the GROUP tab is selected above:

':ﬁ:' GROUP

Blitch Kit
D

Input

o The focused Sound if the SOUND tab is selected above:

= Quick Browse for Instrument/Effect presets and for Samples: Click the magnifying glass in the
upper right corner of the Control area to recall the search query that was used for the
Plug-in in the selected slot:
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o |f a Sampler Plug-in is selected, it will recall the search query used for the Sample
loaded in that Sampler. If several Samples are loaded in the Sampler, it will recall the
search query for the Sample in the selected Zone in the Zone List.

o If any other Instrument or Effect Plug-in is selected, it will recall the search query
used for the Plug-in preset loaded in that Plug-in (the preset name appears next to the
magnifying glass):

Flange Me 0

OuUTPUT

Upon your click on the magnifying glass, the search query for the corresponding file will be
restored in the LIBRARY or FILES pane of the Browser (depending on which of both panes was
used to find the file). The file will be shown in the Result list — if necessary, the list will be
scrolled to display the file. You can then choose other results for that query from the Result
list.

The Quick Browse function is also available from your controller! See below for more infor-
mation.

If No Search Query Was Used for a File...

If a file of your Project wasn’t loaded via a search in the Browser, obviously there is no search
query to be retrieved! Nevertheless, Quick Browse will try various techniques to find out where
the file “comes from.” For example, if you have loaded a file via drag and drop from your desk-
top or any other location on your computer, Quick Browse will display the FILES pane pointing
to that location.

3.1.1  Using Quick Browse on the MASCHINE Controller

Quick Browse is also available on your controller. To use it, you first have to select the desired
file in your Project:
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1. Press to enter Control mode.
If you want to trigger Quick Browse for a Group or a Sound, set the focus to this Group or
Sound — see section 12.3.1, Setting the Focus on a Group or a Sound.

3. If you want to trigger Quick Browse for a Sample or a Plug-in preset, additionally select
the slot of that Plug-in (for a Sample this is the Sampler) — see section 12.3.2, Switch-
ing Between the Master, Group, and Sound Level and 12.3.3, Navigating Channel Proper-
ties, Plug-ins, and Parameter Pages in the Control Area.

Once the desired file is focused/selected, use the Browser of your controller:

1. Press to enter the Browser.

2. Press Button 1 and 2 to select the file type corresponding to the file you have focused/
selected above.

3. Press Button 3 (LOCATE) to trigger the Quick Browse function.

— The Browser of your controller automatically recalls the search query used for that file.
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4 Managing Sounds, Groups, and Your Project

This chapter explains how to handle the various objects that structure any MASCHINE Project:
Sounds, Groups, and the Master.

4.1  Overview of the Sounds, Groups, and Master

In a MASCHINE Project, objects are organized into three hierarchic levels, from the lowest to
the highest:

= Sounds are played by the pads. They are loaded into Sound slots. In the software, in Ar-
range view Sound slots are displayed in the column at the left of the Pattern Editor: the
Sound List (1). Each Sound of the selected Group is by default mapped to one of the 16
pads on the MASCHINE hardware controller, so you can play all Sounds of a Group by
pressing the pads. Sounds are made up of any number of Plug-ins that process the audio
in series. Sounds are the only objects in MASCHINE that can accept Instrument Plug-ins
— these go in the Sounds’ first Plug-in slot. The type of the Plug-in (Instrument or Effect)
loaded in this first Plug-in slot will define the Sound’s role (audio source or bussing point,
respectively). For more information on Plug-ins and how they define the Sound’s role,
please refer to section 16.1, Plug-in Overview.

= Groups contain 16 Sound slots each with all their parameters. The 16 pads on your con-
troller can play one entire Group at a time. In the software, in Arrange view Group are dis-
played in the column at the left of the Arranger: the Group List (2). A MASCHINE Project
can have any number of Groups, which are organized in banks of eight Groups each. Each
Group can have any number of insert effects, which will globally apply to all Sounds con-
tained in that Group, as well as any number of Patterns organized in banks of 16 Patterns
each. More on Patterns in chapter 17, Working with Patterns.

= The Master is the place where all signals from the Groups are being mixed together. Just
like the Groups and Sounds, the Master can host any number of insert effects.
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The Sound List (1) and the Group List (2) in the Arrange view of the software.

41.1  The Sound, Group, and Master Channels

From a routing point of view, each Sound, each Group, and the Master represents a distinct
channel in MASCHINE. The channels of the 16 Sounds in a Group are mixed together and sent
to the Group channel, where their sum will be processed by the Group’s Plug-ins, if any. Simi-
larly, the channels of all Groups in your Project are mixed together and sent to the Master
channel, where their sum will be processed by the Master’s Plug-ins, if any. The resulting sig-
nal is sent to MASCHINE's outputs.

Each channel provides various set of Channel properties that adjust the input, output, groove,
and Macro Control settings for that particular Sound, Group, or for the Master, independently
of the Plug-ins it contains. Please refer to chapter 18, Audio Routing, Remote Control, and
Macro Controls and section 15.2.4, Groove for more details on these.
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When the software is in Mix view, Sounds, Groups, and the Master are represented by channel
strips in the Mixer. This view provides you with an intuitive control on both the audio and MIDI
routings of any Sound, Group, and the Master. Please refer to section 19.2, The Mixer for more
information.

Mastar

Bouncer Ampe..vinet Alien lce Scratchy Worl..Loop] MNois..Drums

= Saturator

——a

GROUP GROUP GROUP GROUP GROUP GROUP GROUP GROUP

The Mixer displaying the channel strips for all Sounds in a Group.

4.1.2  Similarities and Differences in Handling Sounds and Groups

Sounds and Groups are handled in very similar ways — see section 14.2, Managing Sounds
and 14.3, Managing Groups below for all details. We list here the main differences between
both:

= In each Group you always have a fixed number of Sound slots — namely 16. Some of these
Sound slots might be empty, and you can have gaps in your slots (i.e. some empty Sound
slots between other slots containing Sounds), depending on how you prefer to play your
Sounds from your pads. You cannot create Sound slots, but instead you can load/unload
Sounds to/from the 16 existing Sound slots in each Group.
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= In your Project you can have any number of Groups. You can create, fill up, and delete
Groups as you see fit. If you delete a Group, all following Groups are shifted up in the
Group List to fill the gap. If you use more than eight Groups, another Group bank is auto-
matically created.

41.3  Selecting Multiple Sounds or Groups

In MASCHINE you can select multiple Sounds or multiple Groups at once. This notably allows you
to change a parameter value for all selected Sounds/Groups at a time!

To achieve this, MASCHINE distinguishes the “focus” from the “selection”:

= The focus determines what is displayed in the Control area and on your controller. For ex-
ample, by clicking a Sound in the Sound List you are putting the focus on that Sound,
and the Control area and your controller will display its parameters (Channel properties,
Plug-ins, etc.). For the focus, the following rule applies:
At each level (Sound and Group) there is always one object, and only one, in focus.
The focused object is highlighted in the Sound/Group List, and the background of its
leading letter and/or number has the color of the object itself.

The Sound Vocal AhHa is focused (and selected).

= The selection, on the other hand, determines what will be affected by your actions (e.g.,
adjusting a parameter). For example, the focused Sound (i.e. the one you clicked in the
Sound List) is implicitly selected — nothing special here: This just means that the Sound
whose parameters are currently displayed will be indeed affected by the changes you do
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on these parameters. But you can select additional objects on top of the focused object,
thereby extending your selection. Selected objects are highlighted in the Sound/Group
List but their leading letter and/or number stays gray.

Vocal AhHa
I Ride C lated

| I Rida

Other Sounds were added to the selection (but they are not focused).

More precisely, if a Group or a Sound is currently focused, you can additionally select other
Groups or Sounds, respectively. These will be also affected by your edits on the focused Group
or Sound.

You cannot select Sounds and Groups simultaneously.

Each Group remembers its own Sound selection and focus.
When setting the focus to a new Sound or Group, following rules apply:

= |f you set the focus to a Sound or Group which is not selected, both the focus and the
selection are moved to this new Sound or Group.

= |f you set the focus to a Sound or Group which is already included in the current selec-
tion, the focus is moved to this new Sound or Group but the selection is preserved. This
notably allows you to check the parameters of any selected Sound or Group while keeping
the ability to modify parameters for the entire selection.

What Is Affected by the Multiple Selection, and How?

When multiple Sounds or multiple Groups are selected, any change in the following settings of
the focused Sound/Group will be mirrored in the other selected Sounds/Groups, respectively:
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= Channel properties: Parameter adjustments apply to all selected Sounds/Groups for any pa-
rameter in any set of Channel properties. See chapter 18, Audio Routing, Remote Control,
and Macro Controls for more information on the Channel properties.

= Plug-ins: Parameter adjustments apply to all selected Sounds/Groups that have the same
Plug-in loaded in the same Plug-in slot. See chapter 16, Working with Plug-ins for more
information on Plug-ins.

= Pad view: Base key, Choke group, and Link group settings apply to all selected Sounds.
See section 15.1, Adjusting Your Pads for more information on these settings.

= You can move multiple Sound slots or multiple Groups at once. See section 14.2.7, Mov-
ing Sounds and 14.3.7, Moving Groups for more information.

= You can reset multiple Sound slots and delete multiple Groups at once. See section
14.2.8, Resetting Sound Slots and 14.3.8, Deleting Groups for more information.

A The adjustments made in the Assignment area are never mirrored in any other selected
L\ Sound/Group.

Furthermore, the exact influence on the equivalent parameter in the affected Sounds/Groups
depends on the type of parameter:

= Continuous parameters (knob): the values in all selected Sounds/Groups are incremented/
decremented by the same amount as the value in the focused Sound/Group. Values are
clipped when they reach their range limit.

= Discrete parameter (button or selector): the values in all selected Sounds/Groups are set
to the value of the focused Sound/Group.
Selecting Multiple Sounds/Groups in the Software

To select multiple Sounds or multiple Groups in the MASCHINE software, simply use the com-
mon keyboard shortcuts of your operating system: in the Sound List or the Pad view for
Sounds, and in the Group List for Groups. Following actions are available:

Action Function

Selecting Objects (Sounds or Groups)

Click unselected object Selects the object and sets the focus to it.
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Action Function

Click selected object Sets the focus to this object while retaining the selec-
tion.

[Ctrl]-click ([Cmd]-click on Mac OS X) unselected ob- | Adds the object to the selection.
ject

[Ctrl]-click ([Cmd]-click on Mac OS X) selected object | Deselects the object — except for the focused object,
which cannot be deselected.

[Shift]-click object Selects all objects between the focused one and the
[Shift]-clicked one.

[Ctrl] + [A] (ICmd] + [A] on Mac OS X) if some ob- Selects all objects in the list.
jects are not selected

[Ctrl] + [A] ([Cmd] + [A] on Mac OS X) if all objects Deselect all objects except the focused one, which
are selected in the list cannot be deselected.

The shortcuts mentioned in the table above are valid in following areas of the MASCHINE win-
dow:

= To select multiple Groups, use these shortcuts in the Group List.

= To select multiple Sounds, use these shortcuts in the Sound List or in the Pad view (see
section 15.1.1, The Pad View).

41.3.1 Selecting Multiple Sounds/Groups on the MASCHINE Controller
On your controller, you can select multiple Sounds or Groups via the Select mode:

1. Press and hold to enter Select mode. You can also press + Button 1 to
pin this mode and make it permanent.

Ensure that EVENTS (Button 2) is disabled — if it is enabled, press Button 2 to disable it.

n

—  You are ready to select more than one Sound or Group.

EEEYSll [ EVENTS || FREV [ HEXT | [ ALL || HOHE | MULTI

B GLCRATGHYT 150 0 AR AFT..HAYE 1t
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Selecting Sounds and Groups via the Select mode.
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You have following selection tools at your disposal:

Selection Tool Description

Pads Press any pad to set the focus to that particular Sound slot. The pad lights up to
indicate that the Sound slot is focused (and selected). Unlit pads indicate unse-
lected, empty Sound slots, and half-lit pads indicate unselected Sounds. The se-
lection behavior depends on the state of the MULTI option (Button 8, see below).

Group buttons A-H Press any Group button to set the focus to that particular Group in the current
Group bank. The button lights up to indicate that the Group is focused (and selec-
ted). Unlit Group buttons cannot be pressed (they don’t correspond to any existing
Group), and half-lit Group buttons indicate unselected Groups. The selection be-
havior depends on the state of the MULTI option (Button 8, see below).

Button 3/4 (PREV/NEXT) Selects the previous/next Group bank, respectively.

Button 5 (ALL) Selects all Sounds in the current Group without changing the focus.

Button 6 (NONE) Deselects all Sounds in the current Group except the focused Sound.

Button 8 (MULTI) Enables/disables the multiple selection mode. Toggling this option does nothing to
the current focus nor selection but changes the behavior of the selection process
— see below.

The MULTI option (Button 8) switches between single and multiple selection:
= When MULTI is disabled (Button 8 off):

o Pressing the Group button / pad of an unselected Group/Sound sets the focus to that
Group/Sound and clears the current Group/Sound selection (only the focused Group/
Sound is then selected). The Group button / pad lights up.

o Pressing the Group button / pad of a selected Group/Sound only sets the focus to that
Group/Sound without changing the current Group/Sound selection. The Group button /
pad stays fully lit.

= When MULTI is enabled (Button 8 on):

o Pressing the Group button / pad of an unselected Group/Sound adds it to the current
Group/Sound selection without changing the current focus. The Group button / pad
lights up.

o Pressing the Group button / pad of a selected Group/Sound unselects it unless it is the
focused Group/Sound. The Group button turns half lit; the pad turns half lit (if it con-
tains a Sound) or off (if it is empty).
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4.2  Managing Sounds

This section describes the global editing functions available for Sounds and Sound slots.

Sounds: Sound List or Pad View

With the exception of naming Sound slots, all procedures described in the following sections
are available both in the Sound List and in the Pad view. The Pad view is an alternative repre-
sentation of your Sound slots that puts emphasis on their relationship with the pads on your
controller.

C1
Mona  Master

Mona  Master

The Pad view.

The Pad view can be shown by activating the Pad View button above the Sound List:

1 African Plucks

2 I Bumpar

The Pad View button.

» Click the Pad View button to show or hide the Pad view.

— The Pad view replaces the Sound List on the left of the Pattern Editor.
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In the Pad view, each cell represents a pad on your controller and corresponds to a Sound slot
in the current Group. You can select Sound slots in either the Sound List or the Pad view as
you see fit, both selections are strictly equivalent.

In addition to the Sound management features described in the following sections, the Pad
view provides extra settings affecting the behavior of your pads. See section 15.1, Adjust-
ing Your Pads for more information.

4.2.1 Loading Sounds

You can load a readymade Sound from the Browser or from your operating system. The Sound
can be included in the MASCHINE Library or any EXPANSION PACK but it can also be a
Sound you have created yourself and saved for later use.

You have many methods at your disposal to load a Sound:

= Drag and drop: Select the desired Sound in the Browser or in your operating system and
drag it onto the desired Sound slot in the Sound List (or the corresponding cell of the pad
grid in Pad view, see above) to load it in that Sound slot. Any Sound previously loaded in
that slot will be replaced.

= Double-click: Double-click the Sound in the Browser or the Sound file in your operating
system to replace the focused Sound in the Sound List.

= Context menu: Right-click ([Ctrl]l-click on Mac OS X) the desired Sound slot in the Sound
List or the corresponding cell of the pad grid in Pad view, and select Open... in the con-
text menu. In the Load Sound dialog that opens, navigate to the desired Sound file on
your computer and click Open to load it. The loaded Sound will replace the current Sound
loaded in that slot.

You can also recall the search query that was used to find the Sound currently loaded in
the focused Sound slot. See section 13.7, Using Quick Browse for more information.

In your operating system, Sound files have the extension “.mxsnd” (MASCHINE 2) or
“.msnd” (MASCHINE 1.x).

Please refer to chapter 13, Browser for more information on the Browser.
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4.2.1.1 Loading Sounds on Your Controller
On your controller, use the Browser to load Sounds:

= You can browse your MASCHINE Library for the desired Sound. For more information on
how to do this, please refer to section 13.2, Searching and Loading Files from the Library.

= Alternatively you can recall the search query that was used to find the Sound currently
loaded in the focused Sound slot. See section 13.7, Using Quick Browse for more infor-
mation.

4.2.2  Pre-listening to Sounds

You can pre-listen to the Sounds of the focused Group as you set the focus on them in the
software. To do this:

» Click the speaker button above the Sound List (or the Pad view) to enable/disable Sound
pre-listening in the focused Group:

— When the speaker button is enabled, each time you set the focus on a Sound by clicking
it in the Sound List or in Pad view, this Sound will be played back. This is useful as
quick reminder of the various Sounds loaded in the Group.

4.2.2.1 Pre-listening to Sounds on the MASCHINE Controller

On your controller, pre-listening to Sounds actually is the default behavior: In Control mode,
when you press a pad you both trigger its Sound and bring it into focus at once. Hence, you
don’t need to enable anything, pre-listening to Sounds in the focused Group is working out of
the box.
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Setting the Focus on Sounds Without Triggering Them

You can also set the focus on any Sound in the current Group without triggering it. This comes
in handy if you are in a live situation and don’t want to trigger every single Sound you select.
To do this, use the Select mode:

1. Press and hold the button.

2. Check that Button 2 (EVENTS) is disabled — if necessary, press it to disable it.

3. Press the pad containing the desired Sound.

— The Sound is focused without being triggered.

4.2.3 Renaming Sound Slots

By default, Sound slots are named Sound 1-16. If you load a Sound, a Plug-in preset or a
Sample (e.g., from the Browser) into the Sound slot, the Sound slot takes the Sound’s, preset’s
or Sample’s name.

You can also rename Sound slots manually. Naming is only available from within the software,
but any changes will also show up on your controller.

To rename a Sound slot:

1. Double-click the name of the desired Sound slot or right-click ([Ctrl]-click on Mac OS X)
the Sound slot and select Rename from the context menu.
The Sound slot’s name is now highlighted and editable.

Ektl A 1

2. Modify the name of the Sound slot via your computer keyboard. Press [Enter] on your
computer keyboard to confirm.

If you use MASCHINE as a plug-in, some hosts will utilize the [Enter] key, as it is mapped

to some function of the host software. In this case, click anywhere else in the MASCHINE
plug-in window to confirm the name you have entered.
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4.24  Changing the Sound’s Color
You can change the color of each individual Sound in the software. To do this:

1. Right-click ([Ctrl]-click on Mac OS X) the desired Sound slot in the Sound List or in the
Pad view and select Color from the context menu.
A Color Palette appears. In the Palette, the current color of the Sound is highlighted.
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2. Select the desired color in the Palette. You can also choose to set the Sound back to the
default color corresponding to its position in the list by selecting Default in the Color Pa-

lette.

—  The pads of the MASCHINE STUDIO, MASCHINE MK2, and MASCHINE MIKRO MK2
controllers mirror the Sound colors you have selected.

By default Sounds inherit the color of their Group. But you can choose another default col-
or for Sounds in Preferences > Colors > Sound Default. See section 12.5.6, Preferences —
Colors Page for more information.

Once you have set a custom color for a Sound as described above, the Sound will retain its
color when you move it in the Sound List, and the color will be stored with the Sound when
you save the Sound for later use. Note that you can select the same color as the one used
by default: In that case the color (even unchanged) will be considered as a custom color
and will follow the Sound as you move it.

MASCHINE - Manual - 143



Managing Sounds, Groups, and Your Project
Managing Sounds

4.2.5 Saving Sounds

You can save your Sounds as individual files (extension “.mxsnd”). This can be only done in
the software.

Saving Your Modifications into the Original Sound File

If you have made changes to a Sound loaded in your Project, you can save your modifications
as follows:

» Right-click (on Mac OS X: [Ctrl]-click) the Sound slot in the Sound List or in the Pad view
and select Save from the context menu:

Open...

Save I}

Save As...

Impart MIDL...
Export MIDL...
Color 3

Paste

Rename

Reset

HermannsHérna

—  Your modifications are saved to the Sound file.

Even if you don’t save a Sound individually, its current settings will still be saved with your
Project. But once a Sound is saved and tagged, it is available in the Browser for use in oth-
er Groups and Projects.

You cannot save changes to factory files — these files are read-only. If you run the Save com-
mand on a factory file, it automatically turns into the Save As... command: a Save Sound dia-
log opens and lets you save your modified Sound to your user library. See next paragraph for
more details. The same happens with Sounds you have built from scratch.
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Saving Your Modified Sound as a New Sound

If you want to save modifications you have made on a Sound originating from a factory library,
or if you don't want to overwrite the original Sound with your modified version, or if there is no

original version of your Sound (i.e. you built it from scratch), you can save it as a new Sound
file:

1. Right-click (on Mac OS X: [Ctrl]-click) the Sound slot in the Sound List or in the Pad view
and select Save As... from the context menu:

HermannsHérna

A Save Sound dialog appears. By default, the Sound file inherits the name of its Sound
slot and it will be saved in your Standard User Directory (as defined in Preferences > Li-
brary > User, see section 12.5.2, Preferences — Default Page for more information).

2. If you wish, choose another path and/or type another name with your computer keyboard.
3. Press [Enter] to confirm and close the Save Sound dialog.

—  Your Sound is now saved.

The Sound will be added to the user library and is ready to be tagged in the Browser — see
section 13.4, Editing the Files’ Tags and Properties for more information on this.

Even if you don’t save a Sound individually, its current settings will still be saved with your

Project. But once a Sound is saved and tagged, it is available in the Browser for use in oth-
er Groups and Projects.
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4.2.6  Copying and Pasting Sounds

You can copy and paste Sounds across Sound slots (and thereby across pads) and Groups in
your Project.

In the software, Sounds are copied without their note content in the Pattern. To include the
note content in the copying operation, use on your controller (see below)!

To copy and paste Sounds in the software:

1. Right-click (on Mac OS X: [Ctrl]-click) the Sound slot (in the Sound List or in the Pad
view) containing the Sound you want to copy.

2. In the context menu, choose Copy to copy the Sound.

HermannsHbrna

3. To paste the Sound, right-click (Mac OS X: [Ctrl]-click) another Sound slot (this can also
be in another Group, in this case first click the desired Group in the Group List of the Ar-
ranger) and select Paste from the context menu.

— All parameters of the Sound will be copied except for the source’s Pattern content. The
Sound previously loaded in that Sound slot will be replaced.

If you want to copy a Sound more than once, just keep on choosing Paste from the context
menu on other Sound slots: the source Sound stays in the clipboard, ready for the next use!
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4.2.6.1 Duplicating Sounds on Your Controller
On your controller in Control mode, do the following to copy a Sound from one pad to another:

1. Press and hold

2. If you want to duplicate a Sound including its Pattern content, enable the + EVNT option
(Button 2).

3. Press the pad of the Sound you want to copy.
The pad of the Sound starts blinking.

4. Press the pad of the target Sound slot (this can also be in another Group, in this case first
press the desired Group button).

— Al parameters of the Sound will be copied (including the Pattern content for that Sound
if you have enabled the + EVNT option). The copied Sound will replace any Sound previ-
ously loaded in the target slot.

You will notice that once you have pasted the Sound, the target pad starts blinking itself, indi-
cating that it is ready to be pasted again to additional Sound slots: Therefore, to duplicate a
Sound more than once, once you have pressed the source pad you just have to press all the
desired target pads in a row.

Instead of holding , you can also pin the Duplicate mode by pressing
+ Button 1. You can then release : Your controller will stay in Duplicate
mode until you press again. See section 12.3.5, Pinning a Mode on Your Con-

troller for more information.

4.2.1  Moving Sounds

You can reorder Sounds via drag-and-drop in the software. It can be helpful to organize your
Sounds more conveniently. Notably, this allows you to move your Sounds to other pads, and
create a Group that is easier to play from the pads.

You can select multiple Sounds to move them all at once! See 14.1.3, Selecting Multiple
Sounds or Groups for more information.

To move one or more Sounds:
1. Click and hold the desired Sound slot(s) in the Sound List or in the Pad view.
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2. While holding the mouse button, drag your mouse toward the desired location in the
Sound List or in the Pad view.
As the mouse cursor moves an insertion line appears at the potential places where you
can drop the Sound slot(s).

I Trang..oulOne
Vocal AhHa

Rida C..aPlatad

3.  When the insertion line appears at the desired location in the Sound List or in the Pad
view, release the mouse button.

— Each Sound takes its new place in the Group. On your controller, the Sounds will be trig-
gered by the pads whose numbers appear left of the Sound slots in the Sound List or on
the cells in the Pad view.

You can also drag Sounds to another Group in the Group List of the Arranger: The Sounds will
be inserted in the first empty Sound slots of that Group, and that Group will automatically get
the focus. However, in that case the Pattern content of the Sounds won’t be moved.

If you drag the Sound(s) to the “+” at the end of the Group List, a new Group is automati-
cally created and your Sound(s) will be moved to the first Sound slot(s) of that Group.

4.2.8 Resetting Sound Slots

Resetting a Sound slot will remove the Sound it contains and put all its settings (Channel
properties, name, color...) back to their default values.

You can select multiple Sound slots to reset them all at once! See 14.1.3, Selecting Multi-
ple Sounds or Groups for more information.
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» To reset a Sound slot, select it in the Sound List or in the Pad view and press [Del] on
your computer keyboard, or right-click (on Mac OS X: [Ctrl]-click) the Sound slot and
choose Reset from the context menu.

— The content of the Sound slot is removed and the Sound slot is reset to its default set-
tings and name.

Pattern 1

Kick Autopsy |

Kick MuPop 1

Resetting a Sound slot.

4.2.8.1 Resetting a Sound Slot on Your Controller

» Toreset a Sound slot, hold + and then touch the pad corresponding to the
Sound slot to be reset.

— The Sound is removed from the pad and the pad turns off.

4.3  Managing Groups

This section describes the global editing functions available for Groups.
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Group Menu

Many of the functions described in the following sections are available in the following two
context menus:

= The context menu of the Groups in the Group List, opened via a right-click ([Ctrl]-click on
Mac OS X) on the desired Group:

Open...

Save
Save As...
Save with Samples...

Impart MIDL...
Export MIDI...

Color
m Distortion Copy

m Phaser
+

Lead

= The context menu of the focused Group in the Pattern Editor, opened via a right-click
([Ctrl]-click on Mac OS X) on the Group name in the top left corner of the Pattern Editor:

Open...

Save

Save As...

Save with Samples...

Impart MIDI...

Export MIDL...

Both context menus are equivalent: Use either menu as you see fit.
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4.3.1  Creating Groups

Creating a Group will add a new empty Group at the end of the Group List. You can then fill
this Group with the Sounds of your choice.

» To create a Group, click the “+" at the end of the Group List.

navigation_project

Bl ea

B1 I Baat

c1 I

— A new empty Group is created at the end of the Group List with the default name and
color.

Automatic Group Bank Management

In MASCHINE Group banks are managed automatically, so that you don’t have to create or de-
lete them manually. Group are always adjacent in the Group List: you cannot have any gap in
the Group List — nor in any Group bank. When you create a new Group, the following happens:

= As long as the last Group bank contains less than eight Groups, the new Group is created
in that bank.

= |f the last bank already contains eight Groups, a new Group bank is automatically created
after the existing bank(s) and the new Group is created in that new bank.

4.3.1.1 Creating Groups on the MASCHINE MK1 Controller
On your controller, existing Groups are indicated by the lit Group buttons A-H:

= The focused Group is indicated by the fully lit Group button.
= The other Groups of your Project are indicated by half-lit Group buttons.

= In the last Group bank the last lit Group button is always dimmed: It doesn’t correspond
to any existing Group, but instead allows you to create another Group in your Project.
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To create a new Group:

1. Hold and press the last lit Group button to select the last Group bank.
2. Release
3. Press the dimmed Group button after all other lit Group buttons.

— A new empty Group is created after the existing Groups with the default name and color.

If the last Group bank already contains eight Groups, pressing + the last lit Group
button at the first step will directly create a new empty Group in a new Group bank!

Creating Groups via the Select Mode

You can also use the Select mode to create Groups from your controller:

1. Press and hold to enter Select mode. You can also pin the Select mode by press-
ing + Button 1: You can then release : Your controller will stay in Select
mode until you press again. See section 12.3.5, Pinning a Mode on Your Control-

ler for more information.
2. Check that Button 2 (EVENTS) is disabled. If necessary, press it to disable it.
Press Button 4 (NEXT) repeatedly to navigate to the last Group bank.

4. Press the Group button corresponding to the “+” label on the left display to create a new
empty Group.

w

Using the Select mode allows you to access more than eight Group banks!

4.3.2 Loading Groups

You can load a readymade Group from the Browser or from your operating system. The Group
can be included in the MASCHINE Library or any EXPANSION PACK but it can also be a
Group you have created yourself and saved for later use.

You have many methods at your disposal to load a Group:

= Drag and drop: Select the desired Group in the Browser or Group file in your operating sys-
tem and drag it onto the Group List:

o Drag it onto an existing Group to replace this Group in the Group List.
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o Drag it between two Groups to insert it between both.
o Drag onto the “+"” at the end of the Group List to append it to the existing Groups.

= Double-click: Double-click the Group in the Browser or the Group file in your operating
system to replace the focused Group in the Group List.

= Context menu: Right-click ([Ctrl]-click on Mac OS X) the desired Group in the Group List or
the Group name in the top left corner of the Pattern Editor and select Open... in the con-
text menu. In the Load Group dialog that opens, navigate to the desired Group file on your
computer and click Open to load it. The loaded Group will replace the current Group in
the Group List.

You can also recall the search query that was used to find the Group currently loaded in the
focused Group slot. See section 13.7, Using Quick Browse for more information.

In your operating system, Group files have the extension “.mxgrp” (MASCHINE 2) or
“.mgrp” (MASCHINE 1.x).

Please refer to chapter 13, Browser for more information on the Browser.

4.3.2.1 Loading Groups on Your Controller
On your controller, use the Browser to load Groups:

= You can browse your MASCHINE Library for the desired Group. For more information on
how to do this, please refer to section 13.2, Searching and Loading Files from the Library.

= Alternatively you can recall the search query that was used to find the Group currently loa-
ded in the focused Sound slot. See section 13.7, Using Quick Browse for more informa-
tion.

4.3.3  Renaming Groups

By default, new Groups are named Group Ax—Hx, “x” indicating the bank number (Group Al-
H1, Group A2-H2, etc.).

You can rename Groups as you see fit. Naming is only available from within the software, but
any changes will also show up on your controller.
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Group renaming is performed like Sound renaming:

1. Double-click the name of the desired Group in the Group List or right-click ([Ctrl]-click on
Mac OS X) the Group and select Rename from the context menu.
The Group name is now highlighted and editable.
B1 I Baat
C1 I Ambience

m Group D1 k‘

2. Modify the name of the Group. Press [Enter] on your computer keyboard to confirm.
If you use MASCHINE as a plug-in, some hosts will utilize the [Enter] key, as it is mapped

to some function of the host software. In this case, click anywhere else in the MASCHINE
plug-in window to confirm the name you have entered.

4.3.4  Changing the Group’s Color

You can change the color of each individual Group in the software. To do this:
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1. Right-click ([Ctrll-click on Mac OS X) the desired Group in the Group List or the Group
name in the top left corner of the Pattern Editor and select Color from the context menu.
A Color Palette appears. In the Palette, the current color of the Group is highlighted.

Open...

Save

Save As...

Save with Samples...
Import MIDI. ..

Export MIDI...

Colaor

El pefault

2. Select the desired color in the Palette. You can also choose to set the Group back to the
default color corresponding to its position in the list by selecting Default in the Color Pa-

lette.
— The Group buttons of the MASCHINE STUDIO and MASCHINE MK2 controllers, and the
pads of the MASCHINE MIKRO MK2 controller (when you hold the button) mirror

the Group colors you have selected.

By default each Group has a different color. But you can choose a common default color
for Groups in Preferences > Colors > Group Default. See section 12.5.6, Preferences — Col-
ors Page for more information.

Once you have set a custom color for a Group as described above, the Group will retain its
color when you move it in the Group List, and the color will be stored with the Group when
you save the Group for later use. Note that you can select the same color as the one used
by default: In that case the color (even unchanged) will be considered as a custom color
and will follow the Group as you move it.
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4.3.5  Saving Groups

You can save your Groups as individual files (extension “.mxgrp”). This can be only done in the
software.

Saving Your Modifications into the Original Group File

If you have made changes to a Group loaded in your Project, you can save your modifications
as follows:

» Right-click (on Mac OS X: [Ctrl]-click) the Group in the Group List or the Group name in
the top left corner of the Pattern Editor and select Save from the context menu:

Open...

Save h

Sava As...
Save with Samples...

Import MIDL...
Export MIDI...
Color

Copy

B I Sound 8

— Your modifications are saved to the Sound file.

Even if you don’t save a Group individually, its current settings will still be saved with your

Project. But once a Group is saved and tagged, it is available in the Browser for use in oth-
er Projects.

You cannot save changes to factory files — these files are read-only. If you run the Save com-
mand on a factory file, it automatically turns into the Save As... command: a Save Group dia-
log opens and lets you save your modified Group to your user library. See next paragraph for
more details. The same happens with Groups you have built from scratch.
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If you want to save modifications you have made on a Group originating from a factory library,
or if you don’t want to overwrite the original Group with your modified version, or if there is no
original version of your Group (i.e. you built it from scratch), you can save it as a new Group

file:
1.

3.

—

Open...

Save

Save As...

Save with Samples...

Impaort MIDL...
Export MIDL...

Color

Copy

Paste

Rename
Delete

Your Group is now saved.

Right-click (on Mac OS X: [Ctrl]-click) the Group in the Group List or the Group name in
the top left corner of the Pattern Editor and select Save As... from the context menu:

A Save Group dialog appears. By default, the Group file will be saved in your Standard
User Directory (as defined in Preferences > Library > User, see section 12.5.2, Preferen-
ces — Default Page for more information).

If you wish, choose another path and/or type another name with your computer keyboard.
Press [Enter] to confirm and close the Save Group dialog.

The Group will be added to the Library and is ready to be tagged in the Browser — see section

13.4, Editing the Files’ Tags and Properties for more information on this.

You can also save a Group together with all the Samples used in this Group. This can be
useful to use a drum kit on another computer or share it with other users. See section
14.4.1, Saving a Group with its Samples for more information.
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4.3.6  Copying and Pasting Groups

You can copy and paste Groups in your Project.

In the software, Groups are copied without their Clips in the Arranger. To include the Clips
in the copying operation, use on your controller (see below)!

To copy and paste Groups in the software:

1. Right-click (on Mac OS X: [Ctrl]-click) the Group you want to copy in the Group List or the
Group name in the top left corner of the Pattern Editor.

2. In the context menu, choose Copy to copy the Group.

Open...

Save

Save As...

Save with Samples...
Import MIDI. ..

Export MIDI...

Color 3
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3. Right-click (Mac OS X: [Ctrl]-click) any Group in the Group List and select Paste from the
context menu to replace that Group with the copied one. If you want to paste the Group
without affecting the existing Groups, first click the “+” under the last Group to create a
new empty Group and paste the Group there.

D1 I Bassboost

Open...

Save

Save As...

Save with Samples...

Import MIDI...
Export MIDI...
Color

Copy
Pasta

— All parameters of the Group will be copied except for its Clips (its Patterns, though, will
be copied as well). The Group previously in that position in the Group List will be re-
placed.

If you want to duplicate a Group more than once, just keep on choosing Paste from the
context menu on other Groups: the source Group stays in the clipboard, ready for the next
use!

4.3.6.1 Duplicating Groups on Your Controller

On your controller in Control mode, do the following to copy a Group from one Group button to
another:

1. Press and hold

2. If you want to duplicate a Group including its Patterns and Clips, enable the + EVNT option
(Button 2).

3. Press the Group button of the Group you want to copy.
The Group button starts blinking.
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4. Press the Group button of your target Group (this can also be in another Group bank, in
this case first press Button 3/4 to select the Group bank). If you want to paste the Group
without affecting the existing Groups, press the dim white Group button after the last col-
ored Group button to create the new Group and automatically paste the copied Group
there.

—  All parameters of the Group (all included Sounds, Group effects, Group’s Channel proper-
ties) will be copied (including its Patterns and Clips in the Arranger if you have enabled
the + EVNT option). The copied Group will replace the Group previously at that position in
the Group List.

You will notice that once you have pasted the Group, the target Group button starts blinking
itself, indicating that it is ready to be pasted again: Therefore, to duplicate a Group more than
once, once you have pressed the source Group button you just have to press all the desired
target Group buttons in a row.

Instead of holding , you can also pin the Duplicate mode by pressing
+ Button 1. You can then release : Your controller will stay in Duplicate
mode until you press again. See section 12.3.5, Pinning a Mode on Your Con-

troller for more information.

4.3.1  Moving Groups

You can reorder Groups via drag-and-drop in the software. It can be helpful to organize your
Groups more conveniently.

You can select multiple Groups to move them all at once! See 14.1.3, Selecting Multiple
Sounds or Groups for more information.

Moving Groups is performed like moving Sounds:
1. Click and hold the Group.
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2. While holding the mouse button, drag your mouse vertically toward the desired location in
the Group List.
As the mouse cursor moves, an insertion line appears at the potential places where you
can drop the Group.

navigation_project -

m Bassboost 2

3. When the insertion line appears at the desired location, release the mouse button.

— The Group takes its new place in the Group List. Of course, this new place is also mir-
rored on your controller.

4.3.8  Deleting Groups

Deleting a Group will remove it from the Group List.

You can select multiple Groups to delete them all at once! See 14.1.3, Selecting Multiple
Sounds or Groups for more information.

» To delete a Group, select it in the Group List and press [Del] on your computer keyboard.
You can also right-click (on Mac OS X: [Ctrl]-click) the Group in the Group List or the
Group name in the top left corner of the Pattern Editor and choose Delete from the con-
text menu.

— The Group is removed. All following Group are shifted up in the Group List to fill the gap.
If the last Group bank is empty after the Groups have been shifted, the bank is deleted.
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m Bassboost 2

Open...

Save

Save As...

Save with Samples...

Impart MIDL...
Export MIDI...

Color 3

Ietina Grop.
4.3.8.1 Deleting a Group on Your Controller

On your controller in Control mode, do the following to delete a Group:

» To delete a Group, hold + and press the Group button of the Group you
want to delete.

— The Group is removed. All following Groups are shifted left to fill the gap.

4.4  Exporting MASCHINE Objects and Audio

This section describes how to save single Groups or whole Projects for use in another MA-
SCHINE installation, and how to export audio from various sources in your Project.

You can also export your Patterns as audio or MIDI files via drag and drop. This is descri-

bed in section 17.8.1, Exporting Audio from Patterns and 17.8.2, Exporting MIDI from Pat-
terns, respectively.
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4.4.1  Saving a Group with its Samples

Sometimes it is useful to have the ability to save a Group with its Samples outside of the MA-
SCHINE Library. If you want to take a Group to another studio or if you want to backup or
share a custom drum kit with all the related files, this comes in handy.

To save a Group with its Samples:

1. Right-click (on Mac OS X: [Ctrl]-click) the Group in the Group List left of the Arranger and
select Save with Samples... from the context menu:

Open...

Save

Save As...

Save with Samples...
Import MIDI....

Export MIDI...

Color 3

Closa

2. In this panel, adjust the settings (see table below) and click Save to confirm or Close to
cancel the operation.
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Controls Description

Group Displays the name and location of the Group file to be created. The Sam-
ples will be put in a folder with the same name in the same location. By
default, the Group file inherits the name of the Group in the Project and it
will be saved in the “Groups” subfolder of your Standard User Directory (as
defined in Preferences > Library > User, see section 12.5.2, Preferences —
Default Page for more information). Click the folder icon on the right to
choose another name and/or path.

Delete Unused Files Enable this checkbox to delete unused files, thereby minimizing the
amount of audio data to be exported.

ﬁ This command is also available from the Group menu opened by right-clicking ([Ctrl]-click-
ing on Mac OS X)) the Group name above the Sound List, in the top left corner of the Pat-
tern Editor.

You can also save your whole Project with its Samples. See section 14.4.2, Saving a
Project with its Samples.

44.2 Saving a Project with its Samples

Sometimes it is useful to have the ability to save all Samples used in your Project outside of
the MASCHINE Library. If you want to take a Project to another studio or if you want to backup
a production with all the related files, this comes in handy.
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1. Choose Save Project with Samples... from the File menu or the File submenu in the MA-
SCHINE menu:

Save As...

Save Project with Samples... t

Import Maschine 1.x Format...
Export Audio...

Recent Files 3

Praferances...

You will be presented with the Save Project with Samples panel:

Save Project with Samples

Project
I C:'\Usersinico’Documents’Mative Instruments',Masch
Dhal Unused File:

Closa

2. In this panel, adjust the settings (see table below) and click Save to confirm or Close to
cancel the operation.

Element Description

Project Displays the name and location of the Project file to be created. The Samples
will be put in a folder with the same name in the same location. By default, the
Project file inherits the name of the Project and it will be saved in the “Projects”
subfolder of your Standard User Directory (as defined in Preferences > Library >
User, see section 12.5.2, Preferences — Default Page for more information).
Click the folder icon on the right to select another name and/or path.

Delete Unused Files Enable this checkbox to delete unused files, thereby minimizing the amount of
audio data to be exported.
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You can also save single Groups with their Samples. See 14.4.1, Saving a Group with its
Samples.

44.3  Exporting Audio

In some cases you might want to render your Groups, Sounds or your complete Project as audio
files in order to edit them further in other applications or burn a CD. The format of the expor-
ted audio files is WAV. This function is only available in the software.

You can also export the audio of particular Patterns via drag and drop. The audio will be
exported according to the settings described here, except for the exported region, the par-
ticular Sound/Group exported, and the name of the exported audio file. See section 17.8.1,
Exporting Audio from Patterns for more information.

The exported region is based on the current Loop Range. The exact length of the exported au-
dio file depends on the Loop Optimize setting in the Options page of the Export Audio panel
(see description below).

1. Set the Loop Range to the region that you want to export — see section 113.3.1, Select-
ing a Loop Range to know how to do this.

2. Choose Export Audio... from the File menu or from the File submenu in the MASCHINE

menu.

Save As...
Save Project with Samples...
Import Maschine 1.x Format...

Export Audio... [\

lag
Recent Files 3

Prefarences...

You will be presented with the Export Audio panel (see picture below).

3. Inthe Export page of the Export Audio panel, select the source(s) and the destination (see
description below).
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4. If you wish, click the Options tab at the top and adjust the export options in the Options
page that appears (see description below).

5. At the bottom of the panel, click Export to start the export process, or Close to cancel the
operation and close the panel without exporting anything.
Export Audio Panel — Export Page

The Export page of the Export Audio panel allows you to choose the source(s) to be exported
and the destination of the exported audio file(s).

Export Audio

Sound Outputs

Destination

Faoldar ] C:\Usars\...\Maschina 2\Recordings

Export Close

The Export page of the Export Audio panel.

Following parameters are available:
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Element Description

Source

Output menu and Out- | Selects what will be exported. The content of the Output list under the menu de-
put list underneath pends on your selection in the menu:

Master Output: Select this to export the Master output signal (including all Groups
and Sounds and their effects) to one audio file. The Output list underneath contains
only one entry: Master Output. This entry is checked and grayed out (you cannot un-
check it).

Group Outputs: Select this to export the output signals of specific Groups to individ-
ual audio files. The Output list underneath shows all Groups available for exporting.
Empty Groups (i.e. Groups containing only empty Sound slots) are not listed. Click
the check boxes of the desired entries in the list to include/exclude the correspond-
ing Groups. Only Groups with a check mark will be exported.

Sound Outputs: Select this to export the output signals of specific Sounds to indi-
vidual audio files. When this entry is selected, the Output list underneath shows all
Sounds available for exporting. Empty Sound slots are not listed. The entries are or-
ganized as a tree with Groups at the root and Sounds within each Group. By default
all Groups are collapsed and all Groups and Sounds are checked. Click the little ar-
row left of a Group to show/hide its Sounds. Click the check boxes of the desired
entries in the list to include/exclude the corresponding Sounds. Only Sounds with a
check mark will be exported. The check box of Group entries allow to check/uncheck
all Sounds of the Group at once. If some of the Sounds only are checked in a Group,
the Group is “dimmed checked.”

Destination

Folder Displays the folder on your hard disk where the exported audio file(s) will be saved.
To change the destination folder, click the field and select the desired folder in the
navigation dialog that opens.

Export Audio Panel — Options Page

The Options page of the Export Audio panel allows you to adjust various settings for the export
process.
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Export Audio

Options

44100 Hz L4

16 Bit L4

Export Closa

The Options page of the Export Audio panel.

Following parameters are available:

Element Description

Options

Normalize If this option is checked, the resulting audio file(s) will be normalized, i.e. the ex-
ported audio will be brought to the highest possible level without clipping (O dBFS).
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Element Description

Loop Optimize Optimizes the exported audio file for use as a loop:

If Loop Optimize is disabled, the exported audio file will be prolonged to keep, e.g.,
the tail of a reverb. The end of the exported audio will always correspond to a bar
division.

If Loop Optimize is enabled, the exported audio file will have the exact range of the
Loop Range. Any effect tail will be rendered into the beginning of the audio file. Ad-
ditionally the file metadata will include the loop’s tempo (in BPM) and length (in
bars).

Sample Rate Selects from five different sample rates for the exported audio file(s): 44100 Hz
(this is the sample rate of the audio CD format), 48000 Hz, 88200 Hz, 96000 Hz,
and 192000 Hz.

Bit Depth Selects from three different bit depths (or bit resolutions) for the exported audio
file(s):

16 Bit is the bit depth of the audio CD format.
24 Bit is well suited for mastering.

32 Bit float is the bit depth used internally by MASCHINE's audio processing en-
gine. Choose this setting if you plan to further process the exported audio using oth-
er high-end digital audio devices or applications that support this bit depth — using
this setting will allow greater headroom. However note that the exported files will be
significantly larger.

Names of the Exported Audio Files
The exported audio files are named according to following rules:

= |f Master Output is selected in the Output menu the audio file will be nhamed as follows:
[Project name] - [BPM].wav

= |f Group Outputs is selected in the Output menu the audio files will be named as follows:
[Project name] - [Group order number] [Group index (letter + number)] [Group name] -
[BPM].wav
The Group order number is a two-digit number indicating the “order of appearance” of the
Group in the Group List. This ensures that an alphabetical listing of the exported files will
reflect the structure of your Project.
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= |If Sound Outputs is selected in the Output menu the audio files will be named as follows:
[Project name] - [Sound name] - [BPM].wav

In addition, if the name of the file about to be exported is already used in the destination
folder, a hyphen followed by an index number is added to the name (e.g., “-1,” “-2," “
3,"”) to avoid any file being overwritten.

4.5  Importing Third-Party File Formats

4.5.1  Loading REX Files into Sound Slots

MASCHINE supports REX (ReCycle) files to be loaded. REX files are loops that are already
sliced and mapped to MIDI notes.

Only REX2 files are currently supported.

— The Samples are loaded into the Sound slot. A new Pattern is created in that Group and
directly loaded in the Pattern Editor (switch the Pattern Editor to Keyboard view to better
see the Pattern — see section 17.1.5, Group View and Keyboard View). This Pattern con-
tains the sequence data of the REX file. For each REX file you import a Pattern will be
created and added.

Group B2 +  Pattern i

Loop_100

A REX file loaded in the first Sound slot.

MASCHINE - Manual - 171



Managing Sounds, Groups, and Your Project
Importing Third-Party File Formats

4.5.2  Importing MPC Programs to Groups

MASCHINE allows you to import Drum program files (.PGM and .AKP) from the Akai MPC ser-
ies to Groups. Supported models include the MPC4000, MPC3000, MPC2000, MPC500,
MPC1000 and the MPC2500.

Supported Parameters from MPC Programs

Since MASCHINE has a different approach to handling and naming parameters, please refer to
this list to find out how MPC Program settings are being translated into MASCHINE settings.

MPC Parameter MPC500, MPC4000 MPC2000 MPC3000 MASCHINE Parameter
1000, 2500 (XL)

Sample Name

X

X

Sample Name

Play Mode X - Playback Type (ADSR,
One-shot, AHD)

Sample Level X - Zone Level

Sample Pan - - Zone Pan

Range Lower/Higher

High/Low Key

Tuning X X Tune
Attack X X Attack
Decay X X Decay
Voice Overlap X X Polyphony
Filterl Type X - Filter Type

Filterl Frequency

Filter Cutoff

Filter]l Resonance

Filter Resonance

Filter1l Velocity to Fre- X - Velocity Cutoff
quency

Mixer Level X X Track Level
Mixer Pan X X Track Pan
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MPC Parameter MPC500, MPC4000 MPC2000 MPC3000 MASCHINE Parameter
1000, 2500 (XL)

Velocity to Level X - - - Velocity to Volume

Mute Group X - - - Choke Group

Importing MPC Program Files

1. To import an MPC Program file, open the Browser in the MASCHINE software and click
the FILES tab.

2. Navigate to the MPC Program file you want to import and double-click it.
You will be prompted with the MPC Import panel:

MPC Import

Input
B Import All Banks

6 - HHOPEN3

Cancel

3. Inthe Input section of the panel, select one of the import options (see table below).
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4. Click OK to start the import procedure (or Cancel to close the panel without importing

anything).
Control Description
Import All Banks Select this to import all Banks of the MPC Program file. Each Bank will be
loaded into a separate Group.
Import One Bank Select this if you only want to import a single Bank. Use the drop-down
menu to the right to select which Bank you want to import. The list below
shows you a preview of the sounds in the selected MPC Bank.
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9 Playing on Your Controller

This chapter describes the numerous features available in MASCHINE to adjust and enhance
your playing, both during live performances and when recording Patterns.

9.1  Adjusting Your Pads

MASCHINE provides you with numerous features to finely tailor the way the pads of your con-
troller react to your playing:

= Choose a pad mode that best fit your playing needs: 15.1.1, The Pad View.

= Adjust the base key to set the pitch of the notes played by your pads: 15.1.3, Adjusting
the Base Key.

= Set Choke groups to selectively cancel Sounds when other Sounds are triggered: 15.1.4,
Using Choke Groups.

= Create Link groups to trigger several Sounds by pressing only one pad: 15.1.5, Using Link
Groups.

Most of the settings for your pads are available both in the software via the Pad view (see
15.1.1, The Pad View), and on your controller via the Pad Mode (see section 15.1.1, The Pad
View).

5.1.1  The Pad View

In the software the settings for your pads are available in the Pad view, which is enabled via
the Pad View button above the Sound List in the Pattern Editor:

Layers v

African Plucks
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» Click the Pad View button to show or hide the Pad view.

When the Pad View button is enabled, the Pad view replaces the Sound List below:

C1

Mona  Master

Mona  Master

The Pad view replaces the Sound List.

At the top of the Pad view, the grid of pads gives you access to all Sound slots of the current
Group. The focused pad is fully lit; other pads containing a Sound are dim lit; pads without
any Sound are off. The following actions are available in the grid:

= Click any pad to select the corresponding Sound slot. Upon selection the parameters un-
derneath as well as the Control area above are updated accordingly.

= Drag and drop a pad to move it to another location in the grid. This is strictly equivalent
to moving Sound slots in the Sound List (see section 14.2.7, Moving Sounds).

= Right-click ([Ctrl]-click on Mac OS X) any pad to open the same context menu as in the
Sound List — the management commands available in this menu are described in section
14.2, Managing Sounds.
You can select multiple pads in the grid of pads as you can in the Sound List, and adjust
parameters in the Pad view and in the Control area for all of them simultaneously. For more
information on multiple selection, see section 14.1.3, Selecting Multiple Sounds or
Groups.

Under the grid of pads, you find following parameters:
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Parameter Description

Key Adjusts the base key for the selected pad. See section 15.1.3, Adjusting the
Base Key below.

Choke Configures the Choke Group for the selected pad. See section 15.1.4, Using
Choke Groups below.

Link Configures Pad Link for the selected pad. See section 15.1.5, Using Link Groups
below.

5.1.2  Choosing a Pad Mode

By default, your pads play all Sounds of the selected Group — we call this Group mode. Fur-
thermore they are velocity sensitive, meaning they will play louder if you hit them harder. You
can change this behavior and choose another pad mode in order to adapt your pads to various
situations.

5.1.2.1 Choosing a Pad Mode on the MASCHINE Controller
Changing the behavior of the pads is done in Pad Mode:

» To enter Pad Mode, press and hold . You can also press + But-
ton 1 to pin this mode and make it permanent.

IEETE (KEVYEORRD) [ 16 VEL FIZED UEL [ ocT- [ ocT+ |[SEMI- | [ _SEMI+ |
IEHRFE TLGWER 1T77FES 1575 [SOUHD 12| [SOUHD 14] [SOUHD 15 [SOUHD 16|

T i e RIDE..EDUE| [SIE.TART) HOIS..ZIH 1
GROUF MODE GROUP RO [CLO..DARY]| [TRIA..LONE| [JOC..AHHA| [RIDE..ATED)

HOHE MASTER HOHE MASTER KICK..5¥ 1| [KICK..OP 1| [HER..ORHA| ksI;[i[ o0 33§

The Pad Mode on the controller.

If your controller is in Group mode (default mode) the right display shows the name of the
Sound played by each pad.

The Pad Mode provides two Parameter pages for Knob 1-4 under the left display. As usual,
use the Page buttons at the left of the displays to select a Parameter page.

MASCHINE - Manual - 177



Playing on Your Controller
Adjusting Your Pads

Parameter Description

KEYBOARD (Button 2)

Activates/deactivates Keyboard mode. In this mode your pads play notes of the fo-
cused Sound at 16 different pitches. This is well suited for melodic instruments.
The right display indicates the pitches played by each pad. See the next para-
graph for a detailed description of this mode. Please note that Keyboard mode is
not compatible with 16 Velocities mode (see below).

16 VEL (Button 3)

Activates/deactivates 16 Velocities mode. In this mode your pads play the same
note of the focused Sound but with 16 different velocity values. This can be use-
ful to play or program complex drum fills. The right display indicates the velocity
values for each pad. The pitch of the played note is defined by the base key (see
section 15.1.3, Adjusting the Base Key). Please note that 16 Velocities mode is
not compatible with Keyboard mode (see above) nor the Fixed Velocity option
(see below).

FIXVEL (Button 4)

Activates/deactivates the Fixed Velocity option. This option is available when your
pads are in Group mode (default mode) or Keyboard mode. With this option ena-
bled, your pads play at the same volume no matter how hard you hit the pads.
Obviously, this option is not compatible with the 16 Velocities mode described
above: hence, their buttons are mutually exclusive.

0CT-, 0CT+, SEMI-, and SEMI
+ (Button 5-8)

Adjust the base key for the selected pad. See section 15.1.3, Adjusting the Base
Key below.

Page 1

CHOKE section (Knob 1 and
2)

Configures the Choke group for the selected pad. See section 15.1.4, Using
Choke Groups for more information.

LINK section (Knob 3 and
4)

Configures the Link group for the selected pad. See section 15.1.5, Using Link
Groups for more information.

Page 2

FIXVEL (Knob 1)

Here you can adjust the exact velocity value used in the Fixed Velocity mode
(see above).

Using the Keyboard Mode

1. Select a Sound by pressing the pad it is assigned to.

2. Now enter Pad Mode by holding PAD MODE and lock it by pressing Button 1 (you can

then release PAD MODE).

Press Button 2 to enter Keyboard mode.
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— If you hit the pads now, you will hear that they all play the same Sound, but each with a
different pitch. When you leave Pad Mode, the button stays dim lit to indi-
cate that Keyboard mode is active.

Alternatively, you can use the following shortcut:

» In any mode, press + to quickly switch your pads between Keyboard
mode and Group mode.

The pitch scale is divided in semitones, starting with pad | as the lowest pitch going up to pad
as the highest pitch. The current scale is indicated on the right display:

T [AETOLEN) [ 16 VEL | [FIXED VEL |
4 SHAKE.LLOVER 1 C3 1:2:4

CHOKE LINK 152

GROUF MODE GROUF MODE
HOHE MASTER HOHE MASTER

Keyboard mode selected on the controller displays in Pad Mode.

Activating Keyboard mode on your controller automatically switches the Pattern Editor to
Keyboard view in the software, and inversely.

To shift the scale in octaves use Button 5 (octave down) or Button 6 (octave up). You can also
shift the scale in semitones: use Button 7 (semitone down) and Button 8 (semitone up). Of
course all these settings stay active when you press again to leave Pad Mode.

Try to experiment with all kinds of Samples in the Keyboard mode; some rather boring
sounding Samples can be really interesting if you play them very low or very high!

If you prefer to play your melodies with a MIDI keyboard, you can connect one to the MIDI IN
socket on the back of your controller. You can also use any USB-MIDI keyboard selected in the
Audio and MIDI Settings panel (see section 12.6.2, Audio and MIDI Settings — Routing Page
to get to know how to set these up). By default the connected MIDI input device will always
play the selected Sound without the need to enter Keyboard mode.
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The rear side of the MASCHINE hardware with the MIDI IN and OUT sockets.

5.1.3  Adjusting the Base Key

In Group mode, the bhase key defines the key (or pitch) at which the selected Sound will be
played when its pad is pressed. In Keyboard mode, it defines the key played by pad 1 on your
controller; pads 2—16 will then play keys from [base key + 1 semitone] up to [base key + 15
semitones].

The base key also affects the pitch of events created via the step sequencer. See section
17.3.1, Step Mode Basics for more information on this.

Adjusting the base key only affects the notes played by the pads of your controller. It does
not affect the notes recorded in your Patterns! To adjust the key of notes in Patterns,
please refer to section 17.4, Editing Events.

You can select multiple pads and quickly change the base key for all of them at once! See
section 14.1.3, Selecting Multiple Sounds or Groups to know how to do this.

By default the base key of every Sound slot is C3 (i.e. middle C in the MASCHINE convention).
To change the base key of the selected pad(s) / Sound slot(s) in the software:

1. Click the Pad View button above the Sound List in the Pattern Editor to show the Pad
view for the focused Group.

2. Click the Key value and drag your mouse vertically, or double-click it, enter a new value
on your computer keyboard, and press [Enter] to confirm.
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5.1.3.1 Adjusting the Base Key on Your Controller
To change the base key of the selected pad(s) / Sound slot(s) on your controller:

1. Hold the button to enter Pad Mode (or press + Button 1 to pin it).
On the right display, the key indicated for pad 1 (in the bottom left corner) is the current
base key.

2. Press Button 5 (0CT-) / 6 (0CT+) to adjust the base key by octaves, or Button 7 (SEMI-) / 8
(SEMI+) to adjust the base key by semitones.
The new values are indicated for all pads on the right display.

3. Release (or press it again if you pinned the mode).

5.1.4  Using Choke Groups

When your pads are in Group mode, Choke groups allow you to build sets of “mutually exclu-
sive” pads: A Choke group lets you force each newly triggered Sound to cancel out all other
Sounds still playing — in other terms, these Sounds would never play together, the newer
Sound automatically “killing” the audio of the older one. This is a behavior you can find in vin-
tage drum machines (typically used to “choke” the open hi-hat with the closed one), but also
in monophonic synthesizers that are only capable of playing one note at a time.

Within a Group, each pad can be assigned to one of eight Choke groups. When you assign a
pad to a Choke group, the pad may be set as a Master or Slave in the Choke group:

= |f the pad is set to Master (default setting) it will kill the Sounds of other pads in the
same Choke group.

= |If the pad is set to Slave it won't kill any other pad of the Choke group — but be killed by
pads set to Master within the same group.

You may set more than one pad as Master or Slave within the same group.

Choke groups affect not only the notes you play on the pads and the notes triggered by the
Patterns, but also the MIDI notes controlling your Sounds.

You can select multiple Sounds and quickly assign them all to a particular Choke group at
once!

To assign the selected Sound slot(s) to a Choke group and set its/their Choke mode (Master or
Slave), do the following:
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1. Click the Pad View button above the Sound List in the Pattern Editor to show the Pad
view for the focused Group.

2. In the Choke section click the Group value and select the desired group I-8 from the list
or choose None (default setting) to remove the Sound from its current Choke group.

3. In the same Choke section click the Mode value (Master or Slave) to switch the Sound
between Master (default setting) and Slave mode.

4. Repeat the steps above to assign other pads to the same Choke group.

The Hi-hat is an ideal candidate for making use of Choke groups! See 110.4.3, Hi-hat —
Memory for more details!

5.1.4.1 Using Choke Groups on Your Controller

To assign the selected pad(s) / Sound slot(s) to a Choke group and set its/their Choke mode on
your controller:

1. Hold the button to enter Pad Mode (or press + Button 1 to pin it).
2. If necessary, press the Page Left button to switch to the first Parameter page of the Pad
Mode.

3. Turn Knob 1 (CHOKE GROUP) to select the desired Choke group 1-8 for that pad or choose
NONE (default setting) to remove the pad from its current Choke group.

4.  Turn Knob 2 (CHOKE MODE) to select the Choke mode from MASTER (default setting) or SLAVE
for that pad.

5. Release (or press it again if you pinned the mode).

5.1.5  Using Link Groups

When your pads are in Group mode, Link groups allow you to link pads with each other: this
can be used to trigger multiple Sounds when pressing only one pad. Each pad of a Group can
be assigned to one of eight Link groups. A pad may be set as a Master or Slave in the Link

group:
= |f the pad is set to Master (default setting) it will trigger other pads in the same Link
group.

= |f the pad is set to Slave it will only trigger its own Sound, even if it is part of a Link group
— but be triggered by pads set to Master within the same group.
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You may set more than one pad as Master or Slave within the same group.

Link groups affect not only the notes you play on the pads and the notes triggered by the
Patterns, but also the MIDI notes controlling your Sounds.

Link groups are a “live” feature: They only affect the note triggers. In Record mode, Link
groups don’t affect the notes recorded in your Patterns — in other terms notes won’t be
recorded for the linked pads! Notably, this allow you to modify your Link group assignments
after recording. If you want to copy the notes from a Sound to another Sound in Patterns,
please refer to section 17.4, Editing Events.

You can select multiple Sound slots and quickly assign them all to a particular Link group
at once!

To assign the selected Sound(s) to a Link group and set its/their Link mode (Master or Slave),
do the following:

1. Click the Pad View button above the Sound List in the Pattern Editor to show the Pad
view for the focused Group.

2. Inthe Link section click the Group value and select the desired group 1-8 from the list or
choose None (default setting) to remove the Sound from its current Link group.

3. In the same Link section click the Mode value (Master or Slave) to switch the Sound be-
tween Master (default setting) and Slave mode.

A Link group makes sense only if more than one pad/Sound are assigned to it!

5.1.5.1 Using Link Groups on Your Controller

To assign the selected pad(s) / Sound slot(s) to a Link group and set its/their Link mode on
your controller:

1. Hold the button to enter Pad Mode (or press + Button 1 to pin it).
2. If necessary, press the Page Left button to switch to the first Parameter page of the Pad
Mode.

3.  Turn Knob 3 (LINK GROUP) to select the desired Link group 1-8 for that pad or choose NONE
(default setting) to remove the pad from its current Link group.

4.  Turn Knob 4 (LINK MODE) to select the Link mode from MASTER (default setting) or SLAVE for
that pad.
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Release (or press it again if you pinned the mode).

Playing Tools

On top of the various pad settings described in the previous section (see 15.1, Adjusting Your
Pads), MASCHINE also offers you a series of intuitive playing tools particularly useful when
playing live:

5.2.1

Note Repeat allows you to automatically repeat a Sound by holding its pad: 15.2.1, Note
Repeat.

Mute and Solo allow you to selectively mute and solo Sounds and Groups: 15.2.2, Mute
and Solo.

Choke All Notes allow you to cut all playing audio: 15.2.3, Choke All Notes.

Groove allows you to give a shuffling flair to individual Sounds/Groups or to your entire
Project: 15.2.4, Groove.

Hardware Shortcuts give you a quick access to the most important parameters of each
channel (Sound, Group, and Master): 15.2.5, Level, Tempo, Tune, and Groove Shortcuts
on Your Controller.

Note Repeat

Note Repeat is a really handy way to play and program beats: it plays the selected Sound or
note repeatedly at a given rate. You just need to hold a pad and its Sound/note will be steadily
repeated until you release the pad.

When using Note Repeat all pads will be both velocity and pressure sensitive, allowing for
expressive drum rolls or dynamic basslines.

Note Repeat is a really funky way to play percussion and drums live creating build-ups
and breaks.

Note Repeat can also come in handy to quickly record a regular beat when creating Pat-
terns.

Note Repeat is also interesting to use with tonal Sounds and you can access it from Key-
board mode to create synthesizer-like arpeggios.

Playing Tools
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5.2.1.1 Using Note Repeat on the MASCHINE Controller
Note Repeat is a hardware-only feature.

» Press and hold NOTE REPEAT to enter Note Repeat mode. You can also press NOTE RE-
PEAT + Button 1 to pin this mode and make it permanent.

GATE RGT 178 C1/ie | 1AAET | 1/37 )

4. SHAKE.LLOVER 1 120.00 1:2:4

GATE TYPE
100.0 % HORMAL

The Note Repeat mode on the controller.

In Note Repeat mode you can customize the way your Sounds/notes will be repeated by adjust-
ing following settings:

Element Description

Button 5-8 Select between four different presets — also while playing. The rate currently as-
signed to each button is indicated below on the display. The selected rate is
highlighted. You can change the rate and rhythm assigned to each button by se-
lecting it and using Knob 2 and 3, respectively (see below).

RATE (Knob 5) Adjusts the rate assigned to the selected Button 5-8. Available values are 1 BAR
and a series of note values going from 1/2 (half note) until 1/128 (a hundred twen-
ty-eighth note).

TYPE (Knob 6) Selects from three variations of the original note length defined by the RATE pa-
rameter: NORMAL plays the original note length (default setting), TRIPLET plays trip-
lets of the original note length (faster, three notes in the duration of two original
notes), and DOTTED plays dotted versions of the original note length (slower, two
notes in the duration of three original notes). Under Button 5-8, triplet values
are indicated by a “T” and dotted values by a “D” next to the note value.
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Element Description

GATE (Knob 4) Adjusts the ratio between the duration of the notes and the duration of the silen-
ces between them, measured as a percentage of the note value set by RATE (see
above). Available values range from 0 % to 200 %: At low values the notes are very
short. At 50 % notes and silences are equal. At 100 % (midcourse) each note lasts
exactly until the next note is triggered. At higher values notes overlap (provided
that the selected Sound is polyphonic). This setting applies globally to all rate
presets.

GATE RST (Button 4) Press this button at any time to reset the GATE parameter to its default value
100 %.

5.2.2  Mute and Solo

Muting is used to silence a Sound or a Group, whereas Solo is pretty much the opposite: Solo-
ing a Sound or a Group mutes all other Sounds in that Group or all other Groups, respectively,
so that you can listen to the selected Sound or Group alone. The combination of both is a use-
ful means to play live and to test different sequences together.

When used on Sounds, the Solo only applies to the current Group: The Sounds in other Groups
won’t be affected.

@ We describe here how to mute/solo Groups and Sounds in the Arrange view of the software,

but you can also do this from Mix view via the Mute button available in each channel strip
of the Mixer! See section 19.2.5, Adjusting Settings in the Channel Strips for more infor-
mation.

Audio Mute vs. Event Mute

At the Group level, the Mute function is an audio mute: The whole audio output of the muted
Group will be bypassed. At the Sound level, the Mute function is by default a trigger mute: the
Pattern content (the events) for the muted Sound will not be triggered — but any audio re-
maining from past events for this Sound will still be audible until it fades away. You can
change this behavior by enabling the Audio Mute button in the Audio page of the Sound’s Out-
put properties (see section 18.1.2, Configuring the Main Output of Sounds and Groups) as well
as in Solo and Mute mode on your controller: Activating the audio mute for Sounds will ensure
that not only the events are muted, but any remaining audio as well.
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To momentarily mute all audio from all Sounds and Groups at once, please refer to section
15.2.3, Choke All Notes.

Soloing a Sound

» To solo a Sound, right-click (on Mac OS X: [Ctrl]-click) the number on the left side of the
Sound slot in the Pattern Editor.

Kick Ektl A1

Soloing the first kick Sound.

» To unsolo a Sound, right-click (on Mac OS X: [Ctrl]-click) the number again.

Soloing a Group

» To solo a Group, right-click (on Mac OS X: [Ctrl]-click) the Group index (letter + number)
on the left side of the Group in the Arranger:

navigation_project

AN Lead

Soloing a Group.

» To unsolo a Group, right-click (on Mac OS X: [Ctrll-click) the Group index again.
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Muting a Sound

» To mute a Sound, click the number on the left side of the Sound slot in the Pattern Edi-
tor.

Muting a Sound.
» To unmute the Sound, click the number again.

By default, the Mute on Sounds is an event mute: events for muted Sounds are not trig-
gered, but the audio coming from previous events might still be audible (reverb tail, etc.).
You can also activate audio mute for Sounds to mute both events and audio — see the be-
ginning of this section for more information.

Muting a Group

» To mute a Group, click the Group index (letter + number) on the left side of the Group in
the Arranger:

navigation_project -

Muting a Group.
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» To unmute the Group, click the Group index again.
5.2.2.1 Mute and Solo on Your Controller
To enter solo mode on your controller:
TUPREV P HEXT | [ALLOH | [ HOHE |
15 ShlND 12 150,00 EE TR [AFT..HAVE] ! £ 1
[ACC..DION | § H i [SOUHD 12|
| ALIEH ICE | | HOL.RUHS |
|_SEHD FX | (AFRI.UCKS]
The Solo mode on the controller.
1. Press and hold to enter Solo mode. You can also press + Button 1 to pin this

mode and make it permanent.

2. Solo Sounds by pressing their pads, and solo Groups of the current Group bank by press-
ing their Group buttons. Press Button 3 and 4 to switch to the previous/next Group bank,
respectively.

To enter mute mode on your controller:

TUPREY [C_HERT ALL OH HOHE
12 00D 12 150,00 FE TN [AFT..HAVE] | ol :

¥ : [GOUHD 12

(G [ AEKIKIT | [ALKA.KIT | [EICEG] ALIEH ICE | SCRATCHY JITOHEAGTTY [N HOL.RUMS |
GROUP EL1 LEADS JGIGMOINESEN SEHD FX ] [AFRL.UCKS] BUHPER J EOUHCER JAHPE..IHET

The Mute mode on the controller.

1. Press and hold to enter Mute mode. You can also press + Button 1 to pin
this mode and make it permanent.

2. Mute Sounds by pressing their pads, and mute Groups of the current Group bank by
pressing their Group buttons. Press Button 3 and 4 to switch to the previous/next Group
bank, respectively.

In both Solo and Mute modes you will note the following:

= On your controller, the unmuted pads and Group buttons are fully lit, while the muted
ones are dim lit (and the empty ones are off).

= On the displays, the unmuted Sounds and Groups are highlighted while the muted ones
are not (and the empty ones are... empty).

In both modes the displays provide a few more functions:
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= ALLON (Button 5) turns all Sounds on in the selected Group.
= NONE (Button 6) turns all Sounds off in the selected Group.

= When holding Button 8 (AUDIO) you can see on the pads which Sounds have audio mute
enabled (see above): Sounds with audio mute enabled have fully lit pads, while Sounds
with only event mute have dim lit pads. This is also indicated on the right display (Sounds
with audio mute are highlighted). While holding Button 8 (AUDIO), press any pad to switch
the audio mute for this Sound on or off.

Enabling/disabling audio mute for a Sound does not mute/unmute it! It only sets this
Sound to get both its events and its audio muted when you will mute it via the usual way
(pressing + its pad).

Since soloing a Sound mutes all Sounds except one, the button can then be used to
“release” Sounds that have been muted. You can use this technique to create a break-
down: Solo a given Sound such as a kick drum, then build the track up again by bringing
the muted Sounds back in one at a time while holding the button.

5.2.3  Choke All Notes

The Choke All Notes feature allows you to kill any note or event currently playing in your
Project. This affects the audio coming from all Plug-ins (Internal, Native Instruments, and Ex-
ternal).

Choke All Notes is only available on your controller:

» Press + to choke all playing notes.
Choke All Notes can be useful in various situations:
= as a creative tool in a live performance, e.g. to create stutter beaks,

= as a workflow aid, to stop long one-shot Samples that still continue playing after you have
stopped the sequencer,

= as a first panic button, if you are not sure where in your Project a particular sound is com-
ing from, and you want to get rid of it.
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Contrary to the Mute function, Choke All Notes is not turning any Group/Sound into another
state. Instead, all audio voices currently playing are instantaneously killed. The killed voi-
ces cannot be reactivated and are freed up for subsequent notes according to the polypho-
ny setting. Voices triggered by subsequent notes will play normally.

5.24  Groove

The groove controls the rhythmic relationship between events in the selected channel (Sound,
Group or Master). By shifting some of the events, you can e.g. give a shuffling, ternary touch to
your Patterns.

The groove can be adjusted for each channel individually via its Groove properties.
A groove configured for a channel affects all its contained channels:
= At the Sound level, the Groove properties settings of a Sound affect that single Sound.

= At the Group level, the Groove properties settings of a Group affect all Sounds of the
Group. The Group’s swing is added to the groove set for each individual Sound via its own
Groove properties.

= At the Master level, the Groove properties affect all Sounds of all Groups. The Master's
swing is added to the groove set for each individual Group and Sound via their own Groove
properties.

The Groove properties have a single Parameter page: Swing.

Please refer to section 12.3.3, Navigating Channel Properties, Plug-ins, and Parameter Pa-
ges in the Control Area to know how to display and navigate sets of Channel properties.

2 swiNG

.

Amount

The Groove properties for a Sound in the software.

MASCHINE - Manual - 191



Playing on Your Controller
Playing Tools

HASTER GROUP SOUHD | CHAHHEL NIRRT Qe GROOVE Iv]
Ei. AEKI KIT 15000

SWIHNG
AMOUNT CYCLE INVERT

0.0 % 178 OFF

The Groove properties for a Sound on the controller.

Controls Description

SWING Section

Amount Adjusts the amount of swing, i.e. the amount by which some events are
shifted. At O % events are not shifted. Raise the Amount value to increase
the strength of the swing.

Cycle Determines on what musical resolution the groove is applied. This directly
affects which events will be shifted. Values are measured in fractions of a
whole note.

Invert Allows you to invert the groove so that instead of being delayed in the Pat-

tern events will be triggered ahead of time.

How Groove Affects the Rhythm: An Example

Take a simple, regular one-bar rhythm with a hit on each eighth note. We set the Cycle param-
eter to 1/2, which is one half note, that is two beats.

The following picture shows you how this rhythm would sound with the following settings:
= Top: Amount at 0.0 % (no groove).
= Middle: Amount at 100.0 % and Invert off.
= Bottom: Amount at 100.0 % and Invert enabled.
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This is how the same regular rhythm would be heard with various groove settings.

The picture above only illustrates how the groove function affects the sound — adjusting
the Groove properties will not effectively move events in the Patterns displayed in the Pat-
tern Editor!

9.2.5  Level, Tempo, Tune, and Groove Shortcuts on Your Controller

Your controller provides extra shortcuts for various important parameters. Most of these param-
eters are already available in the Channel properties of the Sounds, Groups, and Master. The
shortcuts detailed here give you an additional quick access to them — especially useful during
live performance.

5.2.5.1 Shortcuts on the MASCHINE MK1 Controller

You can quickly alter the output level, the tempo, and the groove of the Master as well as the
output level, the tune, and the groove of any Group or Sound via the section of your
controller.

The MASTER section of your controller.
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Level Shortcuts
1. To change the output level of the Master (i.e. the overall output level of MASCHINE), sim-

ply turn the knob.

2. To change the output level of a Group, hold its Group button (first navigate to its Group
bank if necessary) and turn the knob.

3. To change the output level of an individual Sound, hold its pad (or hold + its pad
if pads are in Keyboard mode) and turn the knob. In Keyboard mode you can
also press + the pad of the desired Sound, then hold any pad (i.e. any pitch of
that Sound) and turn the knob.

— The adjusted level value is temporarily shown on the left display.

Hold while you turn the knob to adjust the value in finer increments.

These shortcuts control the LEVEL parameter in the AUDIO page of the Master’s, Group’s, and
Sound’s Output properties, respectively. See section 18.1.4, Configuring the Master and
Cue Outputs of MASCHINE and 18.1.2, Configuring the Main Output of Sounds and
Groups for a detailed description of these properties.

In the software you can also adjust the output level of the Master via the Master Volume slider
in the Header:

= = @ | (VD

The Master Volume slider in the software’s Header.

To reset the output level of the Master to O dB, double-click the Master Volume slider.

Groove Shortcuts

1. To change the groove of the Master, simply turn the knob.
2. To change the groove of a Group, hold its Group button (first navigate to its Group bank if
necessary) and turn the knob.
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3. To change the groove of an individual Sound, hold its pad (or hold + its pad if
pads are in Keyboard mode) and turn the knob. In Keyboard mode you can also
press + the pad of the desired Sound, then hold any pad (i.e. any pitch of that

Sound) and turn the knob.

— The adjusted groove value is temporarily shown on the left display.

Hold while you turn the knob to adjust the value in finer increments.

These shortcuts control the AMOUNT parameter in the SWING page of the Master’s, Group’s,
and Sound’s Groove properties, respectively. See section 15.2.4, Groove for a detailed de-
scription of these properties.

In the software you can also adjust the Swing amount of your Project via the SWING control in
the Header:

150.00 19.0 %

The SWING control in the software’s Header.

Tempo and Tune Shortcuts
1. To change the tempo of the Master (i.e. the tempo of your Project), simply turn the
knob.

2. To change the tune of all Sounds in a Group, hold the desired Group button (first navigate
to its Group bank if necessary) and turn the knob.

3. To change the tune of an individual Sound, hold its pad (or hold + its pad if pads
are in Keyboard mode) and turn the knob. In Keyboard mode you can also press
+ the pad of the desired Sound, then hold any pad (i.e. any pitch of that Sound)

and turn the knob.

— The adjusted tempo or tune value is temporarily shown on the left display.

Hold while you turn the knob to adjust the value in finer increments.

At the Master level, the shortcut controls the Tempo parameter in the Header.
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The Tempo parameter in the software’s Header.

At the Group and Sound level, the shortcut works only with Sounds containing a Sampler or
a Drumsynth Plug-in. The shortcuts control the TUNE parameter of the PITCH / GATE section in
the PITCH / ENVELOPE page of the Sampler, and the TUNE parameter of the MAIN section in the
MAIN page of any Drumsynth. If you hold a Group button, the shortcut will affect all Sounds
of the Group that contain a Sampler or Drumsynth Plug-in. For more details on the TUNE
parameter, please refer to section 16.2.1, Page 1: Voice Settings / Engine for the Sampler
and section 110.1.5, Pitch Range, Tuning, and MIDI Notes for the Drumsynths.
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b Working with Plug-ins

Plug-ins are the building blocks of all sound in MASCHINE. They can be used at all three lev-
els of the MASCHINE audio routing system: in Sounds, in Groups, and in the Master.

In MASCHINE versions prior to 2.0, Internal Plug-ins were called Modules.

This chapter includes various general or specific Plug-in topics:
= An overview of Plug-ins and how to handle them (16.1, Plug-in Overview).

= An exhaustive description of an essential Internal Instrument Plug-in in charge of playing
back all sample content in MASCHINE: the Sampler (16.2, The Sampler Plug-in).

= Specific information on Native Instruments and External Plug-ins (16.2.6, Page 6: Veloci-
ty / Modwheel).

6.1  Plug-in Overview

This section describes Plug-ins in general: where you can find them, how you can adjust their
settings, and how you can manage them.

6.1.1  Plug-in Basics

In Arrange view, the content and settings of the focused Sound/Group or the Master are dis-
played in the Control area (in the middle of the software window):
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(@) 0 150.00 0.0 %
LIBRARY Raminagrobis
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The Control area displaying the content of the Sound ClosedHH Ektl A of the selected Sound slot 2.

Sounds, Groups, and the Master can each hold any number of Plug-ins. These are stacked up
in the Plug-in List, on the left of the Control area.

GROUP
Alka Kit Fat&Slow 0 MAIN
Saturator

[ 5

+

» To show the Plug-in List, click the little Plug-in icon at the far left of the Control area:
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GROUP
Alka Kit Fat&S
Saturator

[ S

In the Plug-in List, the processing order is always from top to bottom.
@ In addition to Plug-ins, each Sound, each Group, and the Master also provide a set of glob-

al settings called Channel properties. These are described in section 15.2.4, Groove and in
chapter 18, Audio Routing, Remote Control, and Macro Controls.

Different Types of Plug-ins

Plug-ins can be of different types:

Instrument Plug-ins Effect Plug-ins

Internal Plug-ins Sampler, Drumsynths MASCHINE internal effects

Native Instruments Plug- | VST/AU instrument plug-ins from Native | VST/AU effect plug-ins from Native In-
ins Instruments’ range of products struments’ range of products

External Plug-ins Third-party VST/AU instrument plug-ins | Third-party VST/AU effect plug-ins

= Instruments: These Plug-ins generate sound. Instrument Plug-ins can only be loaded in the
first Plug-in slot of Sounds. Following Plug-ins are available:

o Sampler: Included with MASCHINE, the Sampler Plug-in allows the selected Sound to
play back Samples. This is the most common sound source, as adding a Sample to
the Sound slot will automatically load the Sampler in the first Plug-in slot of the
Sound. See 16.2, The Sampler Plug-in for more details.

o Drumsynths: Included with MASCHINE, these Plug-ins are mini-synths specialized in
generating drum sounds. See chapter 110, Using the Drumsynths for more details.

o Native Instruments: You can use all Native Instruments KOMPLETE instruments instal-
led on your computer as VST/AU plug-ins (e.g., MASSIVE, which is included with MA-
SCHINE). Products from Native Instruments are tightly integrated in MASCHINE.

o External: You can also use VST/AU instrument plug-ins from any third-party manufac-
turers.
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= [Effects: These Plug-ins modify the audio coming from the previous Plug-in slot (or from
the incoming audio if the Effect is loaded in the first Plug-in slot of a Sound). Effect
Plug-ins can be loaded in any Plug-in slot. Following Plug-ins are available:

o Internal Effects: These are the Effect Plug-ins included with MASCHINE. To read every
details about each of the MASCHINE internal effects, and how to use them, please
refer to chapter 18, Audio Routing, Remote Control, and Macro Controls and 112, Ef-
fect Reference.

o Native Instruments: You can use all Native Instruments KOMPLETE effects installed on
your computer as VST/AU plug-ins. Products from Native Instruments are tightly inte-
grated in MASCHINE.

o External: You can also use VST/AU effect plug-ins from any third-party manufacturers.

What to Load, and Where

The type of Plug-in that you can load depends on the selected level (Sound, Group or Master)
and slot:

= Effect Plug-ins (both internal and external) can be loaded in all Plug-in slots at all levels
(Sound, Group, Master).

= Instrument Plug-ins (both internal and external) can only be loaded in the first Plug-in
slot of Sounds.

6.1.2  First Plug-in Slot of Sounds: Choosing the Sound’s Role

The Plug-in loaded in the first Plug-in slot of a Sound will determine the general role of this
Sound:

= |f the first Plug-in slot holds an Instrument Plug-in (Sampler, Drumsynth, Native Instru-
ments or External Instrument, see above), the Sound will generate its own audio.

= |f the first Plug-in slot holds an Effect Plug-in (Internal, Native Instruments or External),
the Sound will be available as bussing point for other signals (from within MASCHINE,
and possibly from the outside world). This notably allows you to build up send effects or
to apply effects to external audio. See section 111.3.1, Step 1: Set Up a Sound or Group
as Send Effect for more information.
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You can also sample directly to a Sound slot. This will automatically load a Sampler in its
first Plug-in slot. Read chapter 112, Effect Reference for more details on this.

6.1.3  Loading, Removing, and Replacing a Plug-in

The procedure to load a Plug-in with its default settings is common to all levels (Sound, Group,
and Master) and all Plug-in types (Internal, Native Instruments, and External, as well as Instru-
ment and Effect):

1. Set the focus to the Sound, Group or the Master where you want to load the Plug-in (see
section 12.3.1, Setting the Focus on a Group or a Sound). In the picture below we click
an empty Sound slot in the Sound List of the Pattern Editor and click the SOUND tab in
the Control area above.

Sound 2

+

Group B2 w (none)

1
u Sound 2

The Control area will now show the content (Channel properties or Plug-ins) of the Sound
we have just selected.

2. At the far left of the Control area, click the little plug icon to display the Plug-ins.

This displays the Plug-in List on the left of the Control area:
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Sound 2
[ =

+

The Plug-in List is still empty, because we selected an empty Sound slot. The only visible

“woon

element in the list is a “+"” icon at the top left.

3. Click the slot with the “+" icon at the top of the Plug-in List.
This opens the Plug-in menu where you can select the desired Plug-in for loading (see be-
low for a detailed description of the entries contained in the Plug-in menu).

I
Transient Mastar
Limiter

Sound Maximizer

EQ
Filter

Chorus

Flanger m

FM

Frag Shifter
Phaser

lce

— Upon your selection the selected Plug-in sits at the top of the Plug-in List, in the first
Plug-in slot of the Sound (in our example). In addition, some Native Instruments and Ex-
ternal Plug-ins will automatically open in a floating window (see section 16.3.1, Opening/
Closing Plug-in Windows for more on this).

You will notice that the “+” sign has moved to the next slot. Clicking it would allow you to load
a Plug-in into the next Plug-in slot of that Sound, and so on.

Instead of using the Plug-in menu to load a Plug-in with its default settings, you can also
use the Browser to load a particular preset for a Plug-in. In particular, this can come in
handy to insert a new Plug-in between two existing Plug-ins of the Plug-in List. Please refer
to chapter 13.2, Searching and Loading Files from the Library for more information.

MASCHINE - Manual - 202



Working with Plug-ins

Plug-in Overview

Removing and Replacing a Plug-in

Once you have loaded a Plug-in into a Plug-in slot, the slot shows the name of the loaded
Plug-in, preceded by an icon describing the type of Plug-in (Instrument or Effect), and fol-
lowed by a down-pointing arrow:

m Distortion
Com pressor
+

A few Plug-ins loaded.
This down-pointing arrow lets you open the Plug-in menu for slots already hosting a Plug-in.

» In the Plug-in List, click the down-pointing arrow at the right of a Plug-in name to open
the Plug-in menu for that slot. You can also right-click ([Ctrl]-click on Mac OS X) the
Plug-in name in the slot.

This will notably allow you to remove the loaded Plug-in from the slot:

» To remove the Plug-in currently loaded in a slot, open its Plug-in menu and select None
at the top of the menu.

MNonea P

Mative Irlsbgun'mnts k
External 3

Compressor
Gate

Transient Master
Limiter
Maximizer

EQ
Filter

Distort
m (! art mws
Compre
+

Flangar
FM
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— The Plug-in is unloaded from the slot. All following Plug-ins are shifted one slot upwards
to fill the gap.

Furthermore, the Plug-in menu also allows you to replace the loaded Plug-in with another one:

» To replace the Plug-in currently loaded in a slot, open its Plug-in menu and select anoth-
er Plug-in in the menu.

— The original Plug-in is replaced with the newly selected one. The rest of the Plug-in List
stays untouched.

You can also recall the search query that was used to find the Plug-in preset currently loa-
ded in the Plug-in slot (see section 13.7, Using Quick Browse for more information).

Content of the Plug-in Menu

The entries in the Plug-in menu differ according to the Plug-in slot from which you are calling
the menu:

= The first Plug-in slots of Sounds accepts both Instrument and Effect Plug-ins. The entries
available in their Plug-in menu are listed in the following table.

= All other Plug-in slots at the Sound, Group, and Master level only accept Effect Plug-ins.
Therefore, their Plug-in menus and submenus provide the same entries except all entries
for Instrument Plug-ins.

The Plug-in menus can have following entries, from top to bottom:

Plug-in Menu Entry Description

Plug-ins

Presets submenu (only when a | Lists all VST/AU presets made available to MASCHINE by the VST/AU plug-
Native Instruments or External |in. This allows you to use your favorite presets of the VST/AU plug-in direct-
Plug-in is loaded) ly inside MASCHINE. See section 16.3.4, Using VST/AU Plug-in Presets for
more information.

None Select None to remove the Plug-in currently loaded (see previous para-
graph).
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Plug-in Menu Entry Description

Native Instruments submenu Lists available Native Instruments’ Instruments (first Plug-in slot of Sounds
only) and Effects. For products working both as Instrument and Effect, the
Effect Plug-in name is followed by the mention FX. If necessary each entry
is followed by the plug-in type between brackets: (VST) or (AU). See section
16.2.6, Page 6: Velocity / Modwheel for more information.

External submenu Lists the available External Plug-ins, i.e. the available VST/AU instrument
(first Plug-in slot of Sounds only) and effect plug-ins from third-party manu-
facturers. Each entry is followed by the plug-in type between brackets:
(VST) or (AU). See section 16.2.6, Page 6: Velocity / Modwheel for more in-
formation.

Sampler (first Plug-in slot of The Sampler is the Internal Instrument Plug-in used to play back all Sam-
Sounds only) ples in MASCHINE — this essential Plug-in will be described in details in
section 16.2, The Sampler Plug-in.

Drumsynth submenu (first Lists the available Drumsynths: Kick, Snare, Hi-hat, Tom, and Percussion.
Plug-in slot of Sounds only) Included with MASCHINE, these Instrument Plug-ins are synths specialized
in generating drum sounds — for all details please refer to chapter 110, Us-
ing the Drumsynths.

All MASCHINE Internal Effects | Effect Plug-ins included with MASCHINE. Their entries are split into vari-
ous categories (dynamics, filtering, modulation, reverb, etc.). See chapter
110.6.3, Percussion — Shaker for more details on their usage, and chapter
112, Effect Reference for an exhaustive description of each MASCHINE In-
ternal Effect Plug-in.

Edit Commands

Cut Removes the Plug-in from its current slot and stores the Plug-in and all its
settings to the clipboard for later use.

Copy Copies the Plug-in and all its settings to the clipboard for later use.

Paste Loads into the current slot the Plug-in and all its settings that were cut or

copied from another slot. This notably allows you to use a Plug-in in differ-
ent locations (Sounds, Groups, Master) with the same settings.

Preset Management

Open... Allows you to open a Plug-in preset you have previously saved.
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Plug-in Menu Entry Description

Save As... Allows you to save the current Plug-in settings as a preset for later use. This

preset will appear in the Browser.

Save As Default... (only when a | Allows you to save the current Plug-in settings as a default preset. This de-
Native Instruments or External |fault preset will be recalled each time you load the Plug-in from the Plug-in
Plug-in is loaded) menu.

é Note that the first two submenus Native Instruments and External only show the Plug-ins
that are enabled in the Plug-ins page of the Preferences panel. For more on this, see sec-
tion 12.5.4, Preferences — Plug-ins Page.

A The edit commands (Cut, Copy, and Paste) and preset management commands (Open,

Save As..., and Save As Default...) available at the bottom of the Plug-in menu will be cov-
ered in section 16.1.7, Moving Plug-ins and 16.1.9, Saving and Recalling Plug-in Presets,
respectively.

6.1.3.1 Loading, Removing, and Replacing a Plug-in on the MASCHINE MK1 Controller
On the MASCHINE controller, do the following:

1.
2.

Press CONTROL to enter Control mode.

Select the Sound, Group or the Master where you want to load, remove or replace a Plug-
in (see section 12.3.1, Setting the Focus on a Group or a Sound).

Press Button 6 (PLUG-IN) to display the Plug-in slots of the selected Sound, Group or the
Master.

Press Button 7/8 to navigate to the desired Plug-in slot.

The name of the selected Plug-in appears in the field between the left and right arrows
under Button 7 and 8. If there are no Plug-ins in the channel this will read (NONE).

You are now ready to load, insert, remove or replace a Plug-in as described in the follow-
ing paragraphs.

Loading a Plug-in in Place

To load a Plug-in into the selected Plug-in slot, do the following:

1.

Press SHIFT + BROWSE to open the Plug-in Browser and browse the available Plug-ins.
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On the left display, use Knob 1 to select the TYPE from INTERNAL, NI or EXTERNAL.

The right display shows the list of available Internal, Native Instruments or External Plug-
ins, respectively.

If you have selected the first Plug-in slot of a Sound, use Knob 2 to select the SUBTYPE
from INSTR (Instruments) or EFFECT.

If you have selected any other Plug-in slot the SUBTYPE field is not available — only Effect
Plug-ins will be listed in the right display.

Turn Knob 5 to browse the Plug-ins corresponding to your TYPE (and possibly SUBTYPE) se-
lection.

When you have found the Plug-in you want to use, press Button 8 to load it.

If the selected Plug-in slot was not empty, the previous Plug-in will be replaced with the
new Plug-in!

Instead of using the Plug-in Browser, you can also use the global Browser to load a particu-
lar preset for a Plug-in. Please refer to section 13.2, Searching and Loading Files from the
Library for more information.

Inserting a Plug-in

To insert a Plug-in directly after the selected Plug-in slot, do the following:

1.

Press + Button 4 (INSERT).

This automatically opens the Browser on your controller and locks the File Type to EFFECT
(Button 1 and 2, normally used in the Browser to select the desired File Type, are here
disabled).

Choose and load the desired Plug-in preset via the usual workflow in the Browser (see sec-
tion 13.2, Searching and Loading Files from the Library).

When you finally press the Button 8 (LOAD), your controller automatically switches back to
Control mode and the new Plug-in is loaded in the next Plug-in slot. All following Plug-ins
are shifted one slot downwards to make room for the new Plug-in.

Removing a Plug-in

To remove a Plug-in from its slot, do the following:

» Press + Button 6 (REMOVE).
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— The Plug-in is unloaded from the slot. All following Plug-ins are shifted one slot upwards
to fill the gap.

Alternatively, you can press + , use Knob 5 to select (NONE) at the top of
the list on the right display, and press Button 8 (LOAD).

Replacing a Plug-in
» To replace a Plug-in, simply select its slot and load a new Plug-in as described above.

You can also recall the search query that was used to find the Plug-in preset currently loa-
ded in the Plug-in slot (see section 13.7, Using Quick Browse for more information).

6.1.4  Adjusting the Plug-in Parameters

The procedure for adjusting the Plug-in parameters is common to all types of Plug-ins and all
sets of Channel properties. It is described in section 12.3.3, Navigating Channel Properties,
Plug-ins, and Parameter Pages in the Control Area.

Native Instruments and External Plug-ins only: You can also adjust the Plug-in parameters
via the own user interface of the VST/AU plug-in. More on this in 16.2.6, Page 6: Velocity /
Modwheel.

6.1.5  Bypassing Plug-in Slots

You can bypass (or “mute”) any Plug-in slot. When a Plug-in slot is bypassed, the Plug-in it
contains is temporarily removed from the signal flow and does not process the audio passing
through the slot. Instead, the incoming audio is directly sent to the next Plug-in slot for further
processing (or to the channel’s output if you bypass its last Plug-in slot).

Bypassing Plug-in slots can be very useful in various situations, for example:
= Bypassing and re-enabling an effect during a live performance.
= Comparing the sound with and without an effect.

= Troubleshooting complex effect chains and routings (“Where does this strange reverb tail
come from?”).
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To bypass a Plug-in, do the following:

1.

If you want to bypass a Plug-in of the Master, click the MASTER tab in the top left corner
of the Control area.

If you want to bypass a Plug-in of a Group, click the desired Group on the left of the Ar-
ranger, and click the GROUP tab in the top left corner of the Control area.

If you want to bypass a Plug-in of a Sound, click the Group of its parent Group in the Ar-
ranger, click the desired Sound slot on the left of the Pattern Editor, and click the
SOUND tab in the top left corner of the Control area.

In the Plug-in List, click the icon left to the Plug-in name (keys for an Instrument Plug-in,
FX for an Effect Plug-in) to bypass this Plug-in.

Lj samo

E Distortion

Fk! Comprassor

+

The Plug-in does not affect the sound anymore. The icon is grayed out to indicate that
this slot is now bypassed.

Use the same method to unmute the Plug-in:

» To activate the bypassed slot again, click its grayed out icon.

In most cases the first Plug-in slot contains an Instrument Plug-in (e.g., a Sampler). Be
careful: bypassing the slot will mute the whole Sound!

6.1.5.1 Bypassing a Plug-in Slot on the MASCHINE Controller

1.
2.
3.

Press the button to enter Control mode.
If you want to bypass a Plug-in of the Master, press Button 1 to select the MASTER tab.

If you want to bypass a Plug-in of a Group, press Button 2 to select the GROUP tab and
press the Group button A-H corresponding to the desired Group. If necessary, first press

+ the desired Group button A-H to switch to the Group bank containing that
Group.
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4. If you want to bypass an effect of a Sound, press Button 3 to select the SOUND tab, select
its parent Group as described in the previous step, and press + the pad of that
Sound (or simply hit its pad if pads are in Group mode).

5. Make sure PLUG-IN (Button 6) is activated to show the Plug-in slots.

6. Press Button 7/8 to select the desired Plug-in slot.

The name of the selected Plug-in appears in the field between the left and right arrows
under Button 7 and 8. If there are no Plug-ins in the channel this will read (NONE).

7. Press + Button 5 (BYPASS) above the right display to bypass the corresponding
Plug-in slot.

— The Plug-in is bypassed and does not affect the sound anymore. When you hold ,
Button 5 is fully lit and the BYPASS label on the right display is highlighted to indicate
that this Plug-in slot is now bypassed:

HASTER | [ GROUP | I IHSERT i [ REMOVE | (1] HOVE
1 AFRICAN PLOCKS 150,00 150

MODE DEFTH TIME OUTPUT
MODE THRESHOLD KNEE AMOUNT ATTACK RELEASE GAIN
CLASSIC -10.0 DB 50.0 % 9.0 % 0.25 M5 100.0 M5 -3.6 DB

Use the same method to unmute the effect:

» To unmute the effect, press + the lit Button 5 (BYPASS).

In most cases the first Plug-in slot contains an Instrument Plug-in (e.g., a Sampler). Be
careful: bypassing the slot will mute the whole Sound!

6.1.6  Using Side-Chain

Some Plug-ins provide side-chaining. This allows you to control their influence on the audio via
another audio signal sent to their secondary, side-chain input. This extra routing feature is de-
scribed in details in section 111.1.3, Using the Side-Chain Input.

6.1.7  Moving Plug-ins

MASCHINE allows you to move Plug-ins across the Plug-in List and across Sounds and Groups.
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Moving Plug-ins Within the Plug-in List

» To move a Plug-in in the Plug-in List, click its name and drag your mouse vertically.
While you are holding the mouse button, an insertion line appears at the place in the
Plug-in List where the Plug-in would land if dropped. Drag your mouse until the insertion
line is at the desired location, then release the mouse button to drop the Plug-in onto this
new location.

lll Sampler

Saturator

m ange

— The Plug-in takes its new place between the existing Plug-ins while keeping the exact
same settings. All other Plug-ins sitting between its old and new location are shifted one
slot upwards/downwards to fill the gap.

Dragging Plug-ins can be very useful if you want to quickly change the effects’ processing
order in the channel.

Moving Plug-ins Across Sounds and Groups

Moving Plug-ins is not only possible within the same Sound but also across Sounds, across
Groups, across levels (e.g., from a Sound to a Group) or across Sounds in different Groups!

To move a Plug-in to another Sound, Group or the Master, do the following:

1. Click the down-pointing arrow of the slot containing the Plug-in that you want to move.
2. In the Plug-in menu that opens, select Cut.

3. Select the Sound, Group or the Master where you want to move the Plug-in (see section
12.3.1, Setting the Focus on a Group or a Sound).

4. Click the down-pointing arrow of the target slot (the slot where you want to move the Plug-
in to).
5. In the Plug-in menu that opens, select Paste.

— The Plug-in with all its parameters has now been moved from its original location to its
target location.
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Duplicating Plug-ins Across Sounds and Groups

Instead of selecting Cut in the Plug-in menu of the original slot (see above), select Copy to du-
plicate the Plug-in to another slot!

6.1.7.1  Moving a Plug-in on the MASCHINE Controller

On your controller in Control mode, you can move a Plug-in to another slot of the same Sound,

Group or the Master. To do this:

1. Select the desired Plug-in (see section 12.3.3, Navigating Channel Properties, Plug-ins,
and Parameter Pages in the Control Area).

2. Press + Button 7/8 to move this Plug-in to the previous/next slot, respectively.

— The Plug-in takes its new place between the existing Plug-ins while keeping the exact

same settings. All other Plug-ins sitting between its old and new location are shifted one
slot upwards/downwards to fill the gap.

6.1.8  Alternative: the Plug-in Strip

You can also manipulate your Plug-ins via the Plug-in Strip in the Mix view of MASCHINE. You
will find all details on this feature in section 19.4, The Plug-in Strip.

6.1.9  Saving and Recalling Plug-in Presets

All settings and assignments of a Plug-in can be saved as Plug-in presets. Once saved, Plug-in
presets can be accessed from the Browser, both in the software and from your controller (see
section 13.2, Searching and Loading Files from the Library). This is a very quick and conven-
ient way to recall Plug-ins with their parameters already set to specific values.

Saving Plug-in Presets

Saving Plug-in presets can only be done in the software via the Plug-in menu. To access the
Plug-in menu, click the drop-down arrow on the right-hand side of the Plug-in slot in the Plug-
in List:
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ll‘ Sampler

Distartion

+

Opening the Plug-in menu.

The commands for saving Plug-in presets are found at the bottom of the Plug-in menu.

M S reen

Resochord

Distortion

Save As...
Save As Default...

The commands for saving and recalling Plug-in presets in the Plug-in menu.

Plug-in Menu Entry Description

Save Saves your changes to the preset currently loaded.

Save As... Saves the current Plug-in settings as a new preset on your hard disk.

Save As Default... (Native In- | Only available if a VST/AU plug-in (Native Instruments or External) is loaded
struments and External Plug- |in this Plug-in slot. This command saves the current settings and assignments
ins only) as the default preset for the Plug-in. This default preset will be loaded with
this Plug-in when you load it from the Plug-in Browser on the controller or the
Plug-in menu in the software. See also 12.5.4, Preferences — Plug-ins Page
for more information on managing plug-ins and their default presets.

@ The Save As... and Save As Default... commands notably allow you to import into the MA-

SCHINE library your user presets for Native Instruments instruments/effects as well as both

factory and user presets for third-party instruments/effects! See 16.3.4, Using VST/AU
Plug-in Presets section for more on this.
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Recalling Plug-in Presets

All Plug-in presets you saved as described above are available in the Browser, both in the soft-
ware and from your controller! You will find each Plug-in preset automatically placed in the
corresponding “Instrument” or “Effect” category in the File Type selector of the Browser’s LI-
BRARY pane. Furthermore, user presets will be available when selecting the User content in
the Content selector of the Browser’s LIBRARY pane.

For more information on how to load Plug-in presets in the Browser, please refer to chapter 13,
Browser.

You can assign tags to the Plug-in presets that you saved. This is done in the Browser in
the MASCHINE software. For more information, please refer to section 13.4, Editing the
Files' Tags and Properties.

In addition, the MASCHINE library already provides a collection of Plug-in presets for MA-
SCHINE Internal Plug-ins. Furthermore, any Native Instruments product installed on your com-
puter will have its own factory library already imported into the MASCHINE Browser so that you
can browse and load its presets directly from MASCHINE, ready for loading.

KOMPLETE products and MASCHINE EXPANSIONS have to be updated to ensure their full
integration into the MASCHINE Library. To update any Native Instruments product instal-
led on your computer, please start the Service Center.

You can also load a Plug-in preset from the Plug-in menu by selecting the Open... command,
then navigating your file system and selecting the desired preset file (extension “.mxinst” for
Instrument Plug-in presets, “.mxfx” for Effect Plug-in presets, or “.mfxp” for MASCHINE 1.x
Module presets).

6.2  The Sampler Plug-in

The Sampler Plug-in allows you to play back any Sample in MASCHINE — including all
Groups, Sounds and Samples of the factory library. The Sampler comes with an extensive set
of parameters that offer various ways to further shape each of your Sounds individually. You
can tune, change basic dynamics and apply effects as well as different modulation options.
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Many of these parameters can be modulated and automated! For more information, see
section 17.5, Recording and Editing Modulation and 18.2.2, Controlling Parameters via
MIDI and Host Automation, respectively.

In case MASCHINE cannot find the Sample(s) loaded in a Sampler Plug-in, a Missing Sam-
ple dialog will appear and help you locate the missing Sample(s) again. Please refer to sec-
tion13.6, Locating Missing Samples for more information.

This section describes the specific parameters found in the Sampler. For a general description
of the features and characteristics of Plug-ins (including the Sampler), please refer to section
16.1, Plug-in Overview.

We show here the Sampler parameters as they appear in the Control area of the Arrange
view. The Sampler also provides a custom panel in the Plug-in Strip of the Mix view. This
panel is described in section 19.4.3, Panel for the Sampler.

The Sampler parameters are organized in 6 pages:
= Page 1: Voice Settings / Engine: 16.2.1, Page 1: Voice Settings / Engine.
= Page 2: Pitch / Envelope: 16.2.2, Page 2: Pitch / Envelope.
= Page 3: FX/ Filter: 16.2.3, Page 3: FX/ Filter.
= Page 4: Modulation: 16.2.4, Page 4: Modulation.
= Page 5: LFO: 16.2.5, Page 5: LFO.
= Page 6: Velocity / Modwheel: 16.2.6, Page 6: Velocity / Modwheel.

These Parameter pages can be selected for displaying/editing via the usual way as described in
section 12.3.3, Navigating Channel Properties, Plug-ins, and Parameter Pages in the Control
Area. For example:

» To display a particular Parameter page in the software, click its label at the top of the
Control area.
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6.2.1  Page 1: Voice Settings / Engine

MASTER | [ GROUF | IETITT] PLUG-IH J 1. SAHPLER Iv]
3 INFLUX .O0FT & 5L 150.00 1301
VOICE SETTIHGS EHGINE 1756

POLYFHONY PITCHEEND MODE
8 3.00 STAHDARD

Sampler parameters — page 1 of 6: VOICE SETTINGS and ENGINE on the controller.

Volce Settings / Engine Pitch f Envelopa FX / Filter Maodulation LFO Velocity / Modwheel

VOICE SETTINGS ENGINE

.
1
Standard
-

Palyphony Pitchbend Mode

Sampler parameters — page 1 of 6: VOICE SETTINGS and ENGINE in the software.

Parameter Description

VOICE SETTINGS

Polyphony Here you can define a voice limit for the Sound, that is the maximum number of
voices (notes) the Sampler can play simultaneously. Once this polyphony has
been reached, triggering any additional note will kill the “oldest” note still play-
ing (i.e. the note that was triggered first). The available values are 1, 2, 4, 8 (de-
fault), 16, 32, and 64. You can also set this to Legato — in that case the poly-
phony is set to 1 and the Sampler performs a continuous pitch transition be-
tween consecutive notes.

Glide If Legato is selected for the Polyphony parameter, this allows to adjust the dura-
tion of the transition between consecutive notes.

Pitchbend Here you can adjust how the Sound reacts on incoming MIDI Pitchbend messag-
es from an external MIDI controller or your host application. For more informa-
tion on how to setup your Sounds to receive MIDI, refer to section 18.2.1, Trig-
gering Sounds via MIDI Notes.
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Parameter Description

ENGINE

Mode This allows you to select between different models for the sampling engine. Be-
sides the default Standard setting, the other options MP60 and S1200 emulate
the sound of two legendary Samplers that are often used in Hip-Hop and similar
genres of music. The latter comes in various flavors offering different filtering:
S1200 (no filtering), S1200 L (for Low, i.e. low-pass filtering), S1200 LM (for
Low-Mid, i.e. low-mid-pass filtering), SI200 HM (for High-Mid, i.e. mid-high-
pass filtering), and S1200 High (for High, i.e. high-pass filtering).

6.2.2  Page 2: Pitch / Envelope

[MASTER | [ GrouP | IIETLTR CHAHHEL PLUG-IN J 1. SAMPLER D
B3 IMFLUK. 00F| & S 150.00 13:1:1

FITGH ~ GATE AMPLITUDE ENVELOFPE =2/6
TUNE T REVERSE TYFE ATTACK DECAY SUSTAIN RELEASE
0.00 8 OFF ADSR 0.00HMS 217.0M5 1.00 69.4 M5

Sampler parameters — page 2 of 6: PITCH / GATE and AMPLITUDE ENVELOPE on the controller.

Sampler parameters — page 2 of 6: PITCH/ GATE and AMPLITUDE ENVELOPE on the controller.

s / Engine Pitch f Envelopa FX / Fllter Maodulation LFO Velocity / Modwheel

AMPLITUDE ENVELOPE

9 w

Decay Sustain Release

Sampler parameters — page 2 of 6: PITCH / GATE and AMPLITUDE ENVELOPE in the software.

Parameter Description

PITCH / GATE

Tune Defines the basic pitch of your Sample: turn the knob to the right for a higher
pitch and to the left for a lower pitch.

Start Determines the start point of the Sample. This parameter can also be modulated
by the Velocity control, see 16.2.5, Page 5: LFO.
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Parameter Description

Reverse If Reverse is activated, the Sample will be played backwards.
Type Selects from three different types of amplitude envelopes. See below for more
information.

AMPLITUDE ENVELOPE

The AMPLITUDE ENVELOPE section allows you to tailor your Sample in terms of its loudness
over time.

The Type selector.

The Type selector allows you to choose from three different types of amplitude envelopes. De-
pending on the selected type, the available parameters in the AMPLITUDE ENVELOPE section
will differ (see table below):

= One-shot: This is typical vintage drum machine behavior: the sample is played in its en-
tirety from beginning to end with no envelope. If One-shot is selected, the AMPLITUDE
ENVELOPE section doesn’t display any parameters.

FX / Filter Modulation LFO Velocity / Modwheal

s
Onashot
w

Typa
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= AHD: AHD mode disables the Sustain and Release controls of the ADSR envelope (see be-
low), and replaces them with the Hold parameter. AHD mode is ideal for “fire and forget”
behavior, whereby you would like to have the sound trigger for a certain amount of time
regardless of how long you hold the pad down.

FX / Filtar Modulation LFO Velocity / Modwheal

AMPLITUDE ENVELOPE

2.9

Attack Hold Dacay

= ADSR: Typically, the ADSR envelope is used for longer, sustained Samples that require
complex dynamic control.

FX / Filtar Modulation LFO Velocity / Modwheal

AMPLITUDE ENVELOPE

(& ") |9,

Dacay Sustain Ri

Unlike many other hardware devices, the pads on MASCHINE are sensitive not only to be-
ing hit, but also to being held — so using the ADSR envelope, you can make the pads be-
have like a MIDI keyboard and sustain a note only for as long as it is held down.

Parameter Description

AMPLITUDE ENVELOPE

Attack (AHD and ADSR) Attack determines how quickly the Sound reaches full volume after being trig-
gered.

Hold (AHD only) Hold determines how long the envelope will stay at its maximum level.

Decay (AHD and ADSR) Decay determines how fast the envelope drops to the Sustain level in ADSR
mode; in AHD mode, it is used to adjust how fast the Sound dies down. This pa-
rameter can also be modulated by the Velocity control, see 16.2.5, Page 5: LFO.
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Parameter Description

Sustain (ADSR only) Sustain determines the constant level being kept after Decay until the note
ends. This can also be controlled by an external MIDI controller or keyboard us-
ing the MIDI Control Change 64.

Release (ADSR only) Release determines how long the sound takes to fade out after the note has
ended.

6.2.3  Page 3: FX/Filter

[MASTER | [ GrouP | IIETLTR CHAHHEL PLUG-IN J 1. SAMPLER D

B3 IMFLUK. 00F| & S 150.00 13:1:1

FILTER
=R EITS FILTER
OFF OFF OFF

Sampler parameters — page 3 of 6: FX and FILTER on the controller.

Voice Settings / Engine Pitch / Envelope EX / Filter Modulation LFO Velocity /
EX FILTER

)
Off

-

’

Comp SR Filtar

Sampler parameters — page 3 of 6: FX and FILTER in the software.

FX

This is a small selection of basic effects, not to be mixed up with the collection of Effect Plug-
ins covered in depth in chapter 12.

Parameter Description

FX
Comp Basic compressor allowing you to give a Sound more density.
Drive Defines the amount of saturation applied to a Sound.
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Parameter Description

SR SR stands for “sample rate”: you can use it to lower the original sample rate in
order to make the Sound more lo-fi.

Bits Allows you to lower the original bit depth of the Sound, resulting in a more
rough, digital sounding lo-fi effect.

FILTER

The Filter selector in the FILTER section gives you access to a set of different filters. Using the
arrows or clicking the type currently displayed, you can choose from different filter type set-
tings: Off, LP2, BP2, HPZ, and EQ. Each type results in different parameters to the right of it:

Filter Modes Description

Off No filter.

LP2 LP2 is a low-pass filter with Cutoff and Resonance parameters. Cutoff can be
modulated by Velocity, the Modulation Envelope, the LFO or the MIDI Modula-
tion Wheel.

BP2 BP2 is a band-pass filter with a Cutoff parameter. Cutoff can be modulated by
Velocity, the Modulation Envelope, the LFO or the MIDI Modulation Wheel.

HP2 HP2 is a high-pass filter with Cutoff and Resonance parameters. Cutoff can be
modulated by Velocity, the Modulation Envelope, the LFO or the MIDI Modula-
tion Wheel.

EQ The EQ is an equalizer with Frequency, Bandwidth and Gain parameters.

6.24  Page 4: Modulation
Sampler parameters — page 4 of 6: MODULATION ENVELOPE and DESTINATION on the controller.

Ings / Engine Pitch f Envelopa FX / Fllter Maodulation LFO Valocity / Modwheeal

MODULATION ENVELOPE DESTINATION

C O

Decay Sustain Release Pitch Cutoff

Sampler parameters — page 4 of 6: MODULATION ENVELOPE and DESTINATION in the software.
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MODULATION ENVELOPE

The MODULATION ENVELOPE section offers an additional envelope allowing further modifica-
tion (or “modulation”) of specific Sampler parameters according to the way you play on the
pads. Its parameters are matched to those of the AMPLITUDE ENVELOPE section on page 2
(see 16.2.1, Page 1: Voice Settings / Engine), so that you have either an ADSR (Attack, Decay,
Sustain, Release) envelope or an AHD (Attack, Hold, Decay) envelope to modulate your param-
eters. If you choose One-shot mode, only the AHD envelope (pictured) will be available for
modulation.

Envelope Controls Description

Attack The time it takes for the envelope to reach its maximum level.

Hold How long the envelope will stay at its maximum level.

Decay With Decay you adjust how fast the envelope drops to the sustain level in ADSR
mode; in AHD mode it is used to adjust how fast the envelope fades out.

Sustain The envelope level that will be maintained as long as the note is played.

Release The time for the sustain level to return to zero after the note has ended.

DESTINATION

This is where you define modulation targets for the modulation envelope, i.e. the parameters
you want this envelope to control. The knobs adjust the amount of modulation for the following
targets:

Parameter Modulation Destination

Pitch Tune parameter of the PITCH / GATE section on the Pitch / Envelope page (page
2).

Cutoff Cutoff parameter of the FILTER section (with filter types LP2, HP2, BP2 only)
on the FX/ Filter page (page 3).

Drive Drive parameter of the FX section on the FX / Filter page (page 3).

Pan Pan parameter on the Audio page of the Sound’s Output properties (see 18.1.2,

Configuring the Main Output of Sounds and Groups for more information).
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6.2.5 Page 5:LF0

Voice Settings / Engine Pitch / Envelopa FX / Filter Modulation Valocity /

LFO DESTINATION

Pitch Cutoff

Sampler parameters — page 5 of 6: LFO and DESTINATION in the software.

LFO

The LFO (Low Frequency Oscillator) is another modulation source based on waveforms with
different shapes.

LFO Controls Description

Type Here you can choose the shape of the LFO waveform. Available shapes are Sine,
Tri (Triangle), Rect (Rectangle), Saw, and Random.

Speed Controls the rate of the LFO measured in hertz (Hz). If you choose to synchronize
the Speed by activating Sync, it will show note values instead of hertz.

Phase Defines the initial phase of the LFO waveform, from -0.50 to 0.50.

Sync The Sync selector is used to synchronize the LFO with the tempo of your Project.

If Free is selected, the LFO rate is independent of the Project tempo. If Retrig or
Lock is enabled, the values of the Speed parameter will change into note values
ranging from 16/1 (= one modulation cycle in 16 bars) to 1/32 (one cycle in
1/32nd note) and be synced with the Project tempo. While Retrig restarts the
LFO at each new note (each note has another LFO phase), Lock keeps the LFO
phase synchronized to the song position for all notes.

DESTINATION

This is where you define modulation targets for the LFO, i.e. the parameters you want this LFO
to control. The knobs adjust the amount of modulation for the following targets:
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Parameter Modulation Destination

Pitch Tune parameter of the PITCH / GATE section on the Pitch / Envelope page (page
2).

Cutoff Cutoff parameter of the FILTER section (with filter types LP2, HP2, BP2 only)
on the FX/ Filter page (page 3).

Drive Drive parameter of the FX section on the FX / Filter page (page 3).

Pan Pan parameter on the Audio page of the Sound’s Output properties (see 18.1.2,

Configuring the Main Output of Sounds and Groups for more information).

6.2.6  Page 6: Velocity / Modwheel

MASTER | [ GROUF | IETITT] PLUG-IH J 1. SAHPLER Ir
3 INFLUX .O0FT & 5L 150.00 1301
VELOCITY DESTIHATION MODWHEEL DESTIHNATION

START DECAY CGUTOFF VOLUME START CUTOFF LFO DEPTH
0.0 % 0.0 % 0.0 % 100.0 % 0.0 % 0.0 % .|

Sampler parameters — page 6 of 6: VELOCITY DESTINATION and MODWHEEL DESTINATION on the controller.

Volce Settings / Engine Pitch / Envelope FX / Filter Maodulation LFO Velocity / Modwheel

VELOCITY DESTINATION MODWHEEL DESTINATION

) |

Cutoff Volume Cutoff LFO Depth

Sampler parameters — page 6 of 6: VELOCITY DESTINATION and MODWHEEL DESTINATION in the software.

VELOCITY DESTINATION

This section allows you to use the input velocity in order to modulate various parameters.
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Parameter Modulation Destination

Start Start parameter of the PITCH / GATE section on the Pitch / Envelope page (page
2). Positive values shift the Sample start position later in time as you play hard-
er, negative values shift it closer to the beginning of the Sample as you play
harder.

Tip: a typical example for this parameter is setting it so that the initial attack
transient of a snare drum is heard only at high velocity values. This makes it
sound “snappier” when you play hard, and “muffled” or muted when you play

softly.

Decay Decay parameter of the AMPLITUDE ENVELOPE section on the Pitch / Envelope
page (page 2).

Cutoff Cutoff parameter of the FILTER section (with filter types LP2, HP2, BP2 only)
on the FX / Filter page (page 3).

Volume This allows you to modulate the volume, which is what velocity normally is used
for.

MODWHEEL DESTINATION

Here you can determine how incoming MIDI data sent by the Modulation Wheel affects various
parameters.

Parameter Modulation Destination

Start Start parameter of the PITCH / GATE section on the Pitch / Envelope page (page
2).

Cutoff Cutoff parameter of the FILTER section (with filter types LP2, HP2, BPZ2 only)
on the FX / Filter page (page 3).

LFO Depth Use this knob to adjust how much the Modulation Wheel affects the depth of the

LFO modulation (for all targets) defined on the LFO page (page 5).

Pan Pan parameter on the Audio page of the Sound’s Output properties (see 18.1.2,
Configuring the Main Output of Sounds and Groups for more information).
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6.3  Using Native Instruments and External Plug-ins

MASCHINE allows you to load VST/AU plug-ins from Native Instruments (Native Instruments
Plug-ins) or any third-party manufacturer (External Plug-ins) and to use them like the MA-
SCHINE Internal Plug-ins.

As with Internal Plug-ins, the following rules apply for loading Native Instruments and External
Plug-ins:

= An Instrument Plug-in can be loaded only in the first Plug-in slot of a Sound.

= An Effect Plug-in can be loaded in any Plug-in slot of any Sound, any Group, or of the
Master.

The following sections describe additional features and tasks specific to Native Instruments
and/or External Plug-ins compared to Internal Plug-ins. For all other tasks (e.g., loading, ad-
justing Plug-in parameters, etc.), please refer to section 16.1, Plug-in Overview.

6.3.1  Opening/Closing Plug-in Windows

When you load a Native Instruments or External Plug-in into a Plug-in slot, you can open a
floating window containing the user interface of that Native Instruments or third-party instru-
ment/effect.

Plug-ins of Native Instruments platform products (REAKTOR, KONTAKT, GUITAR RIG) are
automatically opened in floating windows when loaded from the Plug-in menu. All other
Native Instruments Plug-ins as well as all External Plug-ins won’t be opened in floating
windows by default — however they will recall their last state: If such a Plug-in has previ-
ously been opened in its floating window, when you load a new instance of the same Plug-
in it will also open in a floating window.
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© MASCHINE > e
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All Sounds
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MASCHINE showing the user interfaces of a few Native Instruments Plug-ins (MONARK, PASSIVE EQ, GUITAR RIG, and
FM8).

When a Native Instruments or External Plug-in has been loaded into a Plug-in slot, a little di-
agonal arrow appears left of the Parameter pages’ tabs, at the top of the Control area:

SOUND Filtar /

Noise O..0f Drums © | FiTER, FH

lu Maonark

m Guit

Cutoff

The little diagonal arrow next to the Parameter pages’ tabs.

» To open or close the floating window of a Native Instruments or External Plug-in, select
this Plug-in and click the little diagonal arrow at the left of the Parameter pages’ tabs (at
the top of the Control area). You can also double-click the Plug-in name in the list.

MASCHINE - Manual - 227



Working with Plug-ins

Using Native Instruments and External Plug-ins

You can also close any floating window via the common button provided by your operating
system at the top left or right corner of the window.

MASCHINE will always show the open floating windows of the focused Sound, Group or Master
when selected. When you set the focus to another Sound, Group or the Master, all open float-
ing windows disappear, possibly replaced by those for Native Instruments and/or External Plug-
ins loaded in the newly focused Sound/Group/Master.

Plug-in selection is described in section 12.3.3, Navigating Channel Properties, Plug-ins,
and Parameter Pages in the Control Area.

Native Instruments Plug-ins: Default, Additional, and Edit View
Native Instruments Plug-ins provide the following extra features in the floating window:

= Plug-in Header: This is the same as in the Plug-in’s panel in the Plug-in Strip (software in
Mix view), with an additional Edit button described below. For more information, please
refer to section 19.4.4, Custom Panels for Native Instruments Plug-ins.

= Default view and Additional view: Each Native Instruments Plug-in can provide one or two
custom views including reduced sets of controls. The Default view is available for every
Native Instruments Plug-in, while the Additional view is available for specific Native In-
struments Plug-ins only. If a Native Instruments Plug-in provides an Additional view, you
can switch between Default and Additional view by clicking the “+” button in the Plug-in
Header:

PRIS

These views are also available in the Plug-in’s panel in the Plug-in Strip (Mix view in the
software). For more information, please refer to section 19.4.4, Custom Panels for Native
Instruments Plug-ins.
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= Edit view: The Edit view shows the full user interface of the original Native Instruments
product. You can show/hide the Edit view by clicking the Edit button (showing a pencil
icon) in the Plug-in Header:

6.3.1.1  Opening/Closing Plug-in Windows on the MASCHINE Controller

On the MASCHINE controller, to open/close a floating window for a Native Instruments or Ex-
ternal Plug-in do the following:

1. Select the desired Native Instruments or External Plug-in (see section 12.3.3, Navigating
Channel Properties, Plug-ins, and Parameter Pages in the Control Area).

2. Press the lit Button 6 (PLUG-IN) to open the Plug-in’s user interface in a separate floating
window. Press Button 6 again to close the floating window.

6.3.2  Using the VST/AU Plug-in Parameters

The parameters of Native Instruments and External Plug-ins offer various ways to shape each
instrument/effect individually. Of course, you can adjust these parameters using the Plug-in’s
own user interface (see section 16.3.1, Opening/Closing Plug-in Windows above). But MA-
SCHINE also allows quick and convenient access to the parameters of any Native Instruments
or External Plug-in: upon loading these parameters are auto-mapped and organized into Param-
eter pages that will appear both in the software’s Control area and on your controller in Control
mode — exactly like Internal Plug-ins.

Having the Plug-in parameters on Parameter pages in MASCHINE has the following benefits:

= You can step through the Parameter pages and tweak each parameter on your controller
via the usual workflow directly after loading the Native Instruments or External Plug-in
(see section 12.3.3, Navigating Channel Properties, Plug-ins, and Parameter Pages in the
Control Area).

= The Plug-in parameters can be automated the same way as any other parameters (see sec-
tion 17.5, Recording and Editing Modulation).
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= The current state of the Plug-in parameters can be saved to the Browser as a preset for
total recall of the Plug-in (see section 16.1.9, Saving and Recalling Plug-in Presets for
more on this).

Page 1 Page 2 Page 3 Page 4 Page 5 Page 6 Page 7 Page 8 Page 9

*

NOISE-COL

An auto-mapped Parameter page of the Massive Plug-in in the software.

CHAHHEL PLUG-IH [} 1. MASSIVE

10, SOUMD 10 1s0.00 13:1:1

3-16
OSC2-AMF OSC2-FLT. O5C3-FITC O5CZ-FOSI OSC3-FARA OSC3-AMF OSC3-FLT. HOISE-COL
0.00 0.50 0.50 0.00 1.00 0.00 0.50 0.00

An auto-mapped Parameter page of the MASSIVE Plug-in on the controller.

Furthermore, for Native Instruments Plug-ins these Parameter pages group the Plug-in parame-
ters in an intelligent way that fits the particular workflows of each Plug-in. For example in the
MASSIVE Plug-in, the eight Macro Controls of MASSIVE will be grouped into a single Parame-
ter page, the main parameters for Oscillator 1 will be grouped into another Parameter page,
etc.

6.3.3  Setting Up Your Own Parameter Pages

As with any Plug-in, the parameters of a Native Instruments or External Plug-in are organized
into pages. Each Plug-in can have any number of pages, each containing 8 knobs, which can
be assigned to the parameters of the VST/AU instrument or effect.

Parameter pages may be assigned automatically using auto-mapping (see section 16.3.2, Using
the VST/AU Plug-in Parameters above) or created individually via Learn mode. With Learn
mode, you can create custom pages containing only the desired parameters arranged to fit your
personal workflow. Moreover, you can create sections of parameters within each custom Pa-
rameter page, and define custom labels for parameters, sections, and entire Parameter pages.
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/i Note that parameters of Native Instruments and External Plug-ins are systematically as-
A28 signed to knobs (not to switches nor selectors) in MASCHINE — this is also true in the MA-
SCHINE software.

A parameter of a Native Instruments or External Plug-in can be assigned to one knob only!

To begin assigning parameters, do the following:

1.
2.

3.

Select the Plug-in for which you want to customize parameter assignments.

Click the down-pointing arrow in the bottom left corner of the Control area to reveal the
Assignment area underneath:
SOUND A Page 1 Page 2 Page 3 Page 4 Page 5

[ S

Passive EQ

4L
~ ’ ~ ’

High Mid HM1 Gain HM1 G.Mod  HM1 BW.Mo

Automation

Pages

Click the Pages tab in the left part of the Assignment area:

&
Passive EQ

4L

Automation

— The Pages tab lights up and the Pages pane appears on its right. You are now ready to

assign parameters to the Parameter pages.
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The Pages tab can be clicked only for Native Instruments or External Plug-ins and for the

A28 Macro properties. For all other Plug-ins and Channel properties, parameters and Parameter
pages are not editable, and the Pages tab is grayed out and inactive. For more information
on the Macro properties and defining Macro Controls, please refer to 18.3, Creating Custom
Sets of Parameters with the Macro Controls.

When the Pages pane of the Assignment area is open, you also notice a few changes in the
Control area above:

SOUND age 1 x Page 2 x HIGH-MID BAND = Page 4 x
{ 5

Passive EQ

4

High Mid HM1 Gain HM1 G.Mod  HM1 BW.Mo

Automation

HMT Gain

The Control area with the Pages pane active in the Assignment area underneath.

(1) Delete Page button (“x” symbol): Click the little “x” after a page name to delete this Parame-
ter page.

(2) Add Page button (“+” symbol): Click the little “+" after the last page label to append a new
page. By default, pages are labeled “Page 1,” “Page 2,” etc. You can change page labels by
defining sections within your pages via the Section Label fields (3) — see below.

(3) Section Label fields: These fields allow you to define sections of parameters within the dis-
played page. Double-click the field above the first parameter you want to include in the sec-
tion, type the desired name for the section, and press [Enter] to confirm. The new section will
include all following parameters until the next section starts (this can be seen only after you
have closed the Assignment area). Moreover, the Parameter page will mirror the label(s) of its
section(s) — if there is more than one section, the page label will mirror all of them, separated
by slashes.

(4) Focus frame: Indicates the knob being assigned. Click any knob to edit its assignment.
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(5) Parameter Label fields: Double-click these fields to enter custom labels for your parameters
(press [Enter] to confirm). These labels will be mirrored everywhere in MASCHINE for the cor-
responding parameters.

(6) Reset button: Click Reset to remove the assignment for the selected knob.

(7) Learn button: Click Learn to enter Learn mode. Learn mode is an intuitive learn process that
allows you to quickly assign the desired Plug-in parameters to all eight knobs of the current
Parameter page at once. When Learn mode is launched, each knob of the page is successively
focused starting with the knob selected for editing — indicated by the Focus frame (4). The
next parameter you touch in the plug-in’s user interface (see section 16.3.1, Opening/Closing
Plug-in Windows) will be assigned to the focused knob. Once a knob is assigned, the next knob
to the right will become the focal point, and so on until the last knob is assigned. Once com-
plete, Learn mode is automatically deactivated. Alternatively, at any time you can click Learn
again if you want to stop assigning parameters. When Learn mode is active, you can manually
change the focus of the knobs by clicking the desired knob in the Parameter area.

Once you have organized plug-in parameters into Parameter pages, you can also use MA-
SCHINE Macro Controls to pick the most commonly used parameters, e.g., for live perform-
ances. For more information about Macro Controls, please refer to section 18.3, Creating
Custom Sets of Parameters with the Macro Controls.

6.3.4  Using VST/AU Plug-in Presets

For some of your Native Instruments or third-party VST/AU plug-ins, you might already have a
set of factory or user presets (or patches, programs, etc.) that you like to use. MASCHINE lets
you directly load these presets and save them as Plug-in presets within MASCHINE. Saving
your VST/AU presets as Plug-in presets within MASCHINE will notably allow you to access
them from the MASCHINE Browser, in the software as well as from your controller!

Saving presets can be done in the MASCHINE software only.

Accessing Factory Presets of Native Instruments’ Instruments/Effects

Accessing factory presets of your Native Instruments instruments and effects is straightfor-
ward: factory presets of all Native Instruments instruments/effects installed on your computer
are already integrated into the MASCHINE library! You will find them directly in the Browser by
selecting the corresponding file type (Instruments or Effects) in the File Type selector, then se-
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lecting the factory content by clicking the NI logo on the right, then choosing the desired NI
product in the drop-down list underneath — and of course, you will find all these presets in
the same locations in the Browser on your controller.

You can also add to the MASCHINE library the user presets you might have created for any
Native Instruments product installed on your computer. To do this, simply add the corre-
sponding path(s) to the list found on the User pane of the Library page in the Preferences
panel. See section 12.5.2, Preferences — Default Page for more details.

Accessing Other VST/AU Presets

To access user presets of your Native Instruments instruments/effects as well as both factory
and user presets of your third-party VST/AU plug-ins, you first need to load the corresponding
Native Instruments or External Plug-in into a Plug-in slot.

1. Load the desired Native Instruments or External Plug-in into a Plug-in slot (see section
16.1.3, Loading, Removing, and Replacing a Plug-in).

2. Open the Plug-in menu by clicking the little arrow at the right of the Plug-in slot.
The Plug-in menu now contains an additional Presets submenu located under the Native
Instruments and External submenus:

Presets I} 3 INIT - Passive EQ
Nona | Mastering Pop
Native Instruments  » | Mastering Rock
External , | Mastering Bright Pop
Sampler Mix Polish
Drumsynth 3 Vocal

1 Acoustic Guitar
Compressor Electric Bass
Gate Bus Mud Remover
Transient Master Racerrm

This submenu provides the list of all presets that your VST/AU plug-in has made available
to the host — MASCHINE in this case.

3. Select the desired preset in this submenu.
— The preset is loaded into the Plug-in.

Each VST/AU instrument or effect might handle its presets (or patches, programs...) different-
ly. Please refer to the plug-in documentation to find out how to reveal its presets (or a particu-
lar set of presets) to the host.
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For example, in MASSIVE, ABSYNTH 5, and FM8, you need to enable the Program List
and fill it up with the desired patches in order to expose these and see them appear in the
Presets submenu of the Plug-in menus in MASCHINE.

Some VST/AU plug-ins can run both as instrument and effect plug-ins. When loading a pre-
set for such a plug-in, check that the preset can be effectively loaded in the current Plug-in
slot — in particular, take care to load presets for instruments in the first Plug-in slot of
Sounds only! To avoid any mistake, one solution is to name your VST/AU presets explicitly
(e.g., by adding a suffix “[FX]” to the effect presets).

MASCHINE allows you also to change the preset in your Native Instruments or third-party VST/
AU plug-in via MIDI Program Change messages. For more information, see section 18.2.2,
Controlling Parameters via MIDI and Host Automation.

Saving VST/AU Presets as MASCHINE Plug-in Presets

Once you have loaded a VST/AU preset (user preset of a Native Instruments instrument/effect
or any preset of a third-party VST/AU instrument or effect) using the method described above,
you can save it as a Plug-in preset in MASCHINE via the Save As... or Save As Default... com-
mands of the Plug-in menu (see section 16.1.9, Saving and Recalling Plug-in Presets). Once
this is done, your preset will be available as a user preset in the Instrument or Effect category
of the MASCHINE Browser.

6.3.9  Multiple-Output Plug-ins and Multitimbral Plug-ins

MASCHINE allows an extended use of multiple-output Plug-ins as well as multitimbral Plug-
ins.

Multiple-Output Plug-ins

Multiple-output Plug-ins are Plug-ins with more than one audio stereo output.

When a multiple-output Plug-in is loaded into a Sound, MASCHINE uses its available outputs
as follows:

= The Plug-in’s first output pair is inserted in the usual Plug-in signal chain: This output
pair is fed into the input of the next Plug-in slot (or sent to the channel output if the Plug-
in is in the last Plug-in slot).

MASCHINE - Manual - 235



Working with Plug-ins

Using Native Instruments and External Plug-ins

= The Plug-in’s additional outputs are made available as audio sources for other Sounds of
the same Group (they appear in the Source menu in the Audio page of the Input proper-
ties for these Sounds). This can be used to build advanced routings in MASCHINE. For
more information on configuring audio inputs for Sounds, please refer to section 18.1.1,
Sending External Audio to Sounds.

Multitimbral Plug-ins
Multitimbral Plug-ins are Plug-ins that can receive MIDI on top of the host control.

When a multitimbral Plug-in is loaded into a Sound, the other Sounds of the same Group can
send MIDI data to this Plug-in: The Plug-in will appear as additional port in the Dest. menu on
the MIDI page of the Output properties for these Sounds. For more information on configuring
MIDI output for Sounds, please refer to section 18.2.4, Sending MIDI from Sounds.

MASCHINE - Manual - 236



Working with Patterns

Pattern Basics

1 Working with Patterns

Creating a Pattern is where the fun starts, because the sequencer really is the core of MA-
SCHINE. Both your controller and the software provide you with many powerful tools to create
and edit your own beats.

This chapter is organized as follows:
= General points on Patterns and the Pattern Editor: 17.1, Pattern Basics.

= How to record Patterns in real time from your controller: 17.2, Recording Patterns in Real
Time.

= How to record Patterns with the step sequencer of your controller: 17.3, Recording Pat-
terns with the Step Sequencer.

= How to create and modify events/notes in your Patterns: 17.4, Editing Events.

= How to create and modify modulation in your Patterns: 17.5, Recording and Editing Mod-
ulation.

= How to create MIDI tracks in your Patterns: 17.6, Creating MIDI Tracks from Scratch in
MASCHINE.

= How to organize your Patterns in your Project: 17.7, Managing Patterns.

= How to import/export MIDI to/from Patterns, and how to export audio from Patterns: 17.8,
Importing/Exporting Audio and MIDI to/from Patterns.

1.1 Pattern Basics

A Pattern contains the events (also called “notes”) that make up a groove or a musical phrase
using the Sounds of the selected Group. It also contains the modulation data (if any) modifying
the value of parameters in that Group or any of its Sounds. The Pattern belongs to that Group
and is saved together with the Group. In each Group you can have an unlimited number of Pat-
terns. Patterns are grouped into Pattern banks containing up to 16 Patterns each.
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In every Scene of your Project you can choose for each Group which of its Patterns has to
be played. In each Scene the Pattern you have chosen will be referenced by a Clip (more
on this in chapter 112.6.3, Saturator).

1.1.1  Pattern Editor Overview
The Pattern Editor is the all-in-one Pattern editing tool of the MASCHINE software.

This overview of the Pattern Editor introduces you its main parts and control elements.

ise..f Drums

The Pattern Editor (Group view depicted).

(1) Group View button: Click this button to switch to Group view. See section 17.1.5, Group
View and Keyboard View.

(2) Keyboard View hutton: Click this button to switch to Keyboard view. See section 17.1.5,
Group View and Keyboard View.

(3) Sample Editor button: Click this button to switch between the Pattern Editor and the Sample
Editor. The Sample Editor is covered in chapter 112, Effect Reference.
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(4) Sound List: Sound slots 1-16 of the selected Group are listed here. In Keyboard view (2),
click a Sound slot to display its events in the Event area (7).

(5) Pad View button: Click this button to switch between the Sound List (4) and the Pad view.
The Pad view is an alternate representation of your Sound slots that focuses on the pads of
your controller. In Pad view you can adjust how the Sounds should be triggered by your pads.
See section 15.1.1, The Pad View.

(6) Pattern Manager hutton: Opens/closes the Pattern Manager. The Pattern Manager gives you
access to various management commands for your Patterns. Notably, it allows you to select the
Pattern you want to edit in the Pattern Editor and use in the current Scene of the Arranger. It
also provides various Pattern management commands (see section 17.7.1, The Pattern Manag-
er and Pattern Mode).

(7) Event area: Displays the content of the selected Pattern. Here you can see your recorded
events as rectangular blocks. In Group view (1) these represent the Sounds of your Group. In
Keyboard view (2) they represent musical notes of the selected Sound. The length of each rec-
tangular block represents the duration of the event, and its transparency indicates the event
velocity (the softer the hit, the more transparent the event). You can edit events using your
mouse; you can drag them to a new position, elongate/shorten them, create and delete them
using various Edit modes (13). The Event area also displays the Step Grid divisions, a set of
regularly spaced vertical lines defining the resolution of your edits. You can make all your edits
snap to the desired Step Grid via the Step Grid settings (14).

(8) Pattern timeline: The timeline at the top of the Event area (7) displays musical time units,
including bars and beats. Click anywhere in the timeline to move the playhead to that position
(see section 17.1.4, Jumping to Another Playback Position in the Pattern). Drag the white Pat-
tern Length marker horizontally to adjust the Pattern Length (this can also be done via the Pat-
tern Length controls (9), see section 17.1.6, Adjusting the Pattern Grid and the Pattern
Length).

(9) Pattern Length controls: The Pattern Length controls allow you to choose the increment by
which the length of the Pattern can be adjusted, and to adjust the length of the displayed Pat-
tern according to that increment. See section 17.1.6, Adjusting the Pattern Grid and the Pat-
tern Length.

(10) MIDI and Audio Dragger: The MIDI Dragger and the Audio Dragger allow you to conveniently
drag and drop MIDI or audio from your Patterns to your desktop or host software, respectively.
See section 17.8.1, Exporting Audio from Patterns and 17.8.2, Exporting MIDI from Patterns
for more information.
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(11) Control Lane: The Control Lane provides a visual overview and editing tools for the modula-
tion and the MIDI/host automation of each parameter. See section 17.5, Recording and Editing
Modulation and 18.2, Using MIDI Control and Host Automation for more information.

(12) Horizontal zooming scroll bar: Click the main part of the scroll bar and drag your mouse
horizontally to scroll through the Event area on the horizontal axis (time), or drag it vertically to
zoom in/out on this time axis. You can also click the left or right handle of the scroll bar and
drag it horizontally to zoom in/out while keeping the opposite border of the display at a fixed
position in the Pattern. Double-click the main part of the bar to reset the zoom and display the
entire Pattern. In Keyboard view (2) you will find a vertical zooming scroll bar with similar func-
tionality at the right of the Pattern Editor. See section 17.1.2, Navigating the Event Area for
more information.

(13) Edit Mode selector: The Edit Mode selector lets you choose from three different modes
when editing the content of the Pattern: Select, Paint, and Erase mode. See 17.4.1, Editing
Events with the Mouse: an Overview for more information.

(14) Step Grid settings: Use the Step Grid button to enable/disable the Step Grid, and the Step
Size menu to change the Step Grid resolution. See section 17.1.7, Adjusting the Step Grid and
the Nudge Grid for more information.

(15) Control Lane button: Click the Control Lane button to show/hide the Control Lane (11).

1.1.1.1  Patterns on Your Controller
Your controller provides various modes to work on your Patterns:

= The Pattern mode allows you to select and manage your Patterns: 17.7, Managing Pat-
terns.

= The Control mode (default mode of your controller) allows you to record Patterns in real
time using various recording modes: 17.2, Recording Patterns in Real Time.

= The Step mode allows you to record Patterns in the step sequencer: 17.3, Recording Pat-
terns with the Step Sequencer.

= The Select mode allows you to select and edit the desired events: 17.4.3, Selecting
Events/Notes and 17.4.4, Editing Selected Events/Notes.

= The Grid mode lets you adjust the Step Grid: 17.1.7, Adjusting the Step Grid and the
Nudge Grid.
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1.1.2  Navigating the Event Area

The Event area in the Pattern Editor can be scrolled and zoomed in or out to fit your current
needs.

Navigating the Pattern Editor Horizontally (Time)

A zooming scroll bar is available at the bottom of the Pattern Editor. This tool allows you to
both scroll and zoom in/out horizontally in the Event area and the Control Lane on the time
axis:

The zooming scroll bar at the bottom of the Pattern Editor.

Use the horizontal zooming scroll bar as follows:
= Click the main part (1) of the scroll bar and hold the mouse button, then:

o Drag your mouse horizontally to scroll through the Event area on the time axis (com-
mon scroll bar behavior).

o Drag your mouse vertically to zoom in or out of the Event area on the time axis. The
center of the zoom operation will be exactly where you placed your mouse cursor when
you clicked.

= Click the left handle (2) of the scroll bar, hold the mouse button, and drag your mouse
horizontally to zoom in or out of the Event area while keeping the right border of the dis-
play at a fix positioned in the Pattern.

= Similarly, click the right handle (3) of the scroll bar, hold the mouse button, and drag your
mouse horizontally to zoom in or out of the Event area while keeping the left border of the
display at a fixed position in the Pattern.
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= Double-click the main part (1) to reset the zoom and display the entire Pattern.

The Event area and the Control Lane (if visible) always stay in sync on the time axis. See
section 17.5.3, Creating and Editing Modulation in the Control Lane for more information
on the Control Lane.

Navigating the Pattern Editor Vertically (Sounds or Pitches)

When the Pattern Editor is in Group view, a classic scroll bar is available right of the Pattern
Editor. It allows you to scroll to hidden Sound slots in case all of them don’t fit in the Pattern
Editor.

When the Pattern Editor is in Keyboard view, a vertical zooming scroll bar is available on the
right of the Pattern Editor allowing you to both scroll and zoom in/out vertically on the pitch
axis. It works in the same way as the horizontal bar described above.

For more information on the Group and Keyboard view, see section 17.1.5, Group View and
Keyboard View.

You can also adjust the height of the Pattern Editor in order to display more/less Sound slots at
once by resizing the Arranger above — see section 113.1.2, Navigating the Arranger.

1.1.2.1 Navigating the Event Area from the MASCHINE Controller
You can also control the position and zoom factor in the Event area from your controller:

1.  From Control mode, press and hold to enter Navigate mode.
1. MASSIVE I¥] [ PLUG-IH TN 0L ] 4 i
& SCRATCHY is50.00 1390 |MAS EHV3]| [MAS EHY4]| [ MAS..1/2 | [ MAS..3/4 |
S S
ZOOM Ol ZO0M SCROLL |MAS 0SC1] [MAS OSCZ]| [MAS O5C3 | [MAS..0ISE |
14% . 16.8 ¥ 0.0 % | MAS MCS |
2. Turn Knob 3 ( ) to zoom in or out of the Edit area.
3. Turn Knob 4 ( ) to scroll through the Edit area.

1.1.3  Following the Playback Position in the Pattern

If the Event area doesn’t display the entire Loop Range selected, at some point the playhead
will go beyond the portion of the Pattern currently displayed and you might loose sight of the
playback position. To prevent this, you can force the Event area to follow the playhead:
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Activate the Follow button to keep following the playhead in the Event area.

» To follow the playhead position in the Event area during playback, click the Follow button
in the MASCHINE Header.

— The Follow button lights up in the MASCHINE Header. The Event area will now switch to
the next Pattern portion (with the same zoom factor) as soon as the playhead reaches the
end of the portion currently displayed. This way, you always see the Pattern portion that
is being played.

The Follow function will be automatically disabled as soon as you manually scroll in the Ar-
ranger or the Pattern area (in the software or from your controller).

The Follow function affects both the Pattern Editor and the Arranger simultaneously (see sec-
tion 113.1.3, Following the Playback Position in Your Project for more information on the Fol-
low function in the Arranger).

1.1.3.1  Following the Playback Position on the MASCHINE Controller
To follow the playhead position in the Event area during playback:

1. Press and hold to enter Scene mode.

2. Press Button 2 (ARRANGE) to enter Arrange submode (Button 2 is lit and the ARRANGE label
underneath is highlighted).

3. Press Button 3 (FOLLOW) to enable it.

—  Both Button 3 and the FOLLOW label underneath light up. In the software the Event area
will now switch to the next Pattern portion (with the same zoom factor) as soon as the
playhead reaches the end of the portion currently displayed. This way, you always see the
Pattern portion that is being played. You can release to leave Scene mode: the
Follow function will stay active.

The Event area will stop following the playhead as soon as you manually scroll or zoom to
another portion of the Pattern.

The Follow function simultaneously affects various displays in the software and on your con-
troller:

MASCHINE - Manual - 243



Working with Patterns

Pattern Basics

= In the software the Follow function affects both the Pattern Editor and the Arranger.

= On your controller the Follow function affects the displays in Scene mode when Arrange
submode is enabled. Additionally, in Step mode the Follow function affects the pads:
With Follow enabled, when the playhead has gone across all 16 steps shown by the pads
on your controller, the pads switch to the next 16 steps of the Pattern, if any. See section
17.4.2, Creating Events/Notes for more information on Step mode.

If the playback position is outside any Clip referencing the Pattern currently displayed, the
Event area will not follow the playhead, even if the Follow function is active. As soon as the
playhead enters any Clip referencing the selected Pattern, the playhead will appear in the
Pattern displayed in the Event area, and the Event area will follow the playhead.

1.1.4  Jumping to Another Playback Position in the Pattern

You can use the timeline above the Event area to set the playback to the desired position. For
example, this can be useful to check a particular transition between events in your Pattern
without waiting for the whole Loop Range to be looped.

In the timeline above the Event area, a playhead (the little white vertical line) indicates the
current play position in the Pattern.

Basics - Return
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The playhead in the timeline shows you the current play position.
At any time you can jump to another position in the Pattern:

» Click anywhere in the timeline of the Event area to move the playhead to that position in
the Pattern.
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Moving the playhead to another position in the timeline of the Pattern Editor automatically
moves it to the corresponding position in the Arranger. However, using the timeline of the
Pattern Editor you cannot jump outside the Pattern currently displayed. To do this, use the
timeline of the Arranger (see 113.1.4, Jumping to Another Playback Position in Your
Project) or use your controller (see below).

Depending on the playback state, the following will happen:

= |f playback is off, the playhead jumps to the closest step before your mouse cursor, ac-
cording to the current Step Grid settings. If the Step Grid is disabled, the playhead jumps
to the exact position you have clicked.

For more information on the Step Grid, see section 17.1.7, Adjusting the Step Grid and the
Nudge Grid.

= |If playback is on, the playhead jumps to the closest position near your mouse cursor that
retains the current playhead position relative to the Pattern Grid division. This allows
seamless jumps that don’t break the rhythm of your music. If the Pattern Grid is set to Off
(i.e. disabled) or Quick, the playhead position is retained relative to the current bar.

For more information on the Pattern Grid, see section 17.1.6, Adjusting the Pattern Grid
and the Pattern Length.

Example with playback on: Assuming that your Pattern is four bars long and the Pattern Grid
resolution is set to one bar, if you click around the 1.4 mark (4th beat of the 1st bar) in the
timeline when the playhead reaches the 3.3 mark (3rd beat of the 3rd bar), the playhead will
jump from the 3.3 to the 1.3 mark (3rd beat of the 1st bar) and continue from there.

1.1.4.1  Controlling the Playback Position in the Pattern on Your Controller

You can also control the playback position from your controller via the Locate buttons as de-
scribed in section 113.1.4, Jumping to Another Playback Position in Your Project. As a re-
minder:

» Press the Locate buttons (showing left/right arrows) in the section to jump
to the previous/next Pattern Grid division. Hold while pressing the Locate buttons
to jump to the previous/next step instead.

If playback is on, the jumps retain the playhead position relative to the grid resolution (Pattern
Grid without , Step Grid with ).
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Using your controller, you can jump outside the current Pattern. For more details, please
see section 113.1.4, Jumping to Another Playback Position in Your Project.

1.1.5  Group View and Keyhoard View

The Pattern Editor allows you to edit the events for all 16 Sound slots of the selected Group:
this is called the Group view.

» Click the Group View button (showing little rows) on the left of the Pattern Editor to
switch it to Group view:
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In Group view, the Pattern Editor shows the events for all Sounds in the Group.

This view is well suited for rhythmic instruments (e.g., a drum kit), since you can see and edit
the events for all Sounds at once, without worrying about the pitch of the events you create or
edit.

The Keyboard View

Alternatively, you can switch the Pattern Editor to Keyhoard view:
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» Click the Keyboard View button (showing a little keyboard) on the left of the Pattern Edi-
tor to switch it to Keyboard view:

— The Event area now only shows notes for the selected Sound. By adding or editing notes,
you can choose their pitch in semitones depending on where you place them on the verti-
cal axis, the lowest note being the lowest row.

Loop] ARRNNN AN NANRRR RN RN RNRRRREND
ﬂ-llll IRRERRRNEENERR AR EENENDNN L RULIUTINRRU TN

L JURINIL] (ULINIRUTY]
In Keyboard view, the Pattern Editor shows all notes for a particular Sound.

If you select another Sound slot in the Sound List on the left, the whole Event area will switch
to the notes for that Sound.

On the left of the Event area, a vertical piano roll indicates the note corresponding to each row
in the Event area. Octaves are indicated by a number on each C key: e.g., the middle C, which
is noted C3 in the MASCHINE convention, will read “3.” Click any note on the piano roll to
trigger the selected Sound at that particular pitch.

This view is well suited for melodic instruments (e.g., a piano), since you can focus on a par-
ticular Sound, and edit notes at every pitch.
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1.1.5.1  Switching Between Group and Keyboard View from Your Controller

The Group/Keyboard view in the software is always in sync with the Group/Keyboard mode of
the pads on your controller: Switching between Group and Keyboard view in the software will
automatically switch between Group mode and Keyboard mode on your controller (and inverse-

ly).

As a consequence, to switch the Pattern Editor between Group and Keyboard view, you simply
need to switch your pads between Group and Keyboard mode:

» Press + on your controller to switch the Pattern Editor between Group
and Keyboard view.

See 15.1.1, The Pad View for more details on the various pad modes available on your control-
ler.

7.1.6  Adjusting the Pattern Grid and the Pattern Length
The Pattern Grid defines regularly spaced-out timings notably used in following situations:
= Adjusting the Pattern Length (see below).

= Moving the playback position (see 17.1.4, Jumping to Another Playback Position in the
Pattern and 113.1.4, Jumping to Another Playback Position in Your Project).

= Adjusting and moving the Loop Range (see 113.3.1, Selecting a Loop Range).

Adjusting the Pattern Grid
To adjust the Pattern Grid:

1. To adjust the Pattern Grid resolution, click the value near the Grid: label in the Pattern
Length controls and select the desired setting from the menu (see above for the available
settings).

— The divisions of the Pattern Grid now have the size you have just selected.

The following Pattern Grid resolutions are available:
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= 1 Bar, 1/2 note, ..., 1/16th note: Each of these settings lets you adjust the Pattern Length
by the specified increment.

= Off: The Pattern Grid is disabled. Notably, you can freely set the Pattern Length to any
value or set the playback position to any location.

= Quick (default): With this setting, the available lengths for your Pattern are as follows: 1
bar, 2 bars, 4 bars, 8 bars, 12 bars, 16 bars, etc. (+ 4 bars each time starting from 4
bars). This handy mode allows you to quickly select from the most common Pattern
Lengths. For other uses of the Pattern Grid (adjusting the playback position and the Loop
Range), one-bar divisions are used instead.

Adjusting the Pattern Length

You can adjust the length of your Patterns to fit your needs. The Pattern Length is measured in
bars and beats, and Patterns can be up to 256 bars long. When you create a new empty Pat-
tern (see 17.7.3, Creating Patterns), the Pattern has the default length as defined in the De-
fault page of the Preferences panel (see 12.5.1, Preferences — General Page).

You can adjust the Pattern Length in two ways:
» To adjust the Pattern Length, click the Pattern Length: field and drag it up to make the

Pattern longer or drag it down to make it shorter. You can also double-click the displayed
value, enter a new value with your computer keyboard, and press [Enter] to confirm.

or

» To adjust the Pattern Length, drag the end marker of the Pattern (white arrow) in the
timeline:

With either method, the available lengths will depend on the current Pattern Grid resolution
(see above).
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Reducing the length of a Pattern might exclude the last events from the Pattern. However
these events are not deleted: They simply appear darker in the Event area and will be included
back into the Pattern next time you extend it.

Events beyond the Pattern’s end can be edited in the software. However, you cannot edit them
from the controller. See section 17.4, Editing Events for more information on editing events.

1.1.6.1 Adjusting the Pattern Grid and Pattern Length on the MASCHINE Controller

On your controller, the length of the selected Pattern, along with the Pattern Grid resolution
used to modify this length, can both be adjusted using various methods: via the Pattern mode,
the Grid mode or the Record Prepare mode. Choose the method that best fits your current
workflow.

Method 1: Using the Pattern mode

In Pattern mode you can adjust both the Pattern Length of the current Pattern and the Pattern
Grid resolution:

1. Press and hold to enter Pattern mode. You can also press + Button 1
to pin Pattern mode so you can release (see 12.3.5, Pinning a Mode on Your
Controller).

2. Turn Knob 1 (LENGTH) to adjust the Pattern Length according to the current resolution of
the Pattern Grid.

3. Turn Knob 2 (GRID) to adjust the resolution of the Pattern Grid.
Method 2: Using the Grid mode

In Grid mode you can adjust the various grids used in MASCHINE, including the Pattern Grid
resolution:

1. Press and hold to enter Grid mode. You can also press Button 1 to pin Grid mode so
you can release (see 12.3.5, Pinning a Mode on Your Controller).

2. Press Button 3 (PATTERN) to access the Pattern Grid settings.
The right display will show you which pad represents which resolution:
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3. Select a resolution by pressing the corresponding pad. Alternatively you can press But-
ton b, 6 or 8 to successively select each of the resolutions in the corresponding column.

— The selected value is highlighted on the right display and the corresponding pad turns
fully lit.

To disable the Pattern Grid, simply select the OFF value in the top right corner:
» To disable the Pattern Grid, hold , press Button 3 (PATTERN), then press pad (OFF).

You don’t need to explicitly enable the Pattern Grid on your controller: It is enabled as soon
as you select a resolution other than OFF (pad 16).

Method 3: Using the Record Prepare Mode

This extra method is very useful if you are about to start a new recording. Indeed, the Record
Prepare mode (accessed by pressing the unlit button and holding it) is tightly integrated
into the recording workflow of Control mode. For all details please refer to section 17.2.2, The
Record Prepare Mode.

1.1.7  Adjusting the Step Grid and the Nudge Grid

The Step Grid defines regularly spaced-out timings (the “steps”) at which your events/notes can
be created, moved, etc. The Step Grid resolution corresponds to the step size, which directly
affects the precision of all Pattern editing actions, including quantization (see 17.4.7, Quantiz-
ing Events/Notes section for more on quantization).
The Step Grid also affects the step sequencer on your controller: Increasing the Step Grid
resolution (i.e. decreasing the step size) will make more steps available in your Pattern for
placing events. See 17.4.2, Creating Events/Notes for more information on the step se-
quencer.

In the Pattern Editor, the Step Grid is indicated by the gray vertical lines in the Event area:
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The vertical lines represent the Step Grid in the Event area.

By default the Step Grid is active and the step size is 1/16th. However you may use another
step size or disable the Step Grid completely, as described below.

Depending on the current zoom factor and Step Grid resolution, if the vertical lines of the
Step Grid are too close to each other they will be hidden to avoid convoluting the display.

For example, this could be the case if you display 6 or 8 bars and choose a Step Grid reso-
lution of 1/64th.

Regardless of the current Step Grid resolution, the gray lines on the beats (quarter notes)
and the black lines on the bars (notes) are always visible in the Event area.

Enabling or Disabling the Step Grid

» To enable or disable the Step Grid, click the Step Grid button (showing a little grid icon)
in the bottom left corner of the Pattern Editor.

The Step Grid is enabled.

Adjusting the Step Grid

The Step Grid resolution can be adjusted via the Step Size menu, showing a value next to the
grid icon at the bottom left of the Pattern Editor:
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The Step Size menu lets you adjust the Step Grid resolution.

» To select the step size that will apply to all your editing actions, click the value next to
the grid icon at the bottom left of the Pattern Editor and choose the desired step size
from the drop-down menu. Values range from 1 Barto 1/128 and also include triplet val-
ues. The default value is 1/16th note.

The Nudge Grid

In addition to the Step Grid described above, a secondary grid specifically controls the timings
at which existing events/notes can be nudged in the Pattern: the Nudge Grid.

Nudging events means shifting them a small amount ahead or behind their current posi-
tion. See 17.4.4, Editing Selected Events/Notes for more information.

The Nudge Grid is based on the Step Grid:

= The Nudge Grid is active, only when the Step Grid is active. If the Step Grid is disabled,
nudging events will shift them at the maximum resolution of the sequencer.

= By default, the Nudge Grid resolution is half a step, meaning that events will be nudged
by half a step at a time.

= |If you set the Nudge Grid resolution to a full step, the Nudge Grid will mirror the Step
Grid and you can nudge events with the same resolution as when creating or quantizing
events.

= You can also set the Nudge Grid resolution to a smaller fraction of the Step Grid resolu-
tion. This allows you to nudge events with even finer increments.

The Nudge Grid resolution can be adjusted in the context menu of the Event area:
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» To adjust the Nudge Grid, right-click ([Ctrl]-click on Mac OS X) on the background of the
Event area, select Nudge Grid in the menu, and choose a resolution from the values avail-
able in the submenu: Step, Step/2, Step/4, Step/8, and Step/16:

Pattern 3

v Selact
Paint

Erase

Dalate

Mudge Grid 3
+ Step/2

Step/4
Step,/8 %

Step/16

The Nudge Grid is not indicated in the Event area of the Pattern Editor.

1.1.7.1  Adjusting the Step Grid and the Nudge Grid on Your Controller

You can enable/disable the Step Grid and adjust the Step Grid and Nudge Grid resolution from
your controller.

Enabling/Disabling and Adjusting the Step Grid
To change the Step Grid resolution:
1. Hold to enter Grid mode.
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2. Press Button 4 (STEP) to access the Step and Nudge Grid settings.
The right display will show you which pad represents a resolution:
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3. Select a step size by pressing the corresponding pad. Alternatively you can repeatedly
press Button 5-8 to successively select each of the resolutions in the corresponding col-
umn.

— The selected value is highlighted on the right display and the corresponding pad turns
fully lit.

To disable the Step Grid, simply select the OFF value in the top right corner:
» To disable the Step Grid, hold , press Button 4 (STEP), then press pad (OFF).

You don’t need to explicitly enable the Step Grid on your controller: It is enabled as soon as
you select a step size other than OFF (pad 16).

Adjusting the Nudge Grid
To change the Nudge Grid resolution:

1. Hold to enter Grid mode.

2. Press Button 4 (STEP) to access the Step and Nudge Grid settings.
3. Turn Knob 4 (NUDGE) to select the desired Nudge Grid resolution.
N

The new Nudge Grid resolution is directly in use — provided that the Step Grid is ena-
bled (see above).

1.2 Recording Patterns in Real Time

This section describes the various ways, features, and aids available on your controller to re-
cord Patterns as you play them in real time:

= The most common method is called overdub recording. Alternatively you can use replace
recording. Both are described in section 17.2.1, Recording Your Patterns Live.
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Right before you record a new Pattern, you can quickly enter Record Prepare mode to ad-
just a few important settings for your Pattern: 17.2.2, The Record Prepare Mode.

= At any time you can enable and customize the metronome: 17.2.3, Using the Metronome.
= You can also start the recording with a count-in: 17.2.4, Recording with Count-in.

= While recording you can let MASCHINE automatically quantize what you play on the pads:
17.2.5, Quantizing while Recording.

1.2.1  Recording Your Patterns Live

In Control mode your controller provides many tools to live record Patterns for the focused
Group.

@5, Take your time to set up the pad sensitivity and velocity scaling to your personal taste —

7 you will have even more fun playing and recording with your controller! These settings can
be found in Preferences > Hardware > Pads. See 12.5.4, Preferences — Plug-ins Page for
more information.

Overdub Mode

Overdub mode is the most usual recording mode. In this mode all pad hits are added as
events/notes, no matter if the Pattern already contains events.

Recording a Pattern: press PLAY then REC and hit some pads!

1. Press to start the sequencer.
The button lights up.
2. Press to begin recording.

The button lights up.
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Now hit the pads you want to record and listen to what happens.

Each hit will create an event in the Pattern Editor, the event length depends on how long
you hold the pad. Your pad hits keep on being added to the existing events in the Pattern,
even as the Pattern cycles.

When you’re done, press again to stop recording the pads.
The button turns off. The sequencer keeps playing until you press again.

Replace Mode

When recording in Replace mode the events of the selected Sound(s) are replaced by what you

play.

1.

Select the Sound(s) of which you want to replace events: In Group mode you can select
multiple Sounds (see section 14.1.3, Selecting Multiple Sounds or Groups); in Keyboard
mode only the focused Sound (the one played by your pads) will have its events replaced.

Press to start the sequencer.

The button lights up.

Press + to begin recording in Replace mode.
The and buttons light up.

Hit the pads you want to record.

Each hit will create an event in the Pattern Editor, the event length depends on how long
you hold the pad. Existing events for the selected Sound(s) are deleted as they are
reached by the playhead.

When you're done, press again to stop recording the pads.
The and buttons turn off. The sequencer keeps playing until you press
again.

In order to prevent you from erasing events accidentally, in following situations Replace mode
is automatically disengaged ( turns off) and the recording continues in Overdub mode:

When the playback loops (whether at the end of the Loop Range or at the end of your
Project).

When you stop the sequencer (by pressing the lit button).

When you jump to another location in the Project (see section 17.1.4, Jumping to Another
Playback Position in the Pattern).

When you switch your controller to another mode (by pressing, e.g., , ,
etc.).
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= When you set the focus to another Group.

You can also manually disengage Replace mode and switch to Overdub mode:

» While recording in Replace mode, press the lit button to disengage Replace
mode.

— The recording goes on in Overdub mode (see description above).

You can also erase events without engaging record: If you hold together with a pad
while playing (or recording), all events of that pad at the current play position are deleted
(see section 17.4.5, Deleting Events/Notes).

Where are the Events Recorded?
When you start recording the pads, the events are recorded as follows:

= |f a Pattern is already selected (i.e. loaded in the Pattern Editor), the events are recorded
in that Pattern. This is also true if the playhead of the Arranger currently is within an au-
tomatic repetition of the original Clip (see section 113.1, Arranger Basics).

= |f no Pattern is selected, engaging record (in Overdub or Replace mode) automatically
creates an empty Pattern with the default Pattern Length. The new Pattern is referenced
by a Clip placed at the beginning of the current Scene and repeated all along the Scene.

You can adjust the default Pattern Length in the Defaults page of the Preferences panel.
See section 12.5.1, Preferences — General Page for more information.

When you get ready to record, you can also use the Record Prepare mode on your controller to
quickly create a new Pattern with the desired length and directly start the recording! See sec-
tion 17.2.2, The Record Prepare Mode for more on this.

1.2.2  The Record Prepare Mode

The Record Prepare mode is very useful when you are about to start a new recording. Indeed, it
allows you to adjust the Pattern Length and the resolution of the Pattern Grid right before
starting a recording. This way you can quickly create a new Pattern with the desired pattern
length and directly start recording events in it!
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You can also use the Record Prepare mode to adjust the length of an existing Pattern.

1.2.2.1 The Record Prepare Mode on Your Controller

1. With disabled, press and hold to enter Record Prepare mode.
After a second, the following displays appear:

HETRO
3. BOUHCER i50.00

2. While holding , turn Knob 2 (GRID) to adjust the Pattern Grid resolution.

3. While holding , to adjust the Pattern Length for the Pattern in which you are about to
record, you can turn Knob 1 (LENGTH) or press Button 5-8 to directly select from the four
length presets available: 7, 4, 8, or 16 bars.

4. Release

— The Record mode is engaged ( is lit) and the Pattern has the length you defined.
Press to start the sequencer (if it's not done already) and play the pads to start re-
cording! See section 17.2, Recording Patterns in Real Time for more information on re-
cording Patterns.

In Record Prepare mode can also enable or disable the metronome via Button 2! See sec-
tion 17.2.3, Using the Metronome for more information on the metronome.

You can also enter Record Prepare mode while starting a recording in Replace mode (see
17.2.1, Recording Your Patterns Live): Simply press + and hold until your
controller switch to Record Prepare mode. This is also true when using the Count-in (see
17.2.4, Recording with Count-in).

1.2.3  Using the Metronome

The metronome will help you to keep time when recording in real time.

» Click the metronome icon in the MASCHINE Header to enable/disable the metronome:

M+ @ | A 15000
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The metronome can be heard only when the sequencer is playing!

The metronome signal is sent to the Cue bus. To know how to use the Cue bus, see section
19.2.6, Using the Cue Bus.

You can customize the metronome in various ways in the Preferences panel:

You can adjust the metronome’s volume and time signature in the Preferences’ General
page (see section 12.5.1, Preferences — General Page for more details).

You can select custom sounds for the metronome’s downbeats and upbeats in the Prefer-
ences’ Default page (see section 12.5.2, Preferences — Default Page for more details).

The time signature of the metronome can be set to differ from the time signature of your
Project! This can be useful to record unusual rhythms in a Pattern. Reminder: the time sig-
nature of your Project is defined in the MASCHINE Header (MASCHINE in stand-alone
mode) or by your host application (MASCHINE running as a plug-in).

1.2.3.1  Using the Metronome on the MASCHINE Controller
On your controller:

» Press + to activate or deactivate the metronome.

Adjusting the Metronome’s Volume and Time Signature

On your controller you can adjust the volume and time signature of the metronome in the re-
cording settings:

1.

Press + to show the recording settings.

|REC. MODEN  HMETRO
3. BOUHCER 150,00 1311

HMETRONMOME COUNT-IH OUANTIZE
LEVEL TIME LEHNGTH MODE

-1.7 DB 174 Z BARS OH

Turn Knob 1 (METRONOME LEVEL) to adjust the metronome volume.
Turn Knob 2 (METRONOME TIME) to select a time signature.

While adjusting the metronome settings you can enable/disable the metronome via But-
ton 2 (METRO). This is strictly equivalent to pressing + as mentioned above.
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1.2.4  Recording with Count-in

Count-in allows you to start the metronome before the sequencer and recording begins. This is
very handy if you want to start recording a Pattern exactly on the downbeat.

When start recording with a Count-in, the following happens:
= The playhead jumps to the beginning of the Loop Range.
= You hear the metronome alone during the count-in phase (1, 2 or 4 bars).

= After the count-in phase, the recording starts in Overdub mode (see 17.2.1, Recording
Your Patterns Live). The metronome turns off if it was off before the Count-in, otherwise it
stays on.

You can adjust the metronome’s volume, time signature, and downbeat/upbeat sounds. See
section 17.2.3, Using the Metronome for more information.

If the current Loop Range does not start at the beginning of a bar (i.e. on a downbeat), the
count-in phase will start with a downbeat, count the selected duration (1, 2 or 4 bars), and
then add the offset between the beginning of the bar in which the beginning of the Loop
Range is placed and the actual beginning of the Loop Range:

Count-in Length Loop Range

Count-in when the Loop Range starts at the beginning of a bar...

Count-in Length )J added offset | | oop Range

...and when the Loop Range doesn’t start at the beginning of a bar.

You can also use the Count-in to start a recording in Replace mode.
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Adjusting the Count-in Duration

You can choose how long the metronome should be heard before the recording actually starts.
In the software this is done via the Count-in Length setting in the General page of the Prefer-
ences panel. Available values are 1 bar, 2 bars, and 4 bars. See section 12.5.1, Preferences —
General Page for more details on the Count-in and metronome settings available in the Prefer-
ences panel.

1.2.4.1  Using the Count-in on Your Controller
On your controller:

» Press + to start the Count-in and record in Overdub mode.
or
» Press + + to start the Count-in and record in Replace mode (see sec-

tion 17.2.1, Recording Your Patterns Live for more information on the Replace mode).

Adjusting the Count-in Duration
You can adjust the duration of the Count-in in the recording settings:

1. Press + to show the record settings.

|REC_ MODER  METRO
3. BOUMCER 150.00 13:1:1

METRONOME COUNT-IN _ QUANTIZE
LEVEL TIME LEHNGTH MODE
-1.7 DB 1/4 2 BARS OH

2. Turn Knob 3 (LENGTH) to select a duration for the Count-in.

1.2.5  Quantizing while Recording

You can choose to have notes automatically quantized as you record them on the pads. This is
called Input Quantization.

You can also quantize recorded notes at any time. See section 17.4.7, Quantizing Events/
Notes for more information.
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1.2.5.1  Using Input Quantize on Your Controller
1. Press + to show the record settings.

|REC. MODEN  HMETRO
3. BOUHCER 150,00 1311

HMETRONMOME COUNT-IH OUANTIZE

LEVEL TIME LENGTH MODE
-1.7 DB 174 Z BARS OH

2. Turn Knob 4 (QUANTIZE MODE) to enable (ON) or disable (0FF) Input Quantization.

—  With Input Quantization enabled, as you are recording the pads your notes will be quan-
tized according to the step size (i.e. Step Grid resolution) selected. If you turn the Step
Grid off, no quantization will be applied. See section 17.1.7, Adjusting the Step Grid and
the Nudge Grid for more information on the Step Grid and the step size.

1.3  Recording Patterns with the Step Sequencer

If you are familiar with classic drum machines you may want to program your Pattern using the
step sequencer.

1.3.1  Step Mode Basics

On your controller the step sequencer is available via the Step mode. The Step mode allows you
to program the steps to be played by the focused Sound in the current Group.

1.3.1.1  Using Step Mode on the MASCHINE Controller

» Press at the top left of your controller to switch your controller to Step mode.

In Step mode each pad of your controller represents one step of a 16-step sequence for the
focused Sound. The size of the steps depends on the current Step Grid settings. Lit pads indi-
cate events on the corresponding steps.

For more information on the Step Grid, see section 17.1.7, Adjusting the Step Grid and the
Nudge Grid.

This way it's easy to quickly put some drums together.
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A typical 4/4 line in Step mode.

In Step mode events are created with following settings:

= The event pitch is set to the Sound’s base key. To know how to change the base key of
your Sounds, see section 15.1.3, Adjusting the Base Key.

= The event velocity is defined by how hard you hit the pads, unless you have enabled the
Fixed Velocity option (see below).

= The event length is set to one step (hence, it depends on the current Step Grid settings).

= Obviously, the event position is defined by the pad you hit.
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Checking Your Sequence (Right Display)

DOUBLE | [FIXED VEL FOLLOW
Bi, EK-T.REUWORKED EE&35 21

FATTERH EVEHTS i
LENGTH GRID BASE KEY YELOCITY

4:0:0 OuUICK cC3 127

The Step mode on the controller displays: the first bar of a four-bar Pattern.

The right display of your controller provides more information on the sequence:

= Individual events are represented by rectangular blocks. These always mirror the steps
currently represented by your pads. The event velocities are indicated by vertical bars
within blocks (the higher the bar, the higher the velocity).

= The playback position in the Pattern is indicated by a playhead travelling from left to
right.

= A grid is displayed in the background with a marker after every fourth step (after every
third step if the Step Grid resolution is set to a triplet value).

= A scroll bar under the steps indicates which part of the Pattern is currently represented in
the display and on your pads. By default this corresponds to the first 16 steps.

To switch the right display and your pads to another part of the sequence, you have two possi-
bilities:
» Press Button 5 (FOLLOW) to enable/disable the Follow function.

— When Follow is enabled, the right display and your pads automatically switch to the next
16 steps as soon as the playback position reaches the end of the portion currently dis-
played.

This Follow function is always synchronized with the Follow function in the software. See
17.1.3, Following the Playback Position in the Pattern for more information.

When you hold a particular pad (e.g., to quickly edit the parameters of this step, see
17.3.2, Editing Events in Step Mode), the Follow function is temporarily disabled — it is
automatically re-enabled when you release the pad. See below for more information on re-
cording modulation in Step mode.

Otherwise you can manually switch to the previous/next steps:
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» If Button 5 (FOLLOW) is disabled, press Button 7 and 8 to manually switch to the previous/
next 16 steps both on your pads and on the right display.

Adjusting Your Pattern (Left Display)
The left display of your controller allows you to adjust a few settings for your Pattern.

You can adjust the Pattern Length and the Pattern Grid in the PATTERN section:

» Turn Knob 1 (LENGTH) to adjust the Pattern Length, and Knob 2 (GRID) to adjust the Pat-
tern Grid resolution.

See section 17.1.6, Adjusting the Pattern Grid and the Pattern Length for more information
on this.

You can also quickly double the content of the Pattern:
» Press Button 3 (DOUBLE) to double the content of the Pattern.

— The length of the Pattern is doubled. All events in the original Pattern are duplicated to
the second half of the extended Pattern. Any events that were located beyond the original
Pattern’s end are moved beyond the extended Pattern’s end.

You can otherwise double your Pattern via Pattern mode — see section 17.4.8, Doubling a
Pattern for more information.

Preparing the Next Events (Left Display)

The left display of your controller also allows you to adjust the pitch and the velocity of the
next events that you will create by pressing the pads. This is done in the EVENTS section:

» Turn Knob 3 (PITCH) To adjust the pitch of the next created events.
The velocity of the events you create depends on the state of the Fixed Velocity option:

» Press Button 4 (FIXVEL) to enable/disable the Fixed Velocity option.

= |If Fixed Velocity is enabled, all events you create will have the velocity set by Knob 4
(VELOCITY).
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If Fixed Velocity is disabled, the velocity of each event will depend on how hard you hit
the pad when creating the event.

These parameters only affect your next hits on the pads: They don’'t modify the pitch/veloci-
ty of existing events, even if these are selected! To quickly modify the pitch, velocity, and
position of events you have already created, use the Quick Edit shortcuts described in sec-
tion 17.3.2, Editing Events in Step Mode.

1.3.2  Editing Events in Step Mode

In Step mode you can quickly adjust the parameters of events on particular steps.

1.3.2.1 Editing Events in Step Mode on the MASCHINE MK1 Controller

You can quickly adjust the velocity, pitch, and position of any events via the Quick Edit short-
cuts on your controller:

REPEAT
Use the VOLUME, SWING, and TEMPO knobs for the Quick Edit shortcuts.

1.

Press and hold the pad(s) of the step(s) you want to edit. If you want to adjust the last
step you have created, skip this step: the last created event is automatically selected.

Turn the knob to adjust the events’ velocity.
The adjusted value appears on the left display.

Turn the knob to adjust the events’ pitch.
The adjusted value appears on the left display.

Turn the knob to finely adjust the events’ position.
The adjusted value appears on the left display.

When you are done, release the pad(s).

The event position will be adjusted independently of the current Step Grid: It is designed
as a fine adjustment within the current step.
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Alternatively you can use the various commands available on your pads while holding to
edit the selected events — see section 17.4.4, Editing Selected Events/Notes, 17.4.5, Delet-
ing Events/Notes, 17.4.6, Cut, Copy, and Paste Events/Notes, and 17.4.7, Quantizing Events/
Notes for more information on the available commands.

1.3.3

Recording Modulation in Step Mode

You can also record modulation in Step mode! This can be of great help to set value changes
at perfect timings.

1.3.3.1
1.

For all details on modulation please refer to section 17.5, Recording and Editing Modula-
tion.

Recording Modulation in Step Mode on the MASCHINE Controller

Press and hold the pad representing the step you want to modulate (you may need to use
Button 7 and 8 to navigate beforehand to the desired part of the Pattern).

The displays will switch to a mode similar to Control mode displaying parameter values.
Like in Control mode, use Button 2 or 3 to select the Group or Sound level, respectively;
press Button 5 or 6 to display the Plug-ins or Channel properties at this level; use But-
ton 7 and 8 to select the Plug-in slot or set of Channel properties; and use the Page but-
ton (left of the displays) to select the Parameter page containing the parameter you want
to record modulation for.

Only parameters that can be modulated will appear at the bottom of the displays.

While holding the pad, turn any of the Knobs 1-8 under the displays to edit the modula-
tion of the corresponding parameter for this step.

— The modulation values are recorded for this step.

A modulation value that is set for a step is valid for this step only. If you want it to affect
several steps of the Pattern, hold all the corresponding pads while setting the modulation
value.
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1.4  Editing Events

Many creation and editing commands on events/notes are available directly via mouse actions
in the Event area of the Pattern Editor. They will be applied according to the selected Step
Grid resolution (see 17.1.7, Adjusting the Step Grid and the Nudge Grid). In Group view, the
Sound in focus will change according to the row you click in. Selected notes are highlighted.

Events vs. Notes

Basically events and notes are the same thing: a trigger for a Sound with a particular velocity,
pitch, length, etc. If the word “note” is used when dealing with melodic instruments and
“event” when dealing with drum kits, keep in mind that both words have the same meaning in
the MASCHINE context.

1.4.1  Editing Events with the Mouse: an Overview

In the software you can choose from three Mouse Edit modes. Each of them provide different
mouse actions in the Event area.

Kick Ektl A 3

14 Comhn Fktl & 2

tH 116 Y

The Edit Mode selector.
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» To choose a Mouse Edit mode, click the desired icon in the Edit Mode selector, at the
bottom left of the Pattern Editor. You can also right-click ([Ctrl]-click on Mac OS X) in the
background of the Event area and select the desired mode from the context menu.

(1) Select mode: Provides an exhaustive set of actions for creating, selecting, editing, and de-
leting events/notes.

(2) Paint mode: Provides quick actions for creating, resizing and deleting events/notes.

(3) Erase mode: Provides an easy way to bulk delete events/notes.

Listed here are all available mouse actions from the Mouse Edit modes. For more details on
specific actions, please refer to the next sections

Mouse in Select Mode

The following table is an overview of available mouse actions in Select mode (works in both
Group view and Keyboard view, see 17.1.5, Group View and Keyboard View). All these actions
are described in more details in the following sections.

Action Function

Creating Notes

(see 17.4.2, Creating Events/Notes for details)

Double-click in Event area’s background Creates note

Deleting Notes
(see 17.4.5, Deleting Events/Notes for details)

Double-click note Delete selected notes
Right-click (Mac OS X: [Ctrl]-click) Delete selected notes
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Action Function

Selecting Notes

(see 17.4.3, Selecting Events/Notes for details)

Click unselected note

Select note

[Shift] + click unselected note

Add note to current selection

[Shift] + click selected note

Remove note from selection

Drag in Event area’s background

Multiple selection (selection frame)

Click in Event area’s background

Deselect all notes

Editing Selected Notes*

(see 17.4.4, Editing Selected Events/Notes for de-
tails)

Drag note horizontally

Moves selected notes in time according to the Step
Grid.

[Ctrl] + drag note horizontally
(Mac OS X: [Cmd] + drag note)

Freely moves selected notes in time (overrides the
Step Grid quantization).

[Alt] + drag note

Duplicates selected notes. When you drag horizontal-
ly, the copies are moved in time according to the
Step Grid.

Drag left/right note border

Moves the start/end of selected notes according to
the Step Grid, thereby resizing the notes.

[Ctrl] + drag left/right note border
(Mac OS X: [Cmd] + drag left/right border)

Freely moves the start/end of selected notes (over-
rides the Step Grid quantization), thereby resizing the
notes.

Drag note vertically

Group view: Moves selected notes to another Sound
of the Group.

Keyboard view: Transposes selected notes.

* When editing, mouse actions can be performed on any of the selected notes — they will ap-

ply to all selected notes.

Mouse in Paint Mode

With Paint mode enabled, the mouse works like a paint-brush tool:
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» Click in the background of the Event area and drag the mouse with the button pressed to
set notes wherever you move the cursor. Notes are created only for the Sound in which
you started.

The other way round:

» Click a note and move the mouse cursor with the button pressed to erase all notes under
the mouse cursor. Only Notes for the selected Sound are erased.

Additionally, you can resize notes like in Select mode:

» Drag the left or right border of a note horizontally to move its start/end according to the
Step Grid. Hold [Ctrl] (ICmd] on Mac OS X) while dragging to override the quantization.

Mouse in Erase Mode

With Erase mode enabled, the mouse works like an eraser:

» Click and hold the left mouse button down to erase notes wherever you move the cursor.

Contrary to Paint mode, in Erase mode notes are always deleted, no matter if you first click
a note or in the background of the Event area. Furthermore, in Erase mode notes can be
deleted in several Sounds at once, independently of where you first clicked.

1.4.2  Creating Events/Notes

In the software you can create new events anywhere in the Event area using your mouse. The
procedure depends on the active Mouse Edit mode (Select, Paint or Erase).

Each event is created at the beginning of the step in which your mouse cursor is located, ac-
cording to the Step Grid settings. If the Step Grid is disabled, the event is created at the exact
position of your mouse cursor.

In Group view you can create events at the base key for all Sounds in the Group, no matter
which Sound is focused. In Keyboard view you can create events at all keys (pitches) for the
focused Sound — you need to set the focus to another Sound in order to create events for that
Sound.
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Mouse in Select Mode

» To create a new event in Select mode, double-click at the desired location in the back-
ground of the Event area.

Mouse in Paint Mode

» To create a new event in Paint mode, simply click at the desired location. Click and hold
your mouse and move the cursor horizontally to quickly create a series of events.

You cannot create events with your mouse in Erase mode.

Creating Events Beyond the Pattern’s End

If you create an event beyond the end of the Pattern in the Event area, the Pattern is automati-
cally extended to the next Pattern Grid division after the new event so that the Pattern includes
this new event.

For more information on the Pattern Length and the Pattern Grid, see section 17.1.6, Ad-
justing the Pattern Grid and the Pattern Length.

1.4.2.1 Creating Events/Notes on Your Controller

Your controller offers numerous ways to create events — on your controller this is referred to as
“recording Patterns.” For details on this please refer to section 17.2, Recording Patterns in Re-
al Time and 17.3, Recording Patterns with the Step Sequencer.

1.4.3  Selecting Events/Notes

MASCHINE provides you many ways to select events/notes in your Pattern. This notably allows
you to precisely define which events your next edits will be applied to.

In the software you can select events with your mouse only if Select mode is selected in the
Edit Mode selector:

Click the cursor icon on the left to select events with your mouse.
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Action Function

Selecting Events

Click unselected event Select event

[Shift] + click unselected event Add event to current selection
[Shift] + click selected event Remove event from selection

Drag in Event area’s background Multiple selection (selection frame)
Click in Event area’s background Deselect all events

Selecting All Events

You can select all events displayed in the Event area via the usual keyboard shortcut on your
operating system:

» Click anywhere in the Event area and press [Ctrl] + [A] ([Cmd] + [A] on Mac OS X) on
your computer keyboard to select all displayed events.

— If the Pattern Editor is in Group view this will select all events for all Sounds in the Pat-
tern. If the Pattern Editor is in Keyboard view this will select all events at all pitches for
the focused Sound.

1.4.3.1 Selecting Events/Notes on the MASCHINE Controller

Using your controller you can select particular events from the current Pattern. This will allow
you to edit them without affecting the other events.

Quick Selecting Events and Notes

The quickest and easiest way to select events is the following:

» Press SHIFT + SELECT + any dimmed pad to select all events for that Sound (if pads are
in Group mode) or to select all notes at that pitch for the focused Sound (if pads are in
Keyboard mode).

— The selected pad lights up and all its events are selected. While holding SHIFT + SE-
LECT you can press other dimmed pads to add their events to your selection, or press any
fully lit pad to remove its events from the selection (the pad turns dimmed).

MASCHINE - Manual - 274



Working with Patterns
Editing Events

Unlit pad indicate Sounds (in Group mode) or pitches (in Keyboard mode) for which the Pat-
tern has no events. Hence, if you press them nothing happens.

For example in Group mode this can be very useful to quickly quantize a few drum instru-
ments in your kit without affecting the rest of the kit: Press + + the pads of
the desired drums then press + pad 5 ( ), and you're done!

Selecting Events and Notes via the Select Mode

In order to make more complex selections, your controller provides you with a useful tool: the
Select mode.

To select events in your Pattern:

1. Hold to enter Select mode — or press + Button 1 to pin the Select
mode.
2. Press Button 2 (EVENTS).
Button 2 lights up and EVENTS is highlighted in the left display.
You can now select notes and events using various tools: using the pads, Buttons 5-8, Knobs
1-4, and the Page buttons (left of the displays). Depending on the current pad mode (Group
mode or Keyboard mode, see 15.1.1, The Pad View), these tools will select events differently,
as described in the following paragraphs.

Select Mode: Selecting Events (Pads in Group mode)

In Group mode (the default mode of the pads), each pad represents a specific Sound of the
focused Group.

EVEHTS [ ALL__|[_HOHE [ _UP___|[__DOWH |
Ei EK-T.REWORKED E&.35 o KICK EETL A 1 SEL EWEHTS: 1

START FOSITION LENGTH FITCH VELOCITY
RilA A 1:1: 127

1:1:1 1:1 120 C2

Selecting events on the controller with the pads in Group mode.

You have following selection tools at your disposal:
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Selection Tool Description

Pads Unlit pads indicate Sounds for which the Pattern has no events. Nothing happens
when you press them.

Dimmed pads indicate Sounds for which events can be selected: Press any dimmed
pad to add all events for that Sound to the selection. The pad turns fully lit to in-
dicate that all its events are selected. You can press any additional dimmed pad to
add its events to the selection. Pressing a dimmed pad additionally switches the
focus to the corresponding Sound.

Fully lit pads indicate Sounds for which all events are selected: Press any lit pad to
remove all its events from the selection (the pad turns dim lit).

Button 7/8 (ALL/NONE) Selects/deselects all events for all Sounds, i.e. all events in the Pattern.

Button 5/6 (UP/DOWN) Switch the focus to the previous/next Sound in order to add or remove some of its
events to/from the selection (using Knob 1, 2, and 4, and the Page buttons, see
below). The name of the selected Sound is indicated in the middle left part of the
right display.

Knob 1/2 (START/END) Define the selection’s start and end points in the timeline for the focused Sound.
All events within this time interval are included into the selection.

Page buttons Drop the current selection and select the previous/next individual event for the fo-
cused Sound.

Knob 4 (EVENT) Selects individual events for the focused Sound using the events’ index number
(their “order of appearance” in the Pattern). If the selection contains more than
one event, the EVENT field indicates (MULTI).

By combining these tools you can precisely define the selection of events you want to edit.

The total number of events included in the current selection is shown in the middle right part
of the right display.

Select Mode: Selecting Notes (Pads in Keyboard mode)

In Keyboard mode, each pad represents a specific pitch of the focused Sound.

EVEHTS ALL__|[__HOHE _|[_UF | DOWH |
Ai. GROUP AL o OH BREY ILOOFI SEL EWEHTS: 1

START FOSITION LENGTH FITCH VELOCITY
B A 1:1: 127

1:1:4 1:4 240 E-